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Safety information

Important information

Read these instructions carefully and look at the equipment to become familiar with the 
device before trying to install, operate, service or maintain it. The following special 
messages may appear throughout this manual or on the equipment to warn of potential 
hazards or to call attention to information that clarifies or simplifies a procedure.

Please note

Electrical equipment should be installed, operated, serviced and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction, 
installation, and operation of electrical equipment and has received safety training to 
recognize and avoid the hazards involved.

The addition of either symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

DANGER
DANGER indicates an imminently hazardous situation which, if not avoided, will 
result in death or serious injury.

WARNING
WARNING indicates a potentially hazardous situation which, if not avoided, can 
result in death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation which, if not avoided, can result 
in minor or moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury. The safety alert 
symbol shall not be used with this signal word.
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Notices

Class B FCC Part 15

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver. 
• Connect the equipment to an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

This Class B digital apparatus complies with Canadian ICES-003.

Reasonable use and responsibility

This product must be installed, connected and used in compliance with prevailing 
standards and/or installation regulations.

If this product is used in a manner not specified by the manufacturer, the protection 
provided by the product may be impaired.

The safety of any system incorporating this product is the responsibility of the 
assembler/installer of the system.

Updates

As standards, specifications and designs change from time to time, always ask for 
confirmation of the information given in this publication.

Trademarks

PowerLogic and Schneider Electric are trademarks or registered trademarks of 
Schneider Electric in France, the USA and other countries.
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Chapter 1 Introduction

The PowerLogic™ PM5500 series power and energy meters offer value for the 
demanding needs of your energy monitoring and cost management applications. All 
meters in the PM5500 series range comply to Class 0.2S accuracy standards and 
feature high quality, reliability and affordability in a compact and easy to install format.

Some of the many features supported by the meter include:

• A fourth current input for direct and accurate measurement of neutral current, to 
help avoid device overload and network outage.

• Two digital outputs for control and energy pulsing applications.
• Four digital inputs with input metering support for WAGES monitoring applications.
• Dual Ethernet switched ports allow fast Ethernet interconnection to other PM5500 

series meters using only one IP switch.
• Multiple tariff support (8 tariffs) for monitoring energy usage on different days and 

times.
• Extensive alarming options, including logic and custom alarms.
• THD and individual harmonics up to the 63rd order.
• Onboard webpages for displaying real-time and logged data using a web browser.
• Onboard data logging support for up to 14 selectable parameters.
• Multiple language support: The back-lit anti-glare display screen can be switched to 

display meter information in one of the supported languages (available on models 
with a display screen).

• Graphical display of harmonics and phasor diagrams (available on models with a 
display screen).

You can use the meter can as a stand-alone device, but its extensive capabilities are 
fully realized when used as part of an energy management system.

For applications, feature details and the most current and complete specifications of the 
PM5500 series meters, see the PM5000 series technical datasheet at www.schneider-
electric.com.

PM5500 series meter models
The PM5500 series is available in the following models and mounting options:

Measured parameters
The meter provides fully bi-directional, 4-quadrant, Class 0.2S accurate energy 
metering. This section lists some of the parameters measured by the meter.

Model Commercial reference Description

PM5560 METSEPM5560 Front panel mount, integrated display, 96 x 96 mm form factor, 
fits in a 1/4 DIN mounting hole.

PM5561 METSEPM5561
Same as the PM5560, except the meter is calibrated to comply 
to strict MID standards, and is shipped with sealable covers for 
the voltage and current inputs.

PM5563 METSEPM5563 Transducer (TRAN) model, no display, mounts on a standard 
TS35 top hat style DIN rail.
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Energy

The meter stores all accumulated active, reactive and apparent energy parameters in 
nonvolatile memory:

• kWh, kVARh, kVAh delivered and received 
• kWh, kVARh, kVAh net (delivered - received)
• kWh, kVARh, kVAh absolute (delivered + received)

Energy registers can be logged automatically on a programmed schedule. All energy 
parameters represent the total for all three phases.

Demand

The meter supports standard demand calculation methods, including sliding block, 
fixed block, rolling block, thermal and synchronized.

The meter provides present, last, predicted and peak (maximum) demand, and a 
date/timestamp when the peak demand occurred. Peak demand registers can be reset 
manually (password protected) or logged and reset automatically on a programmed 
schedule.

Demand measurements include:

• kW, kVAR, kVA demand total and per phase
• Amps demand average, per phase and neutral (4th CT)
• Demand calculation for pulse input metering (WAGES)

Instantaneous

The meter provides highly accurate 1-second measurements, including true RMS, per 
phase and total for:

• 3-phase voltage (line-to-line, line-to-neutral)
• 3-phase current, neutral and ground current
• Active (kW), reactive (kVAR) and apparent (kVA) power
• True PF (power factor)
• Displacement PF
• System frequency
• Voltage (line-to-line, line-to-neutral) and current unbalance

Power quality

The meter provides complete harmonic distortion metering, recording and real-time 
reporting, up to the 63rd harmonic for all voltage and current inputs.

• Individual harmonics (odd harmonics up to 63rd)
• Total harmonic distortion (THD, thd) for current and voltage (line-to-line, line-to-

neutral)
• Total demand distortion (TDD)
• K-factor, Crest factor
• Neutral current metering and ground current calculation
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Data recording

The meter records the following:

• Each new minimum and new maximum value with date and timestamp for all 
instantaneous values and for each phase

• Alarms (with 1s timestamping)
• Parameters configured for data logging
• Data, alarm history, diagnostics, and maintenance logs

Input/Output

The meter provides the status of the digital inputs and digital outputs.

Other measurements

The meter also provides the following measurements:

• I/O timer shows how long an input or output has been ON.
• Operating timer shows how long the meter has been powered.
• Load timer shows how much time a load has been running, based on the specified 

minimum current for the load timer setpoint setting.

Data display and analysis tools
The meter integrates seamlessly with display and analysis software available from 
Schneider Electric™ such as StruxureWare™ Power Monitoring Expert and 
StruxureWare™ PowerSCADA Expert.

Power Monitoring Expert software lets you analyze and monitor your system and 
produce reports for any department in an organization. Power Monitoring Expert is 
designed to make use of all the meter’s available advanced capabilities. You can also 
use data acquired by the meter in a variety of third-party systems.

PowerSCADA Expert lets you control your system with high reliability, performance and 
data integrity. PowerSCADA Expert is designed to help reduce outages and increase 
power efficiency. It is built to handle simple to complex user requirements.

Related topics
• See the Power Monitoring Expert and PowerSCADA Expert product pages at 

www.schneider-electric.com for more information.

Meter configuration
Meter configuration is performed through the display panel (if your meter equipped with 
it) or through PowerLogic™ ION Setup. ION Setup is a meter configuration tool that can 
be downloaded for free at www.schneider-electric.com.

Related topics
• See the “PM5500 series” topic in the ION Setup online help or in the ION Setup 

device configuration guide. To download a copy, go to www.schneider-electric.com 
and search for ION Setup device configuration guide.
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Firmware
This user manual is written to be used with meter firmware 1.01 or later. See “Firmware 
version, model and serial number” on page 122 to view your meter’s firmware version.

Meter display language
If your meter is equipped with a display screen, you can configure the meter to display 
the measurements in one of the following languages:

• English
• French
• Spanish
• German
• Italian
• Portuguese
• Russian
• Chinese

See “Setting up regional settings” on page 44 to change the displayed language and 
other regional settings.
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Chapter 2 Hardware reference

This section supplements the meter’s installation sheet and provides additional 
information about the meter’s physical characteristics and capabilities.

Related topics
• See “Specifications” on page 27 for detailed meter specifications.
• See “Introduction” on page 11 for a description of features supported by your meter.
• See your product’s technical datasheet at www.schneider-electric.com for the most 

current and complete specifications.

Meter models
The meter is available in these models: 

• PM5560: panel-mount meter with integrated display, fits in a 1/4 DIN panel cutout.
• PM5561: MID-compliant panel-mount meter with integrated display, fits in a 1/4 DIN 

panel cutout.
• PM5563: DIN rail mount meter with no display.
 

PM5500 series meter models and supplied hardware 

PM5560 PM5561
Connector kit Connector kit

Mounting hardware Mounting hardware

Terminal covers

PM5563
Connector kit

92.4m m
3.64”

92.4m m
3.64”

92.4m m
3.64”

92.4m m
3.64”

92.4m m
3.64”

92.4m m
3.64”

92.4m m
3.64”

92.4m m
3.64”

C

C
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LED indicators
The LED indicators alert or inform you of meter activity.

Alarm / energy pulsing LED

The alarm / energy pulsing LED can be configured for alarm notification or energy 
pulsing.

NOTE: The alarm / energy pulsing LED on the PM5561 is permanently set for energy 
pulsing and cannot be disabled or used for alarms.

When configured for alarm notification, this LED flashes when a high, medium or low 
priority alarm is tripped. The LED provides a visual indication of an active alarm 
condition or an inactive but unacknowledged high priority alarm.

When configured for energy pulsing, this LED flashes at a rate proportional to the 
amount of energy consumed. This is typically used to verify the power meter’s 
accuracy.

Related topics
• See “Energy pulsing” on page 80 for details on configuring the alarm / energy 

pulsing LED for energy pulsing.
• See “LED alarm indicator” on page 99 for details on configuring the alarm / energy 

pulsing LED for alarming.

Heartbeat / serial communications LED

The heartbeat / serial communications LED blinks at a slow, steady rate to indicate the 
meter is operational. The LED flashes at a variable, faster rate when the meter is 
communicating over a Modbus serial communications port.

Location of LEDs 

PM5560 / PM5561 PM5563 A Alarm / energy pulsing LED

B Heartbeat / serial 
communications LED

All meter models C Ethernet communications LEDs

C
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You cannot configure this LED for other purposes.

Ethernet communications LEDs

The Link LED blinks to indicate the speed at which data is being transmitted or 
received. The Act (active) LED indicates the meter is communicating through the 
Ethernet port.

You cannot configure these LEDs for other purposes.

Before you begin
Carefully read and follow the safety precautions before working with the meter.

Safety precautions
Installation, wiring, testing and service must be performed in accordance with all local 
and national electrical codes.

1. Turn off all power supplying this device before working on it.

2. Always use a properly rated voltage sensing device to confirm that all power is off.

Meter mounting
This section describes how to mount the meter.

NOTICE
UNINTENDED EQUIPMENT OPERATION

A heartbeat LED that remains lit and does not blink (or flash) indicates a hardware 
problem. In this case, power down the meter and reapply power. If the LED still does 
not blink or flash, contact Technical Support.

Failure to follow these instructions may render your device inoperable.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate personal protective equipment (PPE) and follow safe electrical 
work practices. See NFPA 70E in the USA or applicable local standards.

• Turn off all power supplying this device before working on it.
• Always use a properly rated voltage sensing device to confirm that all power is off.
• Do not exceed the device’s ratings for maximum limits.
• Always use grounded external CTs for current inputs.

Failure to follow these instructions will result in death or serious injury.
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Mounting the integrated display model (PM5560, PM5561)

The meter is designed to be mounted inside a 1/4-DIN panel cutout.

1. Inspect the gasket (installed around the perimeter of the front display) and make 
sure it is secured properly and not damaged.

2. Insert the meter through the mounting hole.

3. Line up the tabs of the retainer clips with the slots on either side of the meter. While 
holding the retainers at a slight angle, push the retainers in and forward to position 
them in place. In situations where the spacing between meters is tight, use a flat-
head screwdriver with a long, narrow shaft to help secure the clips.

4. Push the middle of the clip assembly to lock the retainer in place and secure the 
meter.

(3.62)+0.03
92.0 +0.8

< 6.4
(< 0.25)

92.0 +0.8

(3.62)+0.03

mm
(in)

CLICK

CLICK

CLACK

CLACK
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Mounting the DIN rail mount model (PM5563)

The meter is designed to be mounted on a TS35 Top-Hat style DIN rail.

1. Line up the meter to the DIN rail. Tilt the meter slightly so the top notch is resting 
securely on the DIN rail.

2. Swing the meter downward and push the bottom part of the meter until you hear an 
audible click and the meter locks in place.

Removing the PM5563

1. Insert a flat-tip screwdriver into the DIN release clip. Pull down the clip until you hear 
an audible click and the DIN clip is unlocked.

2. Swing the meter out and upwards to remove the meter.

TS35

35 m
m

7.5 mm

CLIC
K

CLIC
K
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Meter wiring
For wiring instructions and safety precautions, see the meter installation sheet that was 
shipped with your meter, or download a copy at www.schneider-electric.com.

• Wire connections to the meter’s voltage inputs, control power, digital outputs, digital 
(status) inputs and RS-485 communications are terminated using the supplied 
pluggable wire connectors.

• When wiring the meter’s current inputs, terminate the wire ends with ring or split-ring 
crimp connectors. 

Use the meter installation sheet when wiring the meter.

Power system
This section outlines typical requirements for wiring the voltage and current inputs of 
the meter to the electrical power system.

For wiring instructions and safety precautions, see the meter installation sheet that was 
shipped with your meter, or download a copy at www.schneider-electric.com.

Related topics
• See “Specifications” on page 27 for voltage and current input limits.

Direct connect voltage limits

You can connect the meter’s voltage inputs directly to the phase voltage lines of the 
power system if the power system’s line-to-line or line-to-neutral voltages do not 
exceed the meter’s direct connect maximum voltage limits. The meter's voltage 
measurement inputs are rated by the manufacturer for up to 400 V L-N / 690 V L-L. 
However, the maximum voltage allowed for direct connection may be lower, depending 
on the local electrical codes and regulations. In US and Canada the maximum voltage 
on the meter voltage measurement inputs may not exceed 347 V L-N / 600 V L-L.

If your system voltage is greater than the specified direct connect maximum voltage, 
you must use VTs (voltage transformers) to step down the voltages.

Connector locations 

A Voltage inputs

B Control power

C Ethernet ports

D Digital outputs

E Current inputs

F Digital (status) inputs

G RS-485 port

C

D

E

F

G
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Power system setup parameters 

Power system description
—
Meter setting

Symbol
Direct connect maximum

# of VTs
(if required)UL IEC

Single-phase 2-wire line-to-neutral
—
1PH2W LN

480 V L-N 480 V L-N 1 VT

Single-phase 2-wire line-to-line
—
1PH2W LL

600 V L-L 600 V L-L 1VT

Single-phase 3-wire line-to-line with 
neutral
—
1PH3W LL with N

347 V L-N / 
600 V L-L

400 V L-N / 
690 V L-L 2VT

3-phase 3-wire Delta ungrounded
—
3PH3W Dlt Ungnd

600 V L-L 600 V L-L 2 VT

3-phase 3-wire Delta corner 
grounded
—
3PH3W Dlt Crnr Gnd

600 V L-L 600 V L-L 2 VT

3-phase 3-wire Wye ungrounded
—
3PH3W Wye Ungnd

600 V L-L 600 V L-L 2 VT

3-phase 3-wire Wye grounded
—
3PH3W Wye Gnd

600 V L-L 600 V L-L 2 VT

3-phase 3-wire Wye resistance-
grounded
—
3PH3W Wye Res Gnd

600 V L-L 600 V L-L 2 VT

3-phase 4-wire open Delta center-
tapped
—
3PH4W Opn Dlt Ctr Tp

240 V L-N / 
415 V L-N / 
480 V L-L

240 V L-N / 
415 V L-N / 
480 V L-L

3 VT

3-phase 4-wire Delta center-tapped
—
3PH4W Dlt Ctr Tp

240 V L-N / 
415 V L-N / 
480 V L-L

240 V L-N / 
415 V L-N / 
480 V L-L

3 VT

N

N
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Voltage and current input wiring

For wiring instructions and safety precautions, see the meter installation sheet that was 
shipped with your meter, or download a copy at www.schneider-electric.com.

Voltage input protection

The meter’s voltage inputs must be wired to fuses/breakers and a disconnect switch. If 
using a voltage transformer (VT), both primary and secondary sides of the VT must be 
wired to fuses/breakers and disconnect switches.

• Clearly label the device’s disconnect circuit mechanism and install it within easy 
reach of the operator.

• The fuses / circuit breakers must be rated for the installation voltage and sized for 
the available fault current.

• Fuse for neutral terminal is required if the source neutral connection is not 
grounded.

See the meter installation sheet for fuse ratings.

Current input protection

For all connected current inputs, use a CT shorting block to short-circuit the secondary 
leads of the CTs before removing the current input connections to the meter.

NOTE: Ground any unused current inputs.

Balanced system considerations

In situations where you are monitoring a balanced 3-phase load, you may choose to 
connect only one or two CTs on the phase(s) you want to measure, and then configure 
the meter so it calculates the current on the unconnected current input(s).

NOTE: For a balanced 4-wire Wye system, the meter’s calculations assume that there 
is no current flowing through the neutral conductor.

3-phase 4-wire ungrounded Wye
—
3PH4W Wye Ungnd

347 V L-N / 
600 V L-L

347 V L-N / 
600 V L-L 3 VT or 2 VT

3-phase 4-wire grounded Wye
—
3PH4W Wye Gnd

347 V L-N / 
600 V L-L

400 V L-N / 
690 V L-L 3 VT or 2 VT

3-phase 4-wire resistance-grounded 
Wye
—
3PH4W Wye Res Gnd

347 V L-N / 
600 V L-L

347 V L-N / 
600 V L-L 3 VT or 2 VT

Power system setup parameters (Continued)

Power system description
—
Meter setting

Symbol
Direct connect maximum

# of VTs
(if required)UL IEC

N

N
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Balanced 3-phase Wye system with 2 CTs

The current for the unconnected current input is calculated so that the vector sum for all 
three phase currents equal zero.

Balanced 3-phase Wye or Delta system with 1 CT

The currents for the unconnected current inputs are calculated so that their magnitude 
and phase angle are identical and equally distributed, and the vector sum for all three 
phase currents equal zero.

NOTE: You must always use 3 CTs for 3-phase 4-wire center-tapped Delta or 
center-tapped open Delta systems.

Neutral and ground current

The fourth current input (I4) can be used to measure current flow (In) in the neutral 
conductor, which can then be used to calculate residual current. The meter refers to 
residual current as ground current (Ig).

For 4-wire Wye systems, ground current is calculated as the difference between the 
measured neutral current and the vector sum of all measured phase currents.

Control power wiring
For wiring instructions and safety precautions, see the meter installation sheet that was 
shipped with your meter, or download a copy at www.schneider-electric.com.

The meter can be powered from an AC or DC power source.

• L1 and L2 are non-polarized. If using an AC power supply with neutral, connect 
neutral to the meter’s L2 terminal.

• Always use a fuse on L1. Fuse L2 when connecting an ungrounded neutral to the 
control power.

• If using a control power transformer, fuse both primary and secondary sides of the 
transformer.

• The fuses / circuit breakers must be rated for the installation voltage and sized for 
the available fault current.

Communications
This section provides additional information about the communications ports and 
topologies supported by the meter. You must wire and configure the RS-485 port and/or 
the Ethernet port in order to communicate with the meter.

Serial communications

The meter supports serial communications through the RS-485 port. Up to 32 devices 
can be connected on a single RS-485 bus.

In an RS-485 network, there is one master device, typically an Ethernet to RS-485 
gateway. It provides the means for RS-485 communications with multiple slave devices 
(for example, meters). For applications that require only one dedicated computer to 
communicate with the slave devices, an RS-232 to RS-485 converter can be used as 
the master device.
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RS-485 wiring

Connect the devices on the RS-485 bus in a point-to-point configuration, with the (+) 
and (-) terminals from one device connected to the corresponding (+) and (-) terminals 
on the next device.

RS-485 cable

Use a shielded 1.5 twisted pair or 2 twisted pair RS-485 cable to wire the devices. Use 
one twisted pair to connect the (+) and (-) terminals, and use the other insulated wire to 
connect the C terminals.

NOTE: If some devices in your RS-485 network do not have the C terminal, use the 
bare wire in the RS-485 cable to connect the C terminal from the meter to the  
terminal on the devices that do not have the C terminal.

RS-485 maximum cable length

The total distance for devices connected on an RS-485 bus should not exceed 1200 m 
(4000 ft).

RS-485 network configuration

After you have wired the RS-485 port and powered up the meter, you must configure 
the serial communications port in order to communicate with the meter.

Each device on the same RS-485 communications bus must have a unique address 
and all connected devices must be set to the same protocol, baud rate, and parity (data 
format).

NOTE: To communicate with the meter using ION Setup, you must set the serial site 
and all connected devices in the RS-485 network to the same parity setting.

For meters that do not have a display, you must first wire and configure each one 
separately before connecting these meters to the same RS-485 bus.

RS-485 wiring

RS-485 terminals

C Common. This provides the voltage reference (zero volts) for the data plus and data minus signals.

Shield. Connect the bare wire to this terminal to help suppress signal noise that may be present. 
Ground the shield wiring at one end only (either at the master or the last slave device, but not both).

- Data minus. This transmits/receives the inverting data signals.

+ Data plus. This transmits/receives the non-inverting data signal.

+
-

C

+
-

C

120 Ω

D1 (+)
D0 (-)

120 Ω

Master Slaves
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Related topics
• To configure RS-485 communications on a meter equipped with a display panel, 

see “Setting up serial communications” on page 41.
• To configure RS-485 communications on a meter that does not have a display 

panel, see “RS-485 port setup” on page 50

Ethernet communications

The meter supports Modbus TCP, HTTP and FTP protocols and can communicate at 
data speeds up to 100 Mbps through its Ethernet communications port.

The meter supports a single IP address between two 10/100Base-T Ethernet ports. The 
second Ethernet port functions as an Ethernet switch, which allows you to have shorter 
Ethernet cable runs between the meters without requiring additional Ethernet routers or 
repeaters. This helps simplify network connections and reduce installation time and 
costs.

Use a Cat 5 cable to connect the meter’s Ethernet port. Your Ethernet connection 
source should be installed in a location that minimizes the overall Ethernet cable routing 
length.

Ethernet configuration

To communicate with the meter through Ethernet, all devices must have a unique IP 
address and be set to the same subnet mask and gateway.

NOTE: For meters that do not have a display, you must configure each one separately 
in order to set a unique IP address for each device.

• To configure Ethernet communications on a meter equipped with a display panel, 
see “Setting up Ethernet communications” on page 42.

• To configure Ethernet communications on a meter that does not have a display 
panel, see “Using a web browser to set up Ethernet” on page 49.

Digital outputs
The meter is equipped with two Form A digital output ports (D1, D2). You can configure 
the digital outputs for use in the following applications:

• switching applications, for example, to provide on/off control signals for switching 
capacitor banks, generators, and other external devices and equipment

• demand synchronization applications, where the meter provides pulse signals to the 
input of another meter to control its demand period

• energy pulsing applications, where a receiving device determines energy usage by 
counting the kWh pulses coming from the meter’s digital output port

The digital outputs can handle voltages less than 30 V AC or 60 V DC (125 mA 
maximum). For higher voltage applications, use an external relay in the switching 
circuit.

Ethernet wiring

ETHERNET ETHERNETETHERNET

ETHERNET
SWITCH / HUB
Ethernet
Switch / hub

Ethernet Ethernet Ethernet
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Related topics
• See “Digital output applications” on page 77 for digital output use and configuration 

details.

Digital inputs
The meter is equipped with four digital input ports (S1 to S4). You can configure the 
digital inputs for use in status monitoring or input metering applications.

The meter’s digital inputs require an external voltage source to detect the digital input’s 
on/off state. The meter detects an on state if the external voltage appearing at the 
digital input is within its operating range.

The digital inputs require a 18 - 30 V AC or 12 - 30 V DC external voltage source to 
detect the digital input’s on/off state.

Related topics
• See “Digital input applications” on page 71 for digital input use and configuration 

details.

Digital output connections

+

-

LOAD

LOAD

< 30 V AC
< 60 V DC

D1 D2

D1 D2

+ - + -

≤ 125 mA

Digital input connections

S1 S2 S3 S4

+ + + +- -- -

+

-

18 - 30 V AC
12 - 60 V DC

+

-

18 - 30 V AC
12 - 60 V DC

+

-

+

-

18 - 30 V AC
12 - 60 V DC

18 - 30 V AC
12 - 60 V DC
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Specifications
The information contained in this section is subject to change without notice. See your 
product’s technical datasheet at www.schneider-electric.com for the most current and 
complete specifications.

For installation and wiring information, refer to the meter installation sheet.

Related topics
• See “MID compliance” on page 143 for specifications relevant to the Measuring 

Instruments Directive (MID).

Mechanical

Electrical

Mechanical characteristics 

Integrated display 
model 
(PM5560, PM5561)

IP degree of protection 
(IEC 60529)

Front display: IP52
Meter body: IP30 (except connectors)
Connectors: IP20 with terminal covers installed, IP10 
without terminal covers.

IP rating Front display: UL Type 12

Panel thickness 6.0 mm (0.25 in) maximum

Gasket thickness 1.0 mm (0.04 in)

Mounting position Vertical

Display type Monochrome graphics LCD, 128 x 128 resolution

Display backlight White LED

Viewable area 67 x 62.5 mm (2.64 x 2.46 in)

Keypad 4 button

Front panel LED indicators
Green LED (heartbeat / communications activity)
Amber LED (active alarm indicator or energy pulse output)

DIN rail mount model 
(PM5563)

IP degree of protection 
(IEC 60529)

Meter body: IP30 (except connectors)
Connectors: IP20 with terminal covers installed, IP10 
without terminal covers.

Mounting position 35 mm DIN rail

LED indicators (top)
Amber LED (active alarm indicator / energy pulsing
Green LED (heartbeat / communications activity)

Electrical characteristics 

Type of measurement
True RMS up to the 63rd harmonic on three-phase (3P, 
3P + N)
128 samples per cycle, zero blind

Measurement 
accuracy

IEC 61557-12 PMD/[SD|SS]/K70/0.2

Active energy ±0.2%
Class 0.2S, as per IEC 62053-22

Reactive energy ±2%
Class 2, as per IEC 62053-23

Active power ±0.2% as per IEC 61557-12

Reactive power ±1% as per IEC 61557-12

Apparent power ±0.5% as per IEC 61557-12

Current (5 A nominal, per 
phase) ±0.15%

Voltage (L-N) ±0.1%

Frequency ±0.05%
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Power quality 
accuracy, as per 
IEC 61557-12

Voltage unbalance 2.0%

Voltage harmonics 2.0%

Voltage THD 2.0%

Current harmonics 2.0%

Current THD 2.0%

Voltage inputs

VT primary 1.0 MV AC max

Measured voltage
20 to 400 V L-N / 20 to 690 V L-L (Wye) or 20 to 600 V L-L 
(Delta)
UL Listed up to 347 V L-N / 600 V L-L

Measurement category CAT III (6 kV rated impulse voltage)

Overload 480 V L-N / 828 V L-L

Impedance 5 M

Frequency 50 or 60 Hz ±10% (45 - 70 Hz)

Current inputs

CT primary 32767 A max

CT secondary Nominal: 5A (Class 0.2S) or 1 A (Class 0.5S)

Starting current 5 mA

Measured current with 
overrange and crest factor 50 mA to 10 A

Withstand
20 A continuous
50 A at 10 sec/hr
500 A at 1 sec/hr

Impedance  < 0.3 m

Frequency 50 or 60 Hz ±10% (45 - 70 Hz)

Burden < 0.024 VA at 10 A

AC control power

Operating range 100 to 480 V AC ± 10%

Installation category CAT III 600V class per IEC 61010-1 edition 3

Burden 5.0 W / 16.0 VA / 15.2 VAR max at 480 V AC

Frequency 50 or 60 Hz ±10%

Ride-through time
35 ms typical at 120 V L-N and maximum burden
129 ms typical at 230 V L-N and maximum burden

DC control power

Operating range 125 to 250 V DC ±20%

Burden 3.1 W typical, 5.0 W maximum at 125 V DC

Ride-through time 50 ms typical at 125 V DC and maximum burden

Digital outputs

Number / type 2 - Form A solid-state digital outputs

Load voltage 30 V AC / 60 V DC maximum

Load current 125 mA maximum

ON resistance 8 

Pulse frequency 25 Hz maximum

Meter constant 1 to 9,999,999 pulses per kWh

Pulse width 50% duty cycle (20 ms minimum ON time)

Leakage current 1 micro Amps

Isolation 2.5 kV RMS for 60 seconds

Active alarm / energy 
pulsing LED

Type Amber LED, optical

Pulse frequency 2.5 kHz maximum

Pulse width 50% duty cycle (200 microseconds minimum ON time)

Meter constant 1 to 9,999,999 pulses per kWh

Wavelength 590 to 635 nm

Electrical characteristics (Continued)
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Status inputs

Number / type 4 - Externally excited digital inputs

Voltage ratings
ON state: 15 - 30 V AC / 15 - 60 V DC
OFF state: 0 - 6 V AC / 0 - 6 V DC

Input resistance 100 k

Frequency 25 Hz maximum

Pulse width 50% duty cycle (20 ms minimum ON time)

Response time 10 ms

Opto Isolation 2.5 kV RMS for 60 seconds

Input burden
2 mA at 24 V AC/DC
2.5 mA at 60 V AC/DC

Environmental characteristics 

Operating 
temperature

Meter -25 to 70 °C (-13 to 158 °F)

Display -20 to 70 °C (-4 to 158 °F). Display functions to -25 ºC 
(-13 °F) with reduced performance.

Storage temperature Meter and display -40 to 85 °C (-40 to 185 °F)

Humidity rating 5 to 95% RH non-condensing at 50 °C (122 °F)

Pollution degree 2

Altitude < 3000 m (9843 ft)

Location Not suitable for wet locations.

EMC (electromagnetic compatibility) 

Harmonic current emissions IEC 61000-3-2

Flicker (voltage fluctuation) limits IEC 61000-3-3

Electrostatic discharge IEC 61000-4-2

Immunity to radiated fields IEC 61000-4-3

Immunity to fast transients IEC 61000-4-4

Immunity to surge IEC 61000-4-5

Conducted immunity 150kHz to 80MHz IEC 61000-4-6

Immunity to magnetic fields IEC 61000-4-8

Immunity to voltage dips IEC 61000-4-11

Immunity to damped oscillatory waves IEC 61000-4-12

Radiated emissions FCC part 15, EN55022 Class B

Conducted emissions FCC part 15, EN55022 Class B

Safety 

Europe LVD compliance (EN61010-1:2010)

U.S. and Canada cULus (UL61010-1:2012, CSA22.2 No.61010-1-12)

Protective class Protective class II. Double insulated for user accessible 
parts.

RS-485 communications 

Number of ports 1

Maximum cable length 1219 m (4000 ft)

Unit loads Up to 32 devices on the same bus

Parity Even, Odd, None (1 stop bit for Odd or Even parity; 2 stop 
bits for None)

Baud rate 9600, 19200, 38400 baud

Protocol Modbus RTU, Modbus ASCII (7 or 8 bit), JBUS

Firmware and language file update Update via the communication port using DLF3000

Isolation 2.5 kV RMS, double insulated

Electrical characteristics (Continued)
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Related topics
• For additional information, visit the website at www.schneider-electric.com and 

search for “PM5500 technical datasheet”.

Ethernet communications 

Number of ports 2 (same MAC address — the second Ethernet jack 
functions as an Ethernet switch for daisy-chaining devices)

Maximum cable length 100 m (328 ft), per TIA/EIA 568-5-A

Mode 10Base-T, 100Base-TX, Auto-MDIX

Protocol Modbus TCP, HTTP, FTP, DHCP, BOOTP

Firmware and language file update Update via the communication port using DLF3000

Real-time clock

Clock drift ~ 0.4 seconds per day (typical)

Battery backup time 4.5 years without control power (typical)
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Chapter 3 Front panel display and meter setup

This section applies to meters that are equipped with a front panel display. The front 
panel display lets you use the meter to perform various tasks such as setting up the 
meter, displaying data screens, acknowledging alarms, or performing resets.

LED indicators
The meter has two LED indicators on the front panel.

NOTE: For the PM5561 model, the alarm / energy pulsing LED is factory set for energy 
pulsing only and cannot be modified or disabled.

Heartbeat / communications LED

The (green) heartbeat / communications LED blinks at a slow, steady rate to indicate 
the meter is operational. The LED flashes at a variable, faster rate when the meter is 
communicating over a Modbus serial communications port.

You cannot configure this LED for other purposes.

Parts of the display 

A Navigation / menu selection buttons

B Heartbeat / communications LED (green)

C Alarm / energy pulsing LED (orange)

D Navigation symbols or menu options

E Right notification area

F Screen title

G Left notification area

H Cursor

C

G EF

D

Front panel LEDs 
Alarm / energy pulsing LED (orange)
Heartbeat / communications LED (green)

C

NOTICE
UNINTENDED EQUIPMENT OPERATION

A heartbeat LED that remains lit and does not blink (or flash) indicates a hardware 
problem. In this case, power down the meter and reapply power. If the LED still does 
not blink or flash, contact Technical Support.

Failure to follow these instructions may render your device inoperable.
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Related topics
• See “Troubleshooting LED indicators” on page 125 for additional maintenance 

information.

Alarm / energy pulsing LED modes

The (orange) alarm / energy pulsing LED can be configured for alarm notification or 
energy pulsing.

• When configured for alarm notification, this LED flashes when a high, medium or 
low priority alarm is tripped. The LED provides a visual indication of an active alarm 
condition, or an inactive but unacknowledged high priority alarm.

• When configured for energy pulsing, this LED flashes at a rate proportional to the 
amount of energy consumed. This is typically used to verify the power meter’s 
accuracy.

Related topics
• See “Energy pulsing” on page 81 for details on changing the LED mode for energy 

pulsing applications.
• See “LED alarm indicator” on page 101 for details on changing the LED mode for 

alarming applications.

Notification icons
To alert you about meter state or events, notification icons appear at the top left or top 
right corner of the display screen.

Notification icons 

Icon Description

The wrench icon indicates that the power meter is in an overvoltage condition or requires 
maintenance. It could also indicate that the energy LED is in an overrun state. See 
“Maintenance and upgrades” on page 121.

The alarm icon indicates an alarm condition has occurred. See “Alarm display and 
notification” on page 102 and “Alarm priorities” on page 96.



PowerLogic™ PM5500 series user manual Chapter 3—Front panel display and meter setup

HRB1684301-01 33

Meter screen menus
All meter screens are grouped logically, according to their function. You can access any 
available meter screen by first selecting the Level 1 (top level) screen that contains it.

Use the buttons to navigate the different meter screens. The navigation symbols and 
their functions are explained below:

When you reach the last screen, press  again to cycle through the screen menus.

Menu tree

This summarizes the meter screens (IEEE menus shown, with the corresponding IEC 
menus in parentheses — see “Setting up regional settings” on page 42). For detailed 
descriptions of the meter screens, see “Viewing meter data” on page 63.

Level 1 screen menus - IEEE display mode

Level 1 screen menus - IEC display mode

Navigation symbols 

Symbol Description

Scroll right and display more menu items

Exit screen and go up one level

Move cursor down the list of options or display more items below

Move cursor up the list of options or display more items above

Move cursor one character to the left

Move cursor one character to the right

Increase the highlighted value or show the next item in the list

Show the previous item in the list

Front panel buttons

MnMx

Amps Volts Power Energy PF

Unbal

Harm Hz

MaintTimerI/OAlarm Clock

THD

MnMx

I U-V PQS E PF

Unbal

Harm F

MaintTimerI/OAlarm Clock

THD
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PM5560 / PM5561 meter display screen menus

Level 1 Level 2 Level 3

Volts
(U-V)

Power
(PQS)

Energy
(E)

PF

Hz
(F)

THD

Unbal

MnMx

Harm

Maint

Alarm

Clock

I/O

Timer

Volts (U-V)

Reset

Setup

V L-L (U)

V L-N (V)

Power (PQS)

Phase

Dmd

Wh

VAh

VARh

Inp Mtr

True

Disp

THD

thd

Tariff

Amps (I)

Power (PQS)

Unbal

PF

Hz (F)

THD

Hist

Active

Count

Unack

Diag

D In

D Out

Oper

Load

V L-L (U)

V L-N (V)

Amps (I)

TDD / K

Crest

Fund 3-11 13-21 23-31

Fund 3-11 13-21 23-31

Fund 3-11 13-21 23-31

Amps (I) V L-L (U) V L-N (V)

Active (P) Reac (Q) Appr (S)

VARd (Qd) Tot A B C

Wd (Pd) Tot A B C

VAd (Sd) Tot A B C

T1 T2 T3 T4 T5 T6 T7 T8

Dmd Ch 1 Ch 2 Ch 3 Ch 4

Amps (I) V L-L (U) V L-N (V)

Amps (I) V L-L (U) V L-N (V)
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Meter setup screen navigation

The meter’s front panel buttons and display screen allow you to navigate and configure 
the meter’s setup parameters. The following illustration shows one of the meter setup 
screens.

In this example, the down arrow ( ) indicates there are more parameters below the 
selected option ( ). Press the down arrow button to display additional parameters. The 
down arrow disappears when the last item in the list is selected, and there are no more 
parameters to display.

Front panel meter setup
Meter configuration can be performed directly through the front panel buttons or 
remotely through software. This section contains instructions on setting up the meter 
using the front panel.

Related topics
• See “Remote meter setup” on page 49 to set up the meter through communications.

Configuring basic setup parameters

Proper configuration of the meter’s basic setup parameters is essential for accurate 
measurement and calculations. Use the Basic Setup screen to define the electrical 
power system that the meter is monitoring.

If standard (1-sec) alarms have been configured and you make subsequent changes to 
the meter’s basic setup, all alarms are disabled to prevent undesired alarm operation. 
After saving the changes, confirm all configured standard alarm settings are still valid, 
reconfigure them as required, and re-enable the alarms.

Basic setup screen 

NOTICE
UNINTENDED EQUIPMENT OPERATION

After modifying any basic setup parameter:
• Verify all standard alarms settings are correct and make adjustments as necessary.
• Re-enable all configured alarms.

Failure to follow these instructions can result in incorrect alarm functions.
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1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to Meter > Basic.

4. Move the cursor to point to the parameter you want to modify, then press Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

Basic setup menu tree

Basic setup parameters 

Parameter Values Description

Power System

Select the power system type (power transformer) the meter is wired to.

1PH2W LN Single-phase 2-wire line-to-neutral

1PH2W LL Single-phase 2-wire line-to-line

1PH3W LL with N Single-phase 3-wire line-to-line with neutral

3PH3W Dlt Ungnd 3-phase 3-wire ungrounded delta

3PH3W Dlt Crnr Gnd 3-phase 3-wire corner grounded delta

3PH3W Wye Ungnd 3-phase 3-wire ungrounded wye

3PH3W Wye Gnd 3-phase 3-wire grounded wye

3PH3W Wye Res Gnd 3-phase 3-wire resistance-grounded wye

3PH4W Opn Dlt Ctr Tp 3-phase 4-wire center-tapped open delta

3PH4W Dlt Ctr Tp 3-phase 4-wire center-tapped delta

3PH4W Wye Ungnd 3-phase 4-wire ungrounded wye

3PH4W Wye Gnd 3-phase 4-wire grounded wye

3PH4W Wye Res Gnd 3-phase 4-wire resistance-grounded wye

VT Connect

Select how many voltage transformers (VT) are connected to the electrical power 
system.

Direct Con Direct connect; no VTs used

2VT 2 voltage transformers

3VT 3 voltage transformers

VT Primary (V) 1 to 1,000,000 Enter the size of the VT primary, in Volts.

VT Secondary (V) 100, 110, 115, 120 Select the size of the VT secondary, in Volts.

CT on Terminal

Define how many current transformers (CT) are connected to the meter, and 
which terminals they are connected to.

I1 1 CT connected to I1 terminal

I2 1 CT connected to I2 terminal

I3 1 CT connected to I3 terminal

I1 I2 2 CT connected to I1, I2 terminals

I1 I3 2 CT connected to I1, I3 terminals

I2 I3 2 CT connected to I2, I3 terminals

I1 I2 I3 3 CT connected to I1, I2, I3 terminals

I1 I2 I3 IN 4 CT connected to I1, I2, I3, IN terminals

CT Primary (A) 1 to 1000000 Enter the size of the CT primary, in Amps.

CT Secondary (A) 1, 5 Select the size of the CT secondary, in Amps.

CT Primary Neu. (A) 1 to 32767
This parameter displays when CT on Terminal is 
set to I1,I2,I3, IN. Enter the size of the 4th (Neutral) 
CT primary, in Amps.

CT Sec. Neu. (A) 1, 5
This parameter displays when CT on Terminal is 
set to I1,I2,I3, IN. Select the size of the 4th 
(Neutral) CT secondary, in Amps.

Maint Reset

Setup Basic Adv Dmd TariffMeter
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7. Press Yes to save your changes.

Related topics
• See “Power system” on page 20 for descriptions and symbols of the different 

electrical power systems supported by the meter.
• See “Meter configuration using ION Setup” on page 53 to set up the meter using 

ION Setup.

Configuring advanced setup parameters

The advanced setup screens let you configure the following:

• Load timer setpoint: defines the active load current, which is the minimum input 
current required to start and keep the active load timer counting.

• Peak current demand for total demand distortion: specifies the minimum current 
demand value required to include in total demand distortion calculations.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to Meter > Advan.

4. Move the cursor to point to the parameter you want to modify, then press Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

7. Press Yes to save your changes.

Sys Frequency (Hz) 50, 60 Select the frequency of the electrical power 
system, in Hz.

Phase Rotation ABC, CBA Select the phase rotation of the 3-phase system.

Basic setup parameters (Continued)

Parameter Values Description

Advanced setup menu tree

Advanced setup parameters 

Parameter Values Description

Label —

This label identifies the device, e.g., “Power 
Meter”. You cannot use the front panel to edit 
this parameter. Use ION Setup to change the 
device label.

Load Timer Setpt (A) 0 - 9

Specifies the minimum average current at the 
load before the timer starts. The meter begins 
counting the number of seconds the load timer 
is on (i.e., whenever the readings are equal to 
or above this average current threshold.

Pk I dmd for TDD (A) 0 - 9

Specifies the minimum peak current demand 
at the load for inclusion in total demand 
distortion (TDD) calculations. If the load 
current is below the minimum peak current 
demand threshold, the meter does not use the 
readings to calculate TDD. Set this to “0” 
(zero) if you want the power meter to use the 
metered peak current demand for this 
calculation.

Maint Reset

Setup Basic Adv Dmd TariffMeter
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Related topics 
• See “Meter configuration using ION Setup” on page 53 to set up the meter using 

ION Setup.

Demand setup
Demand is a measure of average consumption over a fixed time interval.

Use the Demand setup screens to define power demand, current demand or input 
metering demand.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to Meter > Dmd.

4. Move the cursor to select Power Demand, Current Demand or Input Demand.

5. Move the cursor to point to the parameter you want to modify, then press Edit.

6. Modify the parameter as required, then press OK.

7. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

8. Press Yes to save your changes.

Demand setup menu tree

Power, current, or input demand setup parameters 

Parameter Values Description

Method

Timed Sliding Block 
Timed Block
Timed Rolling Block
Input Sync Block
Input Sync Roll Block
Cmd Sync Block
Cmd Sync Roll Block
Clock Sync Block
Clock Sync Roll Block
Thermal

See “Power demand” on page 115 for 
details.

Interval 0 - 99 Set the demand interval, in minutes.

Subinterval 0 - 99
Applies only to rolling block methods.
Define how many subintervals the demand 
interval should be equally divided into.

Select Dig Output None, Digital Output D1, Digital 
Output D2

Select which digital output the end of 
demand interval pulse should be sent to.

Select Dig Input
None, Digital Input S1, Digital 
Input S2, Digital Input S3, Digital 
Input S4

Applies only to input sync methods.
Select which digital input is used to sync 
the demand.

Clock Sync Time 0 - 2359

Applies only to clock sync methods (these 
synchronize the demand interval to the 
meter’s internal clock).
Define what time of day you want to 
synchronize the demand

Maint Reset

Setup Basic Adv Dmd TariffMeter
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Related topics
• See “Power demand” on page 115 for detailed descriptions on demand parameters, 

characteristics and type.

Multi-tariff setup
The meter’s multi-tariff feature allows you to use up to 8 different tariff “containers” to 
store accumulated energy data. The Tariff setup screens allow you to configure how 
and when to apply the different tariffs.

Related topics
• See “Multi-tariff feature” on page 105 for a comprehensive description and setup 

instructions using the front panel.
• To configure the tariffs using ION Setup, see the “PM5500 series” topic in the 

ION Setup online help or in the ION Setup device configuration guide, available for 
download at www.schneider-electric.com.

Communications setup
After wiring the meter’s serial and Ethernet communications ports, you can configure 
these ports so you can connect to the meter remotely and use device configuration 
software such as ION Setup to configure the meter.

Related topics
• See “Serial communications” on page 23 for details on wiring and configuring the 

meter’s RS-485 port.

Setting up serial communications

The Serial setup screen allows you to configure the meter’s RS-485 communications 
port so you can use software to access the meter’s data or configure the meter 
remotely.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to Comm > Serial.

4. Move the cursor to point to the parameter you want to modify, then press Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

Serial communications setup menu tree

Maint Reset

Setup

Serial EnetComm

Meter
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7. Press  to exit. Press Yes to save your changes.

Related topics
• See “RS-485 port setup” on page 50 for instructions on configuring the RS-485 port 

using ION Setup.

Setting up Ethernet communications

The Ethernet setup screen allows you to assign the meter a unique IP address so you 
can use software to access the meter’s data or configure the meter remotely through 
the Ethernet port. Before configuring the Ethernet parameters, make sure you obtain 
your meter’s IP address information from your network administrator or IT department.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to Comm > Enet.

4. Move the cursor to point to the parameter you want to modify, then press Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

RS-485 port settings 

Parameter Values Description

Protocol Modbus, Jbus, ASCII 8 Bit, 
ASCII 7 Bit

Select the communications format used to transmit 
data. The protocol must be the same for all devices in a 
communications loop.

Address 1 to 247
Set the address for this device. The address must be 
unique for each device in a communications loop. For 
Jbus protocol, set the device ID to 255.

Baud Rate 9600, 19200, 38400
Select the speed for data transmission. The baud rate 
must be the same for all devices in a communications 
loop.

Parity Even, Odd, None
Select None if the parity bit is not used. The parity 
setting must be the same for all devices in a 
communications loop.

Ethernet communications setup menu tree

Maint Reset

Setup

Serial EnetComm

Meter
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7. Press  to exit. Press Yes to save your changes.

Related topics
• See “Configuring Ethernet settings using a browser” on page 56 to set up the 

Ethernet port using the meter webpages.

Alarms setup
An alarm is the meter’s means of notifying you when an alarm condition is detected, 
such as an error or an event that falls outside of normal operating conditions.

Related topics
• See “Alarms” on page 89 for a comprehensive description and detailed setup 

instructions.

Input / output setup
The meter’s input/output (I/O) ports extend the capabilities of the meter. The I/O ports 
can be configured using the front panel or ION Setup.

Related topics
• See “Input / Output” on page 71 for a comprehensive description and setup 

instructions.
• See “Specifications” on page 28 for electrical characteristics and limits of the 

meter’s I/O ports.

Ethernet port settings 

Parameter Values Description

IP Method Stored, Default, DHCP, 
BOOTP

This controls the network protocol for your device 
(what the meter uses to obtain its IP address).
• Stored: Use the static value programmed in the 

IP Address setup register
• Default: Use 85.16 as the first two values of the 

IP address, then convert the last two 
hexadecimal values of the MAC address to 
decimal and use this as the last two values of 
the IP address.
Example: MAC address = 00:80:67:82:B8:C8
Default IP = 85.16.184.200

• DHCP: Dynamic Host Configuration Protocol
• BOOTP: Bootstrap Protocol

IP Address
Contact your local 
network administrator 
for parameter values.

The internet protocol address of your device.

Subnet The Ethernet IP subnetwork address of your 
network (subnet mask).

Gateway The Ethernet IP gateway address of your network.

HTTP Server Enabled, Disabled Controls whether your device’s webserver and 
webpages are active or not.

Device Name (see description)

This is the meter’s device name and is factory set to 
PM55#-xxx (where xxx is the serial number of the 
meter). This can be used as a DNS entry that maps 
the device name to the IP address assigned by the 
DHCP server.
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HMI settings
The HMI (human-machine interface) setup screens allow you to:

• control the general appearance and behavior of the display screens,
• change the regional settings, or
• change the meter passwords.

Related topics
• To configure the front panel display using ION Setup, see the “PM5500 series” topic 

in the ION Setup online help or in the ION Setup device configuration guide, 
available for download at www.schneider-electric.com.

Setting up the display

You can change the display screen’s contrast or the screen backlight and timeout 
settings.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to HMI > Disp.

4. Move the cursor to point to the parameter you want to modify, then press Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

7. Press  to exit. Press Yes to save your changes.

Setting up regional settings

You can change the regional settings to localize the meter screens and display data in 
a different language, using local standards and conventions.

NOTE: In order to display a different language other than those listed in the Language 
setup parameter, you need to download the appropriate language file to the meter 

Display setup menu tree

Display setup parameters 

Parameter Values Description

Contrast 1 - 9 Increase or decrease the value to increase or 
decrease the display contrast.

Backlight Timeout (min) 0 - 99

Set how long (in minutes) before the backlight 
turns off after a period of inactivity. Setting this to 
“0” disables the backlight timeout feature (i.e., 
backlight is always on).

Screen Timeout (min) 0 - 99

Set how long (in minutes) before the screen turns 
off after a period of inactivity. Setting this to “0” 
disables the screen timeout feature (i.e., display is 
always on).

Maint Reset

Setup

Displ Region Pass

Comm

Alarm

I/O

HMI

Meter
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using the appropriate firmware upgrade tool such as DLF3000. See “Firmware 
upgrade” on page 126. 

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to HMI > Region.

4. Move the cursor to point to the parameter you want to modify, then click Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

7. Press  to exit. Press Yes to save your changes.

Resetting the language
To reset the meter to the default language (English), press and hold the outermost two 
buttons for 5 seconds.

Setting up the screen passwords
This can only be configured through the front panel. The factory-default setting for all 
passwords is “0” (zero). Changing the default password for screens that are password-
protected prevents unauthorized personnel from accessing certain screens such as the 
diagnostics and reset screens.

If you lose your password, you must return the meter for factory reconfiguration, which 
resets your device to its factory defaults and destroys all logged data.

Regional settings menu tree

Regional settings setup parameters 

Parameter Values Description

Language English US, French, Spanish, German, 
Italian, Portuguese, Chinese, Russian

Select the language you want the meter to 
display.

Date Format MM/DD/YY, YY/MM/DD, DD/MM/YY Set how you want the date to be displayed, 
e.g., month/day/year.

Time Format 24Hr, AM/PM Set how you want the time to be displayed, 
e.g., 17:00:00 or 5:00:00 PM.

HMI Mode IEC, IEEE Select the standards convention used to 
display menu names or meter data.

Maint Reset

Setup

Comm

Alarm

I/O

Meter

Displ Region PassHMI

NOTICE
LOST DATA

Record your meter's screen password information in a secure location.

Failure to follow these instructions can result in data loss.
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1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to HMI > Pass.

4. Move the cursor to point to the parameter you want to modify, then press Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

7. Press  to exit. Press Yes to save your changes.

Lost password

Visit www.schneider-electric.com for support and assistance with lost passwords or 
other technical problems with the meter.

Make sure you include your meter’s model, serial number and firmware version in your 
email or have it readily available if calling Technical Support.

Setting the clock
The Clock setup screens allow you to set the meter’s date and time.

NOTE: You must always set or sync the meter time to UTC (GMT, Greenwich Mean 
Time), not local time. Use the GMT Offset (h) setup parameter to display the correct 
local time on the meter.

Password setup menu tree

Password setup parameters 

Parameter Values Description

Setup 0000 - 9999 Sets the password for accessing the meter setup 
screens (Maint > Setup).

Energy Resets 0000 - 9999 Sets the password for resetting the meter’s 
accumulated energy values.

Demand Resets 0000 - 9999 Sets the password for resetting the meter’s 
recorded peak demand values.

Min/Max Resets 0000 - 9999 Sets the password for resetting the meter’s 
recorded minimum and maximum values.

Maint Reset

Setup

Comm

Alarm

I/O

Meter

Displ Region PassHMI
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1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to Clock.

4. Move the cursor to point to the parameter you want to modify, then press Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

7. Press  to exit. Press Yes to save your changes.

Related topics
• See “Setting up regional settings” on page 42 for instructions on changing the 

format of the displayed date and time.
• To configure the clock using ION Setup, see the “PM5500 series” topic in the 

ION Setup online help or in the ION Setup device configuration guide, available for 
download at www.schneider-electric.com.

• See “TDD calculation” on page 122 for details on how the meter calculates TDD.

Setting up the alarm / energy pulsing LED
The meter’s LED can be configured for alarm indication or energy pulsing.

Related topics
• See “LED alarm indicator” on page 101 for details on setting up the LED for alarms.
• See “Energy pulsing” on page 81 for details on setting up the LED for energy pulse 

counting.

Clock setup menu tree

Clock setup parameters 

Parameter Display format Description

Date DD/MM/YY, MM/DD/YY, 
YY/MM/DD

Set the current date using the format displayed 
on screen, where DD = day, MM = month and 
YY = year.

Time HH:MM:SS (24 hour format), 
HH:MM:SS AM or PM

Use the 24-hour format to set the current time in 
UTC (GMT).

Meter Time GMT, Local

Select GMT to display the current time in UTC 
(Greenwich Mean Time zone).
To display local time, set this parameter to 
Local, then use GMT Offset (h) to display local 
time in the proper time zone.

GMT Offset (h)1

1 Currently supports whole integers only.

+/- HH.0

Available only when Meter Time is set to Local, 
use this to display the local time relative to GMT. 
Set the sign to plus (+) if local time is ahead of 
GMT, or minus (-) if local time is behind GMT.

Maint Reset

Setup

Comm

Alarm

I/O

HMI

Clock

Meter
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Chapter 4 Remote meter setup

You can configure the meter’s setup parameters through the meter’s Ethernet or 
RS-485 communications port.

The meter is factory-configured with default Ethernet and RS-485 communications port 
settings. You must modify the default settings before connecting the meter to your 
Ethernet or RS-485 network. To do this, you need:

• a web browser to configure the Ethernet port
• ION Setup to configure the RS-485 port

NOTE: Your meter’s serial communications port ID (Com1 ID) is used in both Ethernet 
and serial communications; you need to change the Com1 ID meter property in 
ION Setup if you modify the meter’s RS-485 address.

Downloading ION Setup
Go to www.schneider-electric.com and search for ION Setup to download a copy of the 
installation file.

Upgrading ION Setup

If you already have an existing installation of ION Setup, it is recommended that you 
upgrade it to the latest version in order to access new ION Setup features or 
enhancements and properly configure features available on your device.

Refer to the online help to learn how to use ION Setup.

Ethernet port setup
Use a web browser to connect to the meter webpages and modify the default Ethernet 
settings before connecting the meter to your local area network (LAN). The meter is 
factory-configured with the following default Ethernet communications settings:

• IP address = 169.254.0.10
• Subnet mask = 255.255.0.0
• Gateway = 0.0.0.0
• HTTP server = Enabled
• Device name = PM55-#xxxxxxxxxx, where xxxxxxxxxx is the meter’s factory serial 

number (with leading zeros if serial number is less than 10 characters)
• IP method = Stored

Using a web browser to set up Ethernet

You can perform the initial configuration of your meter’s Ethernet settings using the 
following steps.

1. Disconnect your computer from the network. If your computer has wireless 
communications, make sure you disable the wireless network connection as well.

2. Use an Ethernet cable to connect the computer to one of the meter’s Ethernet ports.

3. Open a web browser and enter 169.254.0.10 in the address field.
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4. Log in to the meter webpages. The default login values are:

— Username = user1
— Password = pass1

5. Click Setup > Ethernet.

6. Modify the Ethernet setup parameters with the settings your system administrator 
assigned for the meter.

7. Click Apply to send and save the new settings to the meter.

8. Click Logout to exit the meter’s webpages.

Meter setup through Ethernet

After the meter’s Ethernet port is configured and connected to the LAN, you can:

• Use a web browser to connect to the meter webpages and configure Ethernet 
settings, webpage users and data log export schedules.

• Use ION Setup to configure all other meter setup parameters.

Related topics
• See “Setting up Ethernet communications” on page 40 for details on using the 

meter’s display panel to configure the Ethernet port.

RS-485 port setup
Use ION Setup to modify the meter’s default RS-485 settings before connecting the 
meter to the RS-485 bus. The meter is factory-configured with the following default 
serial communications settings:

• Protocol = Modbus RTU
• Address = 1
• Baud rate = 19200
• Parity = Even

You can use a communications converter (USB to RS-485 or RS-232 to RS-485) or 
Ethernet gateway device to connect to the meter.

Ethernet & TCP/IP 

Parameter Description

Ethernet MAC Address Displays the meter’s factory-programmed MAC address. 
This information is read-only and cannot be changed.

IP Parameters

IP Address Acquistion 
Mode

This controls the network protocol for your device (which the 
meter uses to obtain its IP address):
• DHCP: Dynamic Host Configuration Protocol
• BOOTp: Bootstrap Protocol
• Static: Use the static value programmed in the 

IP Address setup register
• Default: Use 85.16 as the first two values of the 

IP address, then convert the last two hexadecimal 
values of the MAC address to decimal and use this as 
the last two values of the IP address.
Example: MAC address = 00:80:67:82:B8:C8
Default IP address = 85.16.184.200

IP Address The internet protocol address of your device.

Subnet Mask The Ethernet IP subnetwork address of your network.

Default Gateway The Ethernet IP gatway address of your network.
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Using a serial communications converter to set up RS-485

NOTE: Configuring the serial communications settings using this method may cause 
ION Setup to lose communications when the changes are sent to your meter. You must 
reconfigure ION Setup to match the new settings to re-establish communications with 
your meter.

1. Configure the serial communications converter’s settings to be compatible with the 
meter’s default serial communications settings.

2. Connect the meter’s RS-485 port to the serial communications converter.

3. Connect the communications converter to the computer.

4. Start ION Setup in Network mode.

5. Add a serial site and set its properties:

— Comm Link = Serial
— Comm Port = select which serial (or USB) port the communications converter is 

attached to
— Baud rate = 19200
— Format = select a format with even parity

6. Add a meter to the site and set its properties:

— Type = PowerLogic PM5000 series Power Meter
— Unit ID = 1

7. Use the setup screens to modify the meter’s setup parameters.

8. Use the RS-485 Base Comm setup screen to modify the meter’s serial 
communications settings.

9. Click Send to save your changes to the meter. You need to reconfigure ION Setup 
to match the changed settings in order to re-establish communications with your 
meter.

NOTE: If you set the protocol to ASCII 7, ASCII 8 or JBus, you cannot use ION Setup 
to reconnect to the meter — ION Setup does not communicate using these protocols.

10. Exit ION Setup.

Using an Ethernet gateway to set up RS-485

NOTE: Configuring the serial communications settings using this method may cause 
ION Setup to lose communications when the changes are sent to your meter. You must 

RS-485 port settings 

Parameter Values Description

Protocol Modbus RTU, JBus, 
ASCII 8, ASCII 7

Select the communications format used to transmit 
data. The protocol must be the same for all devices in a 
communications loop.
ION Setup does not support ASCII 8, ASCII 7 or JBus 
protocols.

Address 1 to 247

Set the address for this device. The address must be 
unique for each device in a communications loop. For 
JBus protocol, set the device ID to 255.
This value is used in both Ethernet and serial 
communications; you may need to update your Ethernet 
settings to re-establish Ethernet communications.

Baud Rate 9600, 19200, 38400
Select the speed for data transmission. The baud rate 
must be the same for all devices in a communications 
loop.

Parity Even, Odd, None
Select None if the parity bit is not used. The parity 
setting must be the same for all devices in a 
communications loop.
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reconfigure ION Setup to match the new settings to re-establish communications with 
your meter.

1. If applicable, disconnect all serial devices presently connected to the Ethernet 
gateway’s RS-485 port.

2. Configure the Ethernet gateway’s serial port settings to match the meter’s default 
serial communications settings:

— Baud rate = 19200
— Parity = Even

3. Connect the meter’s RS-485 port to the Ethernet gateway.

4. Connect the Ethernet gateway to the LAN.

5. Start ION Setup in Network mode.

6. Add an Ethernet gateway site and set its properties:

— IP address = IP address of the Ethernet gateway
— Port = 502 (for Modbus RTU)

7. Add a meter to the site and set its properties:

— Type = PowerLogic PM5000 series Power Meter
— Unit ID = 1

8. Use the RS-485 Base Comm setup screen to modify the meter’s serial 
communications settings.

9. Click Send to save your changes to the meter. You need to reconfigure ION Setup 
to match the changed settings in order to re-establish communications with your 
meter.

NOTE: If you set the protocol to ASCII 7, ASCII 8 or JBus, you cannot use ION Setup 
to reconnect to the meter — ION Setup does not communicate using these protocols.

10. Exit ION Setup.

Meter setup through RS-485

After the meter’s RS-485 port is configured and connected to the RS-485 network, you 
can use ION Setup to configure all other meter setup parameters.

Related topics
• See “Setting up serial communications” on page 39 for details on using the meter’s 

display panel to configure the RS-485 port.

RS-485 port settings 

Parameter Values Description

Protocol Modbus RTU, JBus, 
ASCII 8, ASCII 7

Select the communications format used to transmit 
data. The protocol must be the same for all devices in a 
communications loop.
ION Setup does not support ASCII 8, ASCII 7 or JBus 
protocols.

Address 1 to 247

Set the address for this device. The address must be 
unique for each device in a communications loop. For 
JBus protocol, set the device ID to 255.
This value is used in both Ethernet and serial 
communications; if you change this value, you need to 
update your meter properties in ION Setup to re-
establish Ethernet communications.

Baud Rate 9600, 19200, 38400
Select the speed for data transmission. The baud rate 
must be the same for all devices in a communications 
loop.

Parity Even, Odd, None
Select None if the parity bit is not used. The parity 
setting must be the same for all devices in a 
communications loop.
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Meter configuration using ION Setup
Start ION Setup, create a site (or if applicable, use an existing site), then add your 
meter to the site.

NOTE: When adding your meter as an Ethernet device, make sure you enter the 
meter’s address in the Com1 ID field.

See the “PM5500 series” topic in the ION Setup online help or in the ION Setup device 
configuration guide. To download a copy, go to www.schneider-electric.com and search 
for ION Setup device configuration guide.

Related topics
• See “Front panel display and meter setup” on page 31 to configure the meter using 

the display panel.
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Chapter 5 Meter webpages

This section describes the meter’s webpages. The meter’s Ethernet connection allows 
you to access the meter so you can view data and perform some basic configuration 
and data export tasks using a web browser.

Accessing the meter webpages
Open a web browser and enter the meter’s IP address in the address box. When 
prompted, enter your username and password.

NOTE: The webpages are accessed through the meter’s Ethernet port so it must be 
configured properly. See “Configuring Ethernet settings using a browser” on page 54 
for instructions on changing the factory default Ethernet settings.

Webpage UI overview
The meter webpages contain typical elements as shown below.

Webpages setup
You can configure the Ethernet port, user names and passwords, and device log 
exports through the webpages’ Setup menu.

Ethernet communications settings
The meter is factory-configured with default Ethernet settings. You must change the 
default settings before connecting the meter to your network.

Meter brand and modelCompany logo

Firmware version Company and copyright statement User name

Webpage content

Menu commands
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Configuring Ethernet settings using a browser

Before connecting the meter to your LAN, you must first configure the Ethernet settings.

Initial Ethernet configuration steps

1. Disconnect your computer from the network. If your computer has wireless 
communications, make sure you disable the wireless network connection as well.

2. Use an Ethernet cable to connect the computer to one of the meter’s Ethernet ports.

3. Open a web browser and enter 169.254.0.10 in the address box.

4. Log in to the meter webpages. The default login is:

— Username = user1
— Password = pass1

5. Click Setup > Ethernet.

6. Modify the Ethernet setup parameters with the settings your system administrator 
assigned for the meter, then press Apply.

7. Press Apply to send and save the new settings to the meter.

8. Disconnect the meter from the computer.

Final Ethernet configuration steps

1. Re-establish the the computer’s connection to your LAN (plug the computer’s 
Ethernet cable back to your LAN connection or re-enable wireless communications 
to the LAN).

2. Connect the meter’s Ethernet port to your LAN.

3. Open a web browser and enter the meter’s IP address in the address box.

4. Log in to the meter webpages.

Configuring Ethernet settings using the front panel

See “Setting up Ethernet communications” on page 40 for details on using the front 
panel to configure the Ethernet port.

Ethernet & TCP/IP 

Parameter Description

Ethernet MAC Address Displays the meter’s factory-programmed MAC address. 
This information is read-only and cannot be changed.

IP Parameters

IP Address Acquistion 
Mode

This controls the network protocol for your device (which the 
meter uses to obtain its IP address):
• DHCP: Dynamic Host Configuration Protocol1
• BOOTp: Bootstrap Protocol
• Static: Use the static value programmed in the IP 

Address setup register
• Default: Use 85.16 as the first two values of the IP 

address, then convert the last two hexadecimal values of 
the MAC address to decimal and use this as the last two 
values of the IP address.
Example: MAC address = 00:80:67:82:B8:C8
Default IP = 85.16.184.200

1 FQDN (fully qualified device name) is not supported. The device name is not automatically sent to a DNS 
server when a DHCP request is sent. In order to use device name instead of IP address, your IT 
administrator must manually add the device name to the DNS.

IP Address The internet protocol address of your device.

Subnet Mask The Ethernet IP subnetwork address of your network 
(subnet mask).

Default Gateway The Ethernet IP gatway address of your network.
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User setup
To set up users for the webpages:

1. Click Setup > User.

2. Configure the parameters as appropriate.

3. Click Apply to send and save the new settings to the meter.

Device log export setup
You can set up the meter to export its logs to a web server.

NOTE: Device log export times can vary exponentially, depending on the number of 
records to export. To avoid long log export times, consider reducing the logging 
frequency for the recorded items or selecting a more frequent log export schedule 
(e.g., weekly instead of monthly). 

1. Click Setup > Device Log Export.

2. Make sure that the Transport setting is enabled (e.g., set to HTTP). Configure the 
parameters as appropriate.

User Accounts 

Parameter Description

Name
Lists the current usernames for accessing the meter. You can add a new user by 
typing the username in a blank cell.
To remove an existing user, select the name and press Delete on your keyboard.

Password1

1 Always record changes or additions to the username and password list and store the list in a safe place.

Lists the current password associated with each user. After adding a new username, 
you can type a password to associate it with the username. As you enter characters 
for your password, the status bar changes to indicate the password strength (weak, 
medium, strong or very strong).

Group Select the group the username belongs to (e.g., web user or product master).

Language Select the language the webpages are displayed in for the selected username.

Device Log Export 

Parameter Values Description

Transport Disabled, HTTP Select Disabled to disable exporting of meter data logs, 
or select HTTP to enable exporting of meter data logs.

Schedule Daily, Weekly, Monthly

Select Daily to set the meter data log export to once a 
day. Use the Time of Day field to select what time the 
data log export occurs each day.
Select Weekly to set the meter data log export to once a 
week. Use the Time of Day and Day of Week fields to 
select what time and day the data log export occurs each 
week.
Select Monthly to set the meter data log export to once a 
month. Use the Time of Day and Day of Month fields to 
select what time and day the data log export occurs each 
month.

HTTP Parameters

Server IP Address Enter the IP address of the server for the data log export.

Server TCP Port Enter the server port number for HTTP communications.

Proxy Server IP Address Enter the proxy server IP address.

Proxy Server TCP Port Enter the proxy server TCP port number.

PATH Enter the network path of the folder where the data logs 
are to be exported.

Field Name Enter the name of the exported data log.

Host Name If using a virtual host name, enter the name here.

Username Enter the username for accessing the server.

Password Enter the password for accessing the server.



56 HRB1684301-01

Chapter 5—Meter webpages PowerLogic™ PM5500 series user manual

3. Click Apply to send and save the new settings to the meter.

NOTE: You can use the Test HTTP button to test the meter connection to the web 
server.

Related topics
• See “Meter logging” on page 59 for information on what data the meter records.

Viewing the meter webpages
1. Start a web browser and enter the meter’s IP address. When prompted, enter your 

username and password. The default login is:

— Username = user1
— Password = pass1

2. Use the menus along the top banner to select and display the meter's various 
webpages.

NOTE: Click Home to go to the page that is configured as the meter's homepage (e.g., 
Monitoring > Basic Readings).

Monitoring

This menu allows you to navigate to the following webpages:

• Basic Readings
• Power Quality
• Active Alarms
• Alarm History
• Inputs/Outputs
• Data Log

Setting the measurement range

Click Range to set the minimum and maximum ratings (limits) for current, power and 
voltage (L-L and L-N). Select Enable Auto Scale to automatically set the scale on the 
graphical (dial) indicators.

Basic Readings 

Parameter Description

Load Current Real-time load current per phase (Ia, Ib, Ic) and average (I Avg), neutral (In) and 
residual/ground current (Ig), and minimum and maximum recorded values.

Power Real (kW), reactive (kVAR) and apparent (kVA) power, minimum and maximum 
recorded values.

Power Factor Total Real-time power factor (lead or lag), minimum and maximum recorded values.

Voltage Real-time line-to-line voltage (Vab, Vbc, Vca) and average (VLL Avg), line-to-
neutral voltage (Van, Van, Vcn) and average (VLN Avg).

Frequency Real-time frequency, minimum and maximum recorded values

Demand Current
Real-time current demand per phase (Ia, Ib, Ic), demand last interval, peak 
demand with date and timestamp, and the date and time when demand values 
were last reset.

Demand Power Real-time real (kW), reactive (kVAR) and apparent (kVA) power demand. 

Energy
Accumulated values for delivered and received real energy (kWh), reactive energy 
(kVARh) and apparent energy (kVAh), and the date and time when energy values 
were last reset.
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Diagnostics

This menu allows you to navigate to the Meter and Communications webpages.

Meter

This webpage contains information about the meter:

• Meter Information displays the meter model, serial number and manufacture date.
• Firmware Version displays the version numbers of the installed firmware (OS, RS, 

Ethernet, Language and FPGA).

Communications

This webpage displays the meter’s current time and the meter’s last boot time.

This webpage also contains diagnostics information for Ethernet, HTTP server, HTTP 
client and Modbus server. This data aids in troubleshooting communications.

Click Reset to clear the stored information on this page.

Power Quality 

Parameter Description
THD Current Percent total harmonic distortion for each phase current and neutral.

Current Unbalance Percent current unbalance per phase and worst recorded unbalance.

THD VL-L Percent total harmonic distortion for each line-to-line phase voltage.

VL-L Unbalance Percent voltage unbalance for each line-to-line phase voltage and worst recorded 
voltage unbalance.

THD VL-N Percent total harmonic distortion for each line-to-neutral phase voltage.

VL-N Unbalance Percent voltage unbalance for each line-to-neutral phase voltage and worst 
recorded voltage unbalance.

Active Alarms 

Parameter Description

Event1

1 Click the event number to display additional details about the alarm, for example, the actual pickup or 
dropout value and which phase the alarm condition occurred.

This is a list of active (unacknowledged) alarm events with a date/timestamp for 
each event, the value that triggered the alarm (e.g., pickup) and a description of the 
event type.

Alarm History 

Parameter Description

Event1

1 Click the event number to display additional details about the alarm, for example, the actual pickup or 
dropout value and which phase the alarm condition occurred.

This is a historical list of (acknowledged) alarm events with a date/timestamp for 
each event, the value that triggered the alarm (e.g., pickup) and a description of the 
event type.

Inputs / Outputs 

Parameter Description
Inputs Displays the current status of the digital inputs.

Outputs Displays the current status of the digital outputs.

Data Log 

Description
A list of timestamped data recorded in the meter’s data log (energy delivered in Wh, VARh and VAh).
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Maintenance

This menu allows you to navigate to the Registers and Maintenance Log webpages.

Registers

The Read Device Registers page allows you to access the meter and read a specified 
block of Modbus registers:

1. Enter values in the Starting Register and Number of Registers fields.

2. Select the number format of the registers: Decimal, Hexadecimal, Binary, ASCII or 
Float.

3. Click Read.

Maintenance Log

The Maintenance Log page displays a record of meter events, and in particular, 
changes to meter setup. Each event is date/timestamped. The Value field shows a brief 
description what changed and the Event Type specifies which area of the meter was 
affected.

Related topics
• Go to www.schneider-electric.com and search for your meter’s Modbus register list 

to download a copy.

Exporting data logs
See “Device log export setup” on page 55 for details on configuring the meter to 
perform regular data log exports according to a set schedule. To export the meter data 
logs manually, click Manual Export.

Logging out
Click Logout to exit the meter webpages.
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Chapter 6 Meter logging

This section describes the meter’s logging feature. Meter data and events are stored in 
these logs:

• Data log
• Alarm log
• Maintenance log

Data log
The meter is shipped from the factory with data logging enabled for selected values. 
Typically, delivered energy (kWh, kVARh and kVAh) is logged by default, but you can 
configure the meter to record other measurements.

Setting up the data log

Use ION Setup to configure data logging. You can select up to 14 items to record in the 
data log and the frequency (logging interval) that you want those values updated.

1. Start ION Setup and open your meter in setup screens mode (View > Setup 
Screens). See the ION Setup Help for instructions.

2. Double-click Data Log #1.

3. Set up the logging frequency and measurements/data to log.

4. Click OK, then Send to save the changes to the meter.

Saving the data log contents

You can use ION Setup or the meter webpages to save the contents of the data log.

NOTICE
LOST DATA

Save the contents of the data log before configuring it.

Failure to follow these instructions can result in data loss.

Data Log #1 setup parameters 

Parameter Values Description

Status Enable, Disable Set this parameter to enable or disable data 
logging in the meter.

Interval

1 minute, 5 minutes, 
10 minutes, 15 minutes, 
30 minutes, 1 hour, 
24 hours

Select a time value to set the logging frequency.

Channels
Items available for 
logging can vary based 
on the meter type.

Select an item to record from the “Available” 
column, then click the double-right arrow button to 
move the item to the “Selected” column.
To remove an item, select it from the “Selected” 
column then click the double-left arrow button.
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Data log export using ION Setup

1. Start ION Setup and open your meter in data screens mode (View > Data 
Screens). See the ION Setup Help for instructions.

2. Double-click Data Log #1 to retrieve the records.

3. Once the records have finished uploading, right-click anywhere on the viewer and 
select Export CSV from the popup menu to export the entire log.

NOTE: To export only selected records in the log, click the first record you want to 
export, hold down the SHIFT key and click the last record you want to export, then 
select Export CSV from the popup menu.

4. Navigate to the folder where you want to save the data log file, then click Save.

Data log export using a web browser

See “Device log export setup” on page 57 for instructions on saving the data log from 
the webpages.

Alarm log
Alarm records are stored in the meter’s alarm history log. You can use the meter’s 
display or a web browser to view the alarm history log.

Related topics
• See “Active alarms list and alarm history log” on page 102 to view the alarm records 

using the meter’s display.
• See “Viewing the meter webpages” on page 58 to view the alarm records using a 

web browser.

Maintenance log
The meter records maintenance-type events such as changes to meter setup. You can 
use a web browser to view the contents of the maintenance log.

Related topics
• See “Viewing the meter webpages” on page 58 to view the maintenance log using a 

web browser.



HRB1684301-01 61

Chapter 7 Viewing meter data

You can view meter data from the meter’s front panel display, a web browser, or 
through software.

Viewing meter data from the front panel
This section applies to meters that are equipped with a front panel display.

The Summary screen displays real-time values for average voltage and current (Vavg, 
Iavg), total power (Ptot) and energy consumption (E Del).

Displaying data screens

To display data screens, press the button below the appropriate menu. To see more 
menu items, press the  navigation button.

Related topics
• See “Front panel display and meter setup” on page 31 for information on front panel 

menu navigation, LED indicators and display screen notification icons.
• See “Remote meter setup” on page 47 for information on communications port 

setup using the meter webpages and meter configuration using ION Setup.
• See “Alarms” on page 87 for information on alarm indicators and the alarm 

notification icon.
• See “Maintenance and upgrades” on page 121 for information on the wrench 

(maintenance) icon and troubleshooting abnormal LED behavior.

Meter data display screens
The screen menu items are listed below. The titles listed are for the HMI mode in IEEE, 
with the corresponding titles in IEC mode in square brackets [ ].

Related topics
• See “Setting up regional settings” on page 44 for details on changing the HMI 

mode.

Summary screen

A Menu selection buttons

B Scroll right navigation button
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Current

Related topics
• See “Current demand” on page 117.

Voltage

Harmonics

Related topics
• See “Power quality” on page 121.

IgIc In

Phase

Dmd

Amps
(I)

Iavg IbIa

Ig

Amps [I] 

Phase Instantaneous current measurements for each phase and neutral 
(Ia [I1], Ib [I2], Ic [I3], In).

Dmd Summary of peak current demand values at the last demand 
interval for each phase and neutral (Ia [I1], Ib [I2], Ic [I3], In).

Iavg, Ia [I1], Ib [I2], Ic [I3], In, Ig
Real-time demand (Pres), peak demand (Peak) and predicted 
demand (Pred) for the present interval. Average demand for the 
previous (Last) interval.

Pk DT Date and timestamp for the peak demand readings.

Ig Average (Iavg), neutral (In) and residual/ground (Ig) current

Volts
(U-V) V L-L (U)

V L-N (V)

Volts [U-V] 

V L-L [U] Line-to-line phase voltage (Vab [U12], Vbc [U23], Vca [U31]).

V L-N [V] Line-to-neutral phase voltage (Van [V1], Vbn [V2]), Vcn [V3]).

Harm V L-L (U)

V L-N (V)

Amps (I)

TDD / K

Crest

Fund 3-11 13-21 23-31

Fund 3-11 13-21 23-31

Fund 3-11 13-21 23-31

Amps (I) V L-L (U) V L-N (V)

Harm 

V L-L [U] Line-to-line voltage harmonics data: Numeric magnitude and 
angle for the fundamental harmonic, and graphical 
representation of harmonics for the 3rd to 11th, 13th to 21st, and 
23rd to 31st odd harmonics for each line-to-line phase voltage 
(Vab [U12], Vbc [U23], Vca [U31]).

Fund, 3-11, 13-21, 23-31

V L-N [V] Line-to-neutral voltage harmonics data: Numeric magnitude and 
angle for the fundamental harmonic, and graphical 
representation of harmonics for the 3rd to 11th, 13th to 21st, and 
23rd to 31st odd harmonics for each line-to-neutral phase voltage 
(Van [V1], Vbn [V2]), Vcn [V3]).

Fund, 3-11, 13-21, 23-31

Amps [I] Current harmonics data: Numeric magnitude and angle for the 
fundamental harmonics, and graphical representation of 
harmonics for the 3rd to 11th, 13th to 21st, and 23rd to 31st odd 
harmonics for each phase current (Ia [I1], Ib [I2], Ic [I3]).

Fund, 3-11, 13-21, 23-31

TDD/K Total demand distortion and K-factor data for each phase voltage 
(K-F A [K-F 1], .K-F B [K-F 2], K-F C [K-F 3]).

Crest Crest factor data for each phase current (Ia [I1], Ib [I2], Ic [I3]), 
line-to-line phase voltage (Vab [U12], Vbc [U23], Vca [U31]), and 
line-to-neutral phase voltage (Van [V1], Vbn [V2]), Vcn [V3]).Amps [I], V L-L [U], V L-N [V]
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Power

Related topics
• See “Power demand” on page 115.

Energy

Power
(PQS)

Power (PQS)

Phase

Dmd

Active (P) Reac (Q) Appr (S)

VARd (Qd) Tot A B C

Wd (Pd) Tot A B C

VAd (Sd) Tot A B C

Power [PQS] 

Power [PQS]
Summary of real-time power consumption values for total active 
power in kW (Total [Ptot]), total reactive power in kVAR 
(Total [Qtot]), and total apparent power in kVA (Total [Stot]).

Phase Per phase and total power values for active power in kW (A [P1], 
B [P2], C [P3], Total [Ptpt]), reactive power in kVAR (A [Q1], 
B [Q2], C [Q3], Total [Qtot]) and apparent power in kVA (A [S1], 
B [S2], C [S3], Total [Stot]).

Active [P], Reac [Q], Appr [S]

Dmd
Summary of peak power demand values in the previous (Last) 
demand interval period for active power in kW, reactive power in 
kVAR and apparent power in kVA.

Wd [Pd], VARd [Qd], VAd [Sd]

Total and per phase peak power demand values in the previous 
(Last) demand interval for active power demand (Wd [P]), 
reactive power demand (VARd [Q]) and apparent power demand 
(VAd [S]).

Tot, A [1], B [2], C [3]

For the selected power demand screen (active, reactive or 
apparent), each of these sub-screens (total and per phase 
demand) display demand values for the present demand (Pres) 
interval, predicted demand (Pred) based on the current power 
consumption rate, demand for the previous demand (Last) 
interval period, and recorded peak power demand (Peak) value.

Pk DT Date and timestamp for the peak power demand (Peak) value.

Energy
(E)

Wh

VAh

VARh

Inp Mtr

Tariff T1 T2 T3 T4 T5 T6 T7 T8

Dmd Ch 1 Ch 2 Ch 3 Ch 4

Energy [E] 

Wh Delivered (Del), received (Rec), delivered plus received (D+R) 
and delivered minus received (D-R) accumulated values for 
active energy (Wh), apparent energy (VAh) and reactive energy 
(VARh).

VAh

VARh

Tariff
Displays the available tariffs (T1 through T8).

T1, T2, T3, T4, T5, T6, T7, T8

Del
Active energy delivered in Wh (W [P]), reactive energy delivered 
in VARh (VAR [Q]) and apparent energy delivered in VAh 
(VA [S]) energy for the selected tariff.

Rec
Active energy received in Wh (W [P]), reactive energy received in 
VARh (VAR [Q]) and apparent energy received in VAh (VA [S]) 
energy for the selected tariff

InMet Accumulated values on the input metering channels (Ch 1 to 
Ch 4) for the selected tariff.

Inp Mtr Accumulated values on the input metering channels (Ch 1 to 
Ch 4).

Dmd Summary of demand values for input metering channels Ch 1 to 
Ch 4 in the previous (Last) demand interval.

Ch 1, Ch 2, Ch 3, Ch 4

Demand values for present (Pres) and previous (Last) interval 
periods, predicted demand (Pred) based on the current 
consumption rate, and recorded peak demand (Peak) value for 
the selected input metering channel.

Pk DT Date and timestamp for the peak demand reading.



64 HRB1684301-01

Chapter 7—Viewing meter data PowerLogic™ PM5500 series user manual

Related topics
• See “Multi-tariff feature” on page 105.

Power Factor

Frequency

Total harmonic distortion

Related topics
• See “Power quality” on page 121.

Unbalance

PF True

Disp

PF 

True
True power factor values per phase and total (PFa [PF1], PFb 
[PF2], PFc [PF3], Total), PF sign, and load type (capacitive = 
lead, inductive = lag).

Disp
Displacement power factor values per phase and total (PFa 
[PF1], PFb [PF2], PFc [PF3],, Total), PF sign, and load type 
(capacitive = lead, inductive = lag).

Hz
(F)

Hz [F] 

Frequency (Freq), average voltage (Vavg), average current (Iavg) and total power factor (PF) values.

THD THD

thd

Amps (I) V L-L (U) V L-N (V)

Amps (I) V L-L (U) V L-N (V)

THD 

THD THD (ratio of harmonic content to the fundamental) for phase 
currents (Ia [I1], Ib [I2], Ic [I3], In), line-to-line voltages(Vab [U12], 
Vbc [U23], Vca [U31]) and line-to-neutral voltages (Van [V1], 
Vbn [V2], Vcn [V3]).

Amps [I], V L-L [U], V L-N [V]

thd thd (ratio of harmonic content to the rms value of total harmonic 
content) phase currents (Ia [I1], Ib [I2], Ic [I3], In), line-to-line 
voltages(Vab [U12], Vbc [U23], Vca [U31]) and line-to-neutral 
voltages (Van [V1], Vbn [V2], Vcn [V3]).

Amps [I], V L-L [U], V L-N [V]

Unbal

Unbal 

Percent unbalance readings for line-to-line voltage (V L-L [U]), line-to-neutral voltage (V L-N [V]) and current 
(Amps [I]).
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Minimum / maximum

Alarm

Related topics
• See “Alarms” on page 89.

Input / Output

Related topics
• See “Input / Output” on page 71.

MnMx

Volts (U-V)

Amps (I)

Power (PQS)

Unbal

PF

Hz (F)

THD

V L-L (U) V L-N (V)

Active (P) Reac (Q) Appr (S)

True Disp

THD thd

Amps (I) V L-L (U) V L-N (V)

MnMx 

MnMx Summary of maximum values for line-to-line voltage, line-to-
neutral voltage, phase current and total power.

Amps [I] Minimum and maximum values for phase current.

Volts [U-V] Minimum and maximum values for line-to-line voltage and line-
to-neutral voltage.V L-L [U], V L-N [V]

Power [PQS] Minimum and maximum values for active, reactive, and apparent 
power.Active [P], Reac [Q], Appr [S]

PF Minimum and maximum values for true and displacement PF and 
PF sign.True, Disp

Hz [F] Minimum and maximum values for frequency.

THD Minimum and maximum values for total harmonic distortion (THD 
or thd).THD, thd

Amps [I], V L-L [U], 
V L-N [V]

THD or thd minimum and maximum values for phase or neutral 
current, line-to-line voltage and line-to-neutral voltage.

Unbal Minimum and maximum values for current unbalance, line-to-line 
voltage unbalance and line-to-neutral voltage unbalance.Amps [I], V L-L [U], V L-N [V]

Alarm

Hist

Active

Count

Unack

Alarm 

Active
Lists all active alarms (Active), past alarms (Hist), the total 
number each standard alarm has been tripped (Count), and all 
unacknowledged alarms (Unack).

Hist

Count

Unack

I/O

D In

D Out

I/O 

D Out Current status (on or off) of the selected digital output or digital 
input. Counter shows the total number of times an off-to-on 
change of state is detected. Timer shows the total time (in 
seconds) that a digital input or digital output is in the on state.

D In
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Timer

Related topics
• See “Timer” on page 118.

Maintenance

Timer

Oper

Load

Timer 

Load
Real-time counter that keeps track of the total number of days, 
hours, minutes and seconds an active load is connected to the 
meter inputs.

Oper Real-time counter for the total number of days, hours, minutes 
and seconds the meter has been powered.

Maint Reset

Setup

Diag

Basic Adv Dmd Tariff

Serial Enet

1-Sec Unary Dig Logic Cust1s

LED D In D Out Inp Mtr

Displ Region Pass

Polar

Comm

Alarm

I/O

HMI

Clock

Info

Meter

Cl Pwr

Phasor

Meter

Lock (PM5561 only)

Maint 

Reset Screens to perform global or single resets.

Setup
Meter configuration screens.

Meter

Basic, Adv, Dmd, Tariff

Basic: screens to define the power system and power system 
components/elements.
Adv: screens to set up the active load timer and define the peak 
demand current for inclusion in TDD calculations.
Dmd: screens to set up power demand, current demand and 
input metering demand.
Tariff: screens to set up tariffs.

Comm
Screens to set up serial and Ethernet communications.

Serial, Enet

Alarm
Screens to set up standard (1-Sec), unary, digital, logic and 
custom (Cust1s) alarms.1-Sec, Unary, Dig, Logic, 

Cust1s

I/O Screens to set up the alarm / energy pulsing LED, digital inputs, 
digital outputs and input metering channels.LED, D In, D Out, Inp Mtr

HMI Screens to configure display settings, edit regional settings and 
set up front panel meter access passwords.Displ, Region, Pass, 

Clock Screens to set up the meter date and time.

Diag Diagnostic screens provide meter information for 
troubleshooting.

Info

Model, serial number, manufacture date, firmware (OS - 
operating system and RS - reset system) and language versions. 
OS CRC (cyclic redundancy check) is a number that identifies 
the uniqueness between different OS firmware versions — this 
parameter is only available on certain models (e.g., PM5561).

Meter Displays the meter status.
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Related topics
• See “Meter resets” on page 85.
• See “Front panel meter setup” on page 37.
• See “Maintenance and upgrades” on page 125.

Clock

Viewing meter data from a web browser
You can use a web browser to access the meter webpages and configure the Ethernet 
port, view or export logged meter data, read the contents of the meter registers, and 
view real-time meter data. See “Meter webpages” on page 55.

Using ION Setup to view or modify configuration data
You can use ION Setup to view or modify the meter setup parameters. See “Meter 
configuration using ION Setup” on page 53.

Using software to view meter data
There are different software systems and methods you can use to access or display the 
meter data. This can range from using a simple Modbus register interface to read 
stored values in the meter’s registers, to viewing intelligent information from the meter 
through an energy management system.

Power Monitoring Expert
StruxureWare™ Power Monitoring Expert is a complete supervisory software package 
for power management applications. The software collects and organizes data 
gathered from your facility’s electrical network and presents it as meaningful, actionable 
information via an intuitive web interface.

See the Power Monitoring Expert online help for instructions on how to add your meter 
to the system. Power Monitoring Expert communicates with devices on the network to 
provide:

• Real-time monitoring through a multi-user web portal
• Trend graphing and aggregation
• Power quality analysis and compliance monitoring
• Preconfigured and custom reporting

Cl_Power Displays how many times the meter lost control power, and the 
date and time of its last occurrence.

Phasor Displays a graphical representation of the power system the 
meter is monitoring,.

Polar Displays the numeric magnitude and angles of all voltage and 
current phases.

Lock Applies to PM5561. This locks or unlocks the MID protected 
quantities. See “Locking or unlocking the meter” on page 148.

Maint (Continued)

Clock

Clock

Meter date and time (local or GMT).
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Related topics
• See the StruxureWare Power Monitoring Expert online help for instructions on how 

to add your meter into its system for data collection and analysis.
• StruxureWare Power Monitoring Expert user documentation is available in PDF 

format and can be downloaded from www.schneider-electric.com.

PowerSCADA Expert
StruxureWare™ PowerSCADA Expert is a complete real-time monitoring and control 
solution for large facility and critical infrastructure operations. It communicates with your 
meter for data acquisition and real-time control.

You can use PowerSCADA Expert for:

• System supervision and alarm management
• Real-time and historical trending, event logging and waveform capture
• PC-based custom alarms

Related topics
• See the StruxureWare PowerSCADA Expert online help for instructions on how to 

add your meter into its system for data collection and analysis.
• StruxureWare PowerSCADA Expert user documentation is available in PDF format 

and can be downloaded from www.schneider-electric.com.

Modbus command interface

Most of the meter’s real-time and logged data, as well as basic configuration and setup 
of meter features, can be accessed and programmed using a Modbus command 
interface and the meter’s Modbus register list. This is an advanced procedure that 
should only be performed by users with advanced knowledge of Modbus, their meter, 
and the power system being monitored. For further information on the Modbus 
command interface, contact Technical Support.

Related topics
• See your meter’s Modbus register list at www.schneider-electric.com for the 

Modbus mapping information and basic instructions on command interface.
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Chapter 8 Input / Output

This section describes the meter’s I/O (input/output) features. 

The meter is equipped with:

• four (4) digital input ports (S1 to S4), and
• two (2) Form A digital output ports (D1 and D2).

After you wire the meter’s digital I/O ports, you can configure these ports so you can 
use the meter to perform I/O functions.

Digital input applications
Digital inputs are typically used for monitoring the status of external contacts or circuit 
breakers. They can also be used for pulse counting or input metering applications, such 
as WAGES (water, air, gas, electricity, steam) monitoring.

The meter’s digital inputs require an external voltage source to detect the digital input’s 
on/off state. The meter detects an on state if the external voltage appearing at the 
digital input is within its operating range.

Related topics 
• See “Specifications” on page 27 for electrical characteristics and limits for the digital 

inputs.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

• Apply appropriate personal protective equipment (PPE) and follow safe electrical 
work practices. See NFPA 70E in the USA or applicable local standards.

• Turn off all power supplying this device before working on it.
• Always use a properly rated voltage sensing device to confirm that all power is off.
• Do not exceed the device’s ratings for maximum limits.
• Do not use this device for critical control or protection applications where human or 

equipment safety relies on the operation of the control circuit.

Failure to follow these instructions will result in death or serious injury.

Wiring the digital inputs

S1 S2 S3 S4

+ + + +- -- -

+

-

18 - 30 V AC
12 - 60 V DC

+

-

18 - 30 V AC
12 - 60 V DC

+

-

+

-

18 - 30 V AC
12 - 60 V DC

18 - 30 V AC
12 - 60 V DC
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WAGES monitoring

WAGES monitoring allows you to record and analyze all energy sources and utilities 
usage.

Your energy system may use several different types of energy. For example, you may 
consume steam or compressed air for industrial processes, electricity for lights and 
computers, water for cooling and natural gas for heating. WAGES monitoring collects 
the usage information from all these different energy sources to enable a more 
complete energy analysis.

WAGES information can help you:

• Identify losses or inefficiencies.
• Modify demand to reduce costs.
• Optimize energy source usage.

WAGES application example

You can connect your meter’s digital input to a transducer that sends a pulse for every 
15 liters of water. After configuring an input metering channel and assigning it to the 
digital input, the meter is able to detect and record the incoming pulses. An energy 
management system can then use the information from the meter to perform WAGES 
analysis.

Related topics
• See “Input metering setup” on page 73 for details on configuring input metering.

Digital input setup

The digital input ports (S1 to S4) can be configured using the front panel or ION Setup 
software.

NOTE: It is recommended you use ION Setup to configure the digital inputs, as setup 
parameters that require text entry can only be modified using ION Setup.

Configuring digital inputs using ION Setup

You can use ION Setup to configure the digital inputs.

1. Start ION Setup.

2. Connect to your meter.

3. Navigate to I/O configuration > I/O Setup.

4. Select a digital input to configure and click Edit. The setup screen for that digital 
input is displayed.

5. Enter a descriptive name for the digital input’s Label.

30

Water flow meter

15 L/pulse

Energy meter

Input Metering

Channel 1
Unit code: L
Digital input 1

Energy management system

WAGES analysis software
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6. Configure the other setup parameters as required.

7. Click Send to save your changes.

Configuring digital inputs using the front panel

You can use the front panel to configure the digital inputs.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to I/O > D In.

4. Move the cursor to point to the digital input you want to set up, then press Edit.

5. Move the cursor to point to the parameter you want to modify, then press Edit.

NOTE: If Edit is not displayed, it means the parameter is either read-only or can 
only be modified through software. 

6. Modify the parameter as required, then press OK.

Digital input setup parameters available through ION Setup 

Parameter Values Description

Label — Use this field to change the default label and assign a 
descriptive name to this digital input.

Control Mode Normal, Demand Sync, Input 
Metering, Multi-Tariff

This field displays how the digital input functions.
• Normal: the digital input is either associated with a 

digital input alarm, or it is not associated with 
another meter function. The meter counts and 
records the number of incoming pulses normally.

• Demand Sync: the digital input is associated with 
one of the input sync demand functions. The meter 
uses the incoming pulse to synchronize its demand 
period with the external source.

• Input Metering: the digital input is associated with 
one of the input metering channels. The meter 
counts and records the number of incoming pulses 
and related consumption data associated with the 
pulses.

• Multi-Tariff: the digital input is associated with the 
multi-tariff function. See “Input mode overview” on 
page 105.

Debounce 0 to 1000

Debounce is the time delay that compensates for 
mechanical contact bounce. Use this field to set how 
long (in milliseconds) the external signal must remain in 
a certain state to be considered a valid state change. 
Allowable values are increments of 10 (i.e., 10, 20, 30, 
etc., up to 1000 ms).

Associations — This field displays additional information if the digital 
input is already associated with another meter function.

Digital input setup menu tree

Maint Reset

Setup

LED D In D Out Inp Mtr

Comm

Alarm

I/O

Meter
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7. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

8. Press  to exit. Press Yes to save your changes.

Related topics
• See “Synchronized demand” on page 112 for information on using an external 

source to synchronize meter demand periods.
• See “Input metering setup” on page 73 for details on associating a digital input for 

input metering applications.

Input metering
Your meter’s digital inputs can be used to count pulses from transducers and convert 
the pulses to energy measurements. 

Your meter’s input metering channels count pulses received from the digital inputs 
assigned to that channel. The incoming pulses are used in calculating and measuring 
consumption data (e.g., BTU, kWh, L, kg). Each channel must have the following 
values configured to match the pulse data:

• Pulse Weight: the pulses per unit value.
• Unit Code: the unit of measure associated with the monitored value.
• Demand Code: for time-based values (such as kWh), this provides the associated 

demand units (kW) for demand calculations; for other values (such as kg), this can 
be configured to provide rate information (kg/h or kg/s).

• Mode: Whether pulse counting based on full pulses or transitions.

For example, if each complete pulse represents 125 Wh, you can configure for Wh 
pulsing as follows:

• Pulse Weight = pulses/Wh = 1/125 = 0.008
• Unit Code = Wh
• Demand Code = kW (this is automatically set)
• Mode = pulse

Digital input setup parameters available through the front panel 

Parameter Values Description

Label — This can be modified only through software. Use this 
field to assign names to the digital inputs (S1 to S4).

Debounce Time 
(ms) 0 to 1000

Debounce is the time delay that compensates for 
mechanical contact bounce. Use this field to set how 
long (in milliseconds) the external signal must remain in 
a certain state to be considered a valid state change. 
Allowable values are increments of 10 (i.e., 10, 20, 30, 
etc., up to 1000 ms).

Control Mode Normal, Demand Sync, Input 
Metering, Multi-Tariff

This field displays how the digital input functions.
• Normal: the digital input is either associated with a 

digital input alarm, or it is not associated with 
another meter function. The meter counts and 
records the number of incoming pulses normally.

• Demand Sync: the digital input is associated with 
one of the input sync demand functions. The meter 
uses the incoming pulse to synchronize its demand 
period with the external source.

• Input Metering: the digital input is associated with 
one of the input metering channels. The meter 
counts and records the number of incoming pulses 
and related consumption data associated with the 
pulses.

• Multi-Tariff: the digital input is associated with the 
multi-tariff function. See “Input mode overview” on 
page 105.
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If you want to configure for kWh pulsing, you must adjust the pulse weight calculation 
and unit code as follows:

• Pulse Weight = pulses/kWh = 1/0.125 = 8
• Unit Code = kWh

Input metering setup

Input metering can be configured using the front panel or software.

NOTE: It is recommended you use ION Setup to configure input metering, as setup 
parameters that require text entry can only be modified using ION Setup.

Configuring input metering using ION Setup

You can use ION Setup to configure the input metering channels.

1. Start ION Setup.

2. Connect to your meter

3. Navigate to I/O configuration > Input metering.

4. Select an input metering channel to configure and click Edit. The Channel Setup 
screen is displayed

5. Enter a descriptive name for the metering channel’s Label.

6. Configure the other input metering parameters as required.

7. Click Send to save your changes.

Configuring input metering using the front panel

You can use the front panel to configure the input metering channels.

Input metering setup parameters 

Parameter Values Description

Label — Use this field to change the default label and assign a 
descriptive name to this input metering channel.

Pulse Weight 0 to 99.99999 Use this field to specify the quantity or value each pulse 
represents.

Units

No units, Wh, kWh, MWh, 
VARh, kVARh, MVARh, 
VAh, kVAh, MVAh, gal, BTU, 
L, m3, MCF, lbs, kg, klbs, 
Therm

Select the unit of measurement associated with the 
monitored value.

Rate
(see table in “Demand 
measurements for input 
metering” on page 74)

For time-based values (such as kWh), this provides the 
associated demand units (kW) for demand calculations. 
For other values (such as kg), this can be configured to 
provide rate information (kg/h).

Mode Pulse or Transition
Set Mode to Pulse to count only complete pulses. Set 
Mode to Transition to count each ON-to-OFF or OFF-to-
ON status change.

Available Inputs / 
Assigned Inputs Digital Input DI1 to DI4

Select the digital input from the Available Inputs box and 
use the right arrow button to assign the input metering 
channel to that digital input.
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1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to I/O > Inp Mtr.

4. Move the cursor to point to the input metering channel you want to set up, then 
press Edit.

5. Move the cursor to point to the parameter you want to modify, then press Edit.

NOTE: If Edit is not displayed, it means the parameter is either read-only or can 
only be modified through software.

6. Modify the parameter as required, then press OK.

7. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

8. Press  to exit. Press Yes to save your changes.

Demand measurements for input metering

Based on the unit code selected, the following demand codes are set or selectable.

Input metering setup menu tree

Input metering setup parameters 

Parameter Values Description

Label —
This can be modified only through software. Use this 
field to assign names to the input metering channels 
(Channel 1 to 4).

Pulse Weight 0 to 99.99999 Use this to specify the quantity or value each pulse 
represents.

Unit Code

None, Wh, kWh, MWh, 
VARh, kVARh, MVARh, 
VAh, kVAh, MVAh, gal, BTU, 
L, m3, MCF, lbs, kg, klbs, 
Therm

Select the unit of measurement associated with the 
monitored value.

Demand Code
(see table in “Demand 
measurements for input 
metering” on page 74)

For time-based values (such as kWh), this provides the 
associated demand units (kW) for demand calculations. 
For other values (such as kg), this can be configured to 
provide rate information (kg/h).

Mode Pulse or Transition
Set Mode to Pulse to count only complete pulses. Set 
Mode to Transition to count each ON-to-OFF or OFF-to-
ON status change.

Digital Inputs Digital Input DI1 to DI4 Select the digital input port that is used for input 
metering.

Maint Reset

Setup

LED D In D Out Inp Mtr

Comm

Alarm

I/O

Meter

Input metering unit and demand measurements 

Unit Code Demand Code Description

None None Default setting for the input metering channels.

Wh

kW
Watt-hour kiloWatt-hour and MegaWatt-hour 
measurements are converted to calculate demand in 
kW.

kWh

MWh

VARh

kVAR
VAR-hour kiloVAR-hour and MegaVAR-hour 
measurements are converted to calculate demand in 
kVAR.

kVARh

MVARh
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Viewing input metering data
You can use the front panel to view the input metering data.

Using the meter’s display

Navigate to the energy screens and select the input metering channel to (Ch1 - Ch4) to 
view the data.

NOTE: The display screen shows accumulation values from 0 to 99999. The display 
rolls over to zero when accumulated value reaches 100000 and starts incrementing 
again.

Digital output applications
Digital outputs are typically used in switching applications, for example, to provide 
on/off control signals for switching capacitor banks, generators, and other external 
devices and equipment. They can also be used in demand synchronization 
applications, where the meter provides pulse signals to the input of another meter to 
control its demand period.

The digital output can also be used in energy pulsing applications, where a receiving 
device determines energy usage by counting the kWh pulses coming from the meter’s 
digital output port.

VAh

kVA VA-hour kiloVA-hour and megaVA-hour measurements 
are converted to calculate demand in kVA.kVAh

MVAh

gal GPH, GPM Select GPH to set rate to gallons per hour, or GPM to 
set it to gallons per minute.

BTU BTU/h BTU (British thermal unit) energy measurements are set 
to calculate BTUs per hour consumption rate.

L l/hr, l/min Select liters per hour or per minute consumption rate.

m3 m3/hr, m3/s, m3/m Select cubic meters per hour, per second, or per minute 
consumption rate.

MCF cfm
Thousand cubic feet volume measurements are 
converted to calculate cubic feet per minute 
consumption rate.

lbs
lb/hr Kilopound (klbs) measurements are converted to 

calculate pounds per hour consumption rate.klbs

kg kg/hr Kilogram measurements are set to calculate kilogram 
per hour consumption rate.

Therm Thm/h
British therm (equivalent to 100,000 BTU) heat 
measurements are set to calculate therm per hour 
consumption rate.

Input metering unit and demand measurements (Continued)

Unit Code Demand Code Description

Energy
(E)

Wh

VAh

VARh

Inp Mtr

Tariff

Dmd Ch 1 Ch 2 Ch 3 Ch 4
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NOTE: Be aware that an unexpected change of state of the digital outputs may result 
when the supply power to the meter is interrupted or after a meter firmware upgrade.

Digital output application example

You can connect one of your meter’s digital outputs to a relay that switches on a 
generator and the other digital output to send a demand sync pulse to other meters. In 
the following example, the first meter (Meter 1) controls and sets the demand period 
(900 seconds) of the other meters (Meter 2, Meter 3, Meter 4) through the output pulse 
occurring at the end of the first meter’s demand interval.

Related topics
• See “Specifications” on page 28 for electrical characteristics and limits for the digital 

outputs.
• See “Demand setup” on page 40 for details on configuring demand parameters.
• See “Power demand calculation methods” on page 115 for descriptions of the 

different demand calculation methods.

Digital output setup

The digital output ports (D1 and D2) can be configured using the front panel or 
ION Setup.

NOTE: It is recommended you use ION Setup to configure the digital outputs, as setup 
parameters that require text entry can only be modified using software.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

• Apply appropriate personal protective equipment (PPE) and follow safe electrical 
work practices. See NFPA 70E in the USA or applicable local standards.

• Turn off all power supplying this device before working on it.
• Always use a properly rated voltage sensing device to confirm that all power is off.
• Do not exceed the device’s ratings for maximum limits.
• Do not use this device for critical control or protection applications where human or 

equipment safety relies on the operation of the control circuit.

Failure to follow these instructions will result in death or serious injury.

Digital output wiring example

+

-

< 30 V AC
< 60 V DC

D1 D2

+ - + -

900 s+

-

< 30 V AC
< 60 V DC

D1 D2

+ - + -

900 s

Meter 1 digital outputs

Meter 2 Meter 3 Meter 4

125 mA
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Configuring digital outputs using ION Setup

You can use ION Setup to configure the digital outputs (D1 and D2).

1. Start ION Setup.

2. Connect to your meter

3. Navigate to I/O configuration > I/O Setup.

4. Select a digital output to configure and click Edit. The setup screen for that digital 
output is displayed.

5. Enter a descriptive name for the digital output’s Label.

6. Configure the other setup parameters as required.

7. Click Send to save your changes.

Digital output setup parameters available through ION Setup 

Parameter Values Description

Label — Use this field to change the default label and assign a 
descriptive name to this digital output.

Control Mode External, Demand Sync, 
Alarm, Energy

This field displays how the digital output functions.
• External: the digital output is controlled remotely 

either through software or by a PLC using 
commands sent through communications.

• Demand Sync: the digital output is associated 
with one of the demand systems. The meter 
sends a pulse to the digital output port at the end 
of every demand interval.

• Alarm: the digital input is associated with the 
alarm system. The meter sends a pulse to the 
digital output port when the alarm is triggered.

• Energy: The digital output is associated with 
energy pulsing. When this mode is selected, you 
can select the energy parameter and the set the 
pulse rate (pulses/kW).

Behavior Mode Normal, Timed, Coil Hold

• Normal: this mode applies when control mode is 
set to External or Alarm. The digital output 
remains in the ON state until an OFF command is 
sent by the computer or PLC.

• Timed: the digital output remains ON for the 
period defined by the On Time setup register.

• Coil Hold: this mode applies when control mode 
is set to External or Alarm. For a unary alarm that 
is associated with a digital output, you must set 
Behavior Mode to Coil Hold. The output turns on 
when the “energize” command is received and 
turns off when the “coil hold release” command is 
received. In the event of a control power loss, the 
output remembers and returns to the state it was 
in when control power was lost.

On Time (s) 0 to 9999 This setting defines the pulse width (ON time) in 
seconds.

Select Dmd System Power, Current, Input 
Metering

Applies when Control Mode is set to Demand Sync. 
Select the demand system to monitor. 
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Configuring digital outputs using the front panel

You can use the front panel to configure the digital outputs.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to I/O > D Out.

4. Move the cursor to point to the digital output you want to set up, then press Edit.

5. Move the cursor to point to the parameter you want to modify, then press Edit.

NOTE: If Edit is not displayed, it means the parameter is either read-only or can only 
be modified through software.

6. Modify the parameter as required, then press OK.

7. Move the cursor to point to the next parameter you want to modify, press Edit, 
make your changes, then press OK.

8. Press  to exit. Press Yes to save your changes.

Select Alarms

Over Current, Ph; Under 
Current, Ph; Over Current, 
N; Over Current, Gnd; Over 
Voltage, L-L; Under 
Voltage, L-L; Over Voltage, 
L-N; Under Voltage L-N; 
Over kW; Over kVAR; Over 
kVA; Lead PF, True; Lag 
PF, True; Lead PF, Disp; 
Lag PF, Disp; Over kW 
Dmd, Pres; Over kW Dmd, 
Last; Over kW Dmd, Pred; 
Over kVAR Dmd,Pres; Over 
kVAR Dmd,Last; Over 
kVAR Dmd,Pred; Over kVA 
Dmd, Pres; Over kVA Dmd, 
Last; Over kVA Dmd, Pred; 
Over Frequency; Under 
Frequency; Over Voltage 
Unbal; Over Voltage THD; 
Phase Loss; Meter 
Powerup; Meter Reset; 
Meter Diagnostic; Phase 
Reversal; Digital Alarm S1 
through S4; Custom Alarm 
1 through 5; Logic Alarm 1 
through 10

Applies when Control Mode is set to Alarm. Select 
one or more alarms to monitor.

Associations —
This field displays additional information if the digital 
output is already associated with another meter 
function.

Digital output setup menu tree

Digital output setup parameters available through ION Setup (Continued)

Parameter Values Description

Maint Reset

Setup

LED D In D Out Inp Mtr

Comm

Alarm

I/O

Meter
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Related topics
• See “Synchronized demand” on page 116 for information on using an external 

source to synchronize meter demand periods.
• See “Demand setup” on page 40 for details on configuring a digital output to send 

demand sync pulses to another connected device.

Digital output setup parameters available through the front panel 

Parameter Values Description

Label -----
This can be modified only through software. Use this 
field to change the default label and assign a 
descriptive name to this digital output.

Control Mode External, Demand Sync, 
Alarm, Energy

This field displays how the digital output functions.
• External: the digital output is controlled remotely 

either through software or by a PLC using 
commands sent through communications.

• Demand Sync: the digital output is associated 
with one of the demand systems. The meter 
sends a pulse to the digital output port at the end 
of every demand interval.

• Alarm: the digital input is associated with the 
alarm system. The meter sends a pulse to the 
digital output port when the alarm is triggered.

• Energy: The digital output is associated with 
energy pulsing. When this mode is selected, you 
can select the energy parameter and the set the 
pulse rate (pulses/kW).

Behavior Mode Normal, Timed, Coil Hold

• Normal: this applies when control mode is set to 
External or Alarm. The digital output remains in 
the ON state until an OFF command is sent by 
the computer or PLC.

• Timed: the digital output remains ON for the 
period defined by the On Time setup register.

• Coil Hold: this applies when control mode is set to 
External or Alarm. For a unary alarm that is 
associated with a digital output, you must set 
Behavior Mode to Coil Hold. The output turns on 
when the “energize” command is received and 
turns off when the “coil hold release” command is 
received. In the event of a control power loss, the 
output remembers and returns to the state it was 
in when control power was lost.

On Time (s) 0 to 9999 This defines the pulse width (ON time) in seconds.

Select Dmd System Power, Current, Input 
Metering

Applies when Control Mode is set to Demand Sync. 
Select the demand system to monitor. 

Select Alarms

Over Current, Ph; Under 
Current, Ph; Over Current, 
N; Over Current, Gnd; Over 
Voltage, L-L; Under 
Voltage, L-L; Over Voltage, 
L-N; Under Voltage L-N; 
Over kW; Over kVAR; Over 
kVA; Lead PF, True; Lag 
PF, True; Lead PF, Disp; 
Lag PF, Disp; Over kW 
Dmd, Pres; Over kW Dmd, 
Last; Over kW Dmd, Pred; 
Over kVAR Dmd,Pres; Over 
kVAR Dmd,Last; Over 
kVAR Dmd,Pred; Over kVA 
Dmd, Pres; Over kVA Dmd, 
Last; Over kVA Dmd, Pred; 
Over Frequency; Under 
Frequency; Over Voltage 
Unbal; Over Voltage THD; 
Phase Loss; Meter 
Powerup; Meter Reset; 
Meter Diagnostic; Phase 
Reversal; Digital Alarm S1 
through S4; Custom Alarm 
1 through 5; Logic Alarm 1 
through 10

Applies when Control Mode is set to Alarm. Select 
one or more alarms to monitor.
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Energy pulsing
You can configure the meter’s alarm / energy LED or one of the digital outputs for 
energy pulsing applications.

NOTE: The alarm / energy pulsing LED on the PM5561 is permanently set for energy 
pulsing and cannot be disabled or used for alarms.

When set to detect alarms, the LED blinks to indicate an alarm condition. See “Alarm 
priorities” on page 96 for a description of the LED behavior based on different alarms.

When the LED is set to energy pulsing, the meter sends a readable pulse or signal 
based on the measured energy. This pulse can be used for accuracy verification or as 
an input to another energy monitoring system. The meter uses the pulse constant 
setting in pulses per k_h to determine the frequency and number of pulses sent to the 
LED (where k_h = kWh, kVARh or kVAh depending on the energy parameter selected).

The LED setup screen allows you to configure the alarm / energy pulsing LED for 
alarming or energy pulsing applications.

Configuring the alarm / energy pulsing LED using the front panel

You can use the front panel display to configure your meter’s LED for alarming or 
energy pulsing application.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to I/O > LED.

4. Move the cursor to point to the parameter you want to modify, then press Edit.

Location of alarm / energy pulsing LED 

PM5560, PM5561 PM5563 A Alarm / energy pulsing LED

Alarm / energy pulsing LED settings menu tree

Maint Reset

Setup

LED D In D Out Inp Mtr

Comm

Alarm

I/O

Meter
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5. Press  or  to modify the parameter as required, then press OK.

6. Press  to exit. Press Yes to save your changes.

Configuring the LED or digital output for energy pulsing using 
ION Setup

You can use the ION Setup to configure your meter’s LED or digital output for energy 
pulsing.

1. Start ION Setup.

2. Connect to your meter

3. Navigate to I/O configuration > Energy Pulsing.

4. Select the LED or a digital output to configure and click Edit. The setup screen is 
displayed.

5. Enter a descriptive name for the digital output’s Label.

6. Configure the other setup parameters as required.

7. Click Send to save your changes.

Related topics
• See “Alarm display and notification” on page 102 for details on using the front panel 

to view and acknowledge alarms.
• See “Alarm priorities” on page 96 for a detailed description on the alarm / energy 

pulsing LED’s behavior when it is configured for alarm notification.

Alarm / energy pulsing LED setup parameters 

Setting Option or range Description

Mode Disabled, Alarm, Energy
Disabled turns off the LED completely.
Alarm sets the LED for alarm notification.
Energy sets the LED for energy pulsing.

Parameter

Active Del,
Active Rec,
Active Del + Rec,
Reactive Del,
Reactive Rec,
Reactive Del + Rec,
Apparent Del,
Apparent Rec,
Apparent Del + Rec

Select which accumulated energy channel to monitor and 
use for energy pulsing. This setting is ignored when the 
LED mode is set to Alarm.

Pulse Wt. (p/k_h) 1 to 9999999

When configured for energy pulsing, this setting defines 
how many pulses are sent to the LED for every 1 kWh, 
1 kVARh or 1kVAh accumulated energy. This setting is 
ignored when the LED mode is set to Alarm.

Alarm / energy pulsing LED setup parameters available through ION Setup 

Parameter Values Description

Mode Off, Alarm, Energy
Off disables the LED.
Alarm sets the LED for alarm notification.
Energy sets the LED for energy pulsing.

Pulse Wt. (p/k_h) 1 to 9999999

When configured for energy pulsing, this 
defines how many pulses are sent to the LED 
for every 1 kWh, 1 kVARh or 1kVAh of 
accumulated energy.

Channel

Active Energy Delivered,
Active Energy Received,
Active Energy Del+Rec,
Reactive Energy Delivered,
Reactive Energy Received,
Reactive Energy Del+Rec,
Apparent Energy Delivered,
Apparent Energy Received
Apparent Energy Del+Rec

Select which accumulated energy channel to 
monitor and use for energy pulsing.
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Chapter 9 Meter resets

Reset commands clear the meter’s onboard data logs and related registers. Meter 
resets are typically performed after you make changes to the meter’s basic setup 
parameters (such as power system, frequency, or PT/CT settings), to clear invalid or 
obsolete data in preparation for putting the meter into active service.

The meter reset commands are grouped into two categories: Global Resets and Single 
Resets.

Related topics
• For meter reset procedures using ION Setup, see “Meter configuration using ION 

Setup” on page 51.

Front panel meter reset screens
To access the meter reset screens, navigate to Maint > Reset.

Global resets
Global resets allow you to clear all data of a particular type, such as all energy values or 
all minimum/maximum values.

Meter Initialization is a special command that clears the meter’s recorded logged data, 
counters and timers. It is common practice to initialize the meter after its configuration is 
completed, before adding it to an energy management system.

1. Navigate to Maint > Reset.

2. Move the cursor to point to Global Reset, then press Select.

3. Move the cursor to point to the parameter you want to reset, then press Reset.

4. Enter the reset password (default is “0”), then press OK.

5. Press Yes to confirm the reset or No to cancel and return to the previous screen.

Reset menu tree

Maint Reset

Global reset options

Parameter Description

Meter Initialization Clears all data listed in this table (energy, demand, min/max values, 
counters, logs, timers, and input metering data).

Energies Clears all accumulated energy values (kWh, kVARh, kVAh).

Demands Clears all the demand registers.

Min/Max Clears all the minimum and maximum registers.

Alarm Counts & Logs Clears all the alarm counters and alarm logs.

I/O Counts & Timers Clears all the I/O counters and resets all the timers.

Input Metering Clears all input metering energy data.
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Single resets
Single resets allow you to clear data only in a specific register or register type.

1. Navigate to Maint > Reset.

2. Move the cursor to point to Single Reset, then press Select.

3. Move the cursor to point to the parameter you want to reset, then press Reset. If 
there are additional options for the parameter, press Select, move the cursor to 
point to the option you want, then press Reset.

4. Enter the reset password (default is “0”), then press OK.

5. Press Yes to confirm the reset or No to cancel and return to the previous screen.

Single reset options

Parameter Option Description

Energy Accumulated Clears all accumulated energy values (kWh, 
kVARh, kVAh).

Demand Power, Current, Input Metering
Select which demand registers to clear 
(power demand, current demand or input 
metering demand).

Alarms

Event Queue Clears the alarm event queue register (actve 
alarms list).

History Log Clears the alarm history log.

Counters

All Alarm Counts, 
(various alarm 
counters) — see the 
next table

Select “Counters”, then select which counter 
to clear (choose all or individual alarm 
counters listed in the “Alarm counter options”  
table below).

Digital Inputs

Timers

All Dig In Timers, 
Digital Input DI1, 
Digital Input DI2, 
Digital Input DI3, 
Digital Input DI4

Select “Timers”, then select which digital 
input timer to clear (choose all or individual 
digital input timers).

Counters

All Dig In Counters, 
Digital Input DI1, 
Digital Input DI2, 
Digital Input DI3, 
Digital Input DI4

Select “Timers”, then select which digital 
input counter to clear (choose all or individual 
digital input counters).

Digital Outputs

Timers
All Dig Out Timers, 
Digital Output DO1, 
Digital Output DO2

Select “Timers”, then select which digital 
output timer to clear (choose all or individual 
digital output timers).

Counters
All Dig Out Counters, 
Digital Output DO1, 
Digital Output DO2

Select “Timers”, then select which digital 
output counter to clear (choose all or 
individual digital output counters).

Active Load Timer Clears and restarts the load operation timer.

Multi-Tariff Clears accumulated values in all tariff 
register.

Input Metering
Reset All InptMtr, Reset InpMtr 
Chan 1, Reset InpMtr Chan 2, Reset 
InpMtr Chan 3,Reset InpMtr Chan 4

Select which input metering channel (InpMtr 
Chan) to clear (choose all or individual input 
metering channels).

Alarm counter options 

Alarm counter Option Description

Current

Over Current, Ph

Select which alarm counter register to reset from 
the current alarm condition counters.

Under Current, Ph

Over Current, N

Over Current, Gnd

Voltage

Over Voltage, L-L

Select which alarm counter register to reset from 
the voltage alarm condition counters.

Under Voltage, L-L

Over Voltage, L-N

Under Voltage, L-N

Over Voltage Unbal

Over Voltage THD

Phase Loss
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Power

Over kW
Select which alarm counter register to reset from 
the power alarm condition counters.Over kVAR

Over kVA

Power Factor

Lead PF, True

Select which alarm counter register to reset from 
the power factor alarm condition counters.

Lag PF, True

Lead PF, Disp

Lag PF, Disp

Demand

Over kW Dmd, Pres

Select which alarm counter register to reset from 
the demand alarm condition counters.

Over kW Dmd, Last

Over kW Dmd, Pred

Over kVAR Dmd, Pres

Over kVAR Dmd, Last

Over kVAR Dmd, Pred

Over kVA Dmd, Pres

Over kVA Dmd, Last

Over kW Dmd, Pred

Frequency
Over Frequency Select which alarm counter register to reset from 

the frequency alarm condition counters.Under Frequency

Unary

Meter Powerup

Select which alarm counter register to reset from 
the unary alarm condition counters.

Meter Reset

Meter Diagnostic

Phase Reversal

Digital Inputs

Digital Alarm DI1

Select which alarm counter register to reset from 
the digital input alarm condition counters.

Digital Alarm DI2

Digital Alarm DI3

Digital Alarm DI4

Cust1s

Custom Alarm 1

Select which alarm counter register to reset from 
the custom 1-second alarm condition counters.

Custom Alarm 2

Custom Alarm 3

Custom Alarm 4

Custom Alarm 5

Logic

Logic Alarm 1

Select which alarm counter register to reset from 
the logic alarm condition counters.

Logic Alarm 2

Logic Alarm 3

Logic Alarm 4

Logic Alarm 5

Logic Alarm 6

Logic Alarm 7

Logic Alarm 8

Logic Alarm 9

Logic Alarm 10

Alarm counter options (Continued)

Alarm counter Option Description
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Chapter 10 Alarms

This section describes the meter’s alarms feature. An alarm is the meter’s means of 
notifying you when an alarm condition is detected, such as an error or an event that 
falls outside of normal operating conditions.

Alarm overview
When an alarm is tripped, the meter records the alarm event, and the alarm indicator 
appears on the meter display if it is a low, medium or high priority alarm. The alarm can 
also be used to trigger another event, such as controlling a digital output.

NOTE: If configured for alarms, the alarm / energy pulsing LED flashes when the alarm 
is tripped. See “LED alarm indicator” on page 99 to set up the LED for alarms.

Alarm types
The meter supports these types of alarms (total available indicated in parentheses):

• Unary (4)
• Digital (4)
• Standard (29)
• Logic (10)
• Custom (5)

Unary alarms
A unary alarm is the simplest type of alarm — it monitors a single behavior, event or 
condition.

WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection applications where human or 
equipment safety relies on the operation of the control circuit.

Failure to follow this instruction can result in death or serious injury.

Unary alarms 

Alarm label Description

Meter Power Up Meter powers on after losing control power.

Meter Reset Meter resets for any reason.

Meter Diagnostic Meter’s self-diagnostic feature detects a problem.

Phase Reversal Meter detects a phase rotation different than expected.
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Digital alarms
Digital alarms monitor the ON or OFF state of the meter’s digital inputs (S1 to S4).

Digital alarm with setpoint delay

To prevent false triggers from erratic signals, you can set up a time delay for the digital 
alarm.

NOTE: To prevent filling the alarm log with nuisance alarm trips, the digital alarm is 
automatically disabled if the digital input changes state more than 4 times in one 
second or more than 10 times in ten seconds. See “Digital input setup” on page 72 to 
adjust the Debounce setting for the digital inputs.

Standard alarms
Standard (1-Sec) alarms have a detection rate equal to the 50/60 meter cycle, which is 
nominally 1 second if the meter’s frequency setting is configured to match the system 
frequency (50 or 60 Hz). These setpoint-driven alarms monitor certain behaviors, 
events or unwanted conditions in your electrical system.

Many of the standard alarms are three-phase alarms. Alarm setpoints are evaluated for 
each of the three phases individually, but the alarm is reported as a single alarm. The 
alarm pickup occurs when the first phase exceeds the alarm pickup magnitude for the 
pickup time delay. The alarm is active as long as any phase remains in an alarm state. 
The alarm dropout occurs when the last phase drops below the dropout magnitude for 
the dropout time delay. 

Digital alarms 

Alarm label Description

Digital Alarm S1 Digital input 1

Digital Alarm S2 Digital input 2

Digital Alarm S3 Digital input 3

Digital Alarm S4 Digital input 4

Adding setpoint delays to a digital alarm

A Pickup setpoint (1 = ON) ∆T2 Dropout time delay (in seconds)

B Dropout setpoint (0 = OFF) EV2 End of alarm condition

∆T1 Pickup time delay (in seconds) ∆T3 Alarm duration (in seconds)

EV1 Start of alarm condition

EV1 EV2

0

1
ΔT1 ΔT2

ΔT3

Standard (1-Sec) alarms 

Alarm label Valid range and resolution1

Units
ION Setup Meter display ION Setup Meter display

Over Phase Current Over Current, Ph 0.000 to 99999.000 0 to 99999 A

Under Phase Current Under Current, Ph 0.000 to 99999.000 0 to 99999 A

Over Neutral Current Over Current, N 0.000 to 99999.000 0 to 99999 A
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NOTE: Some alarms do not apply to all power system configurations. For example, 
line-to-neutral voltage alarms cannot be enabled on 3-phase delta systems.

Setpoint conditions

A setpoint condition occurs when the magnitude of the signal being monitored crosses 
the limit specified by the pickup setpoint setting and stays within that limit for a minimum 
time period specified by the pickup time delay setting.

The setpoint condition ends when the magnitude of the signal being monitored crosses 
the limit specified by dropout setpoint setting and stays within that limit for a minimum 
time period specified by dropout time delay setting.

The meter supports these types of setpoint conditions:

Over setpoint

When the value rises above the pickup setpoint setting and remains there long enough 
to satisfy the pickup time delay period (∆T1), the alarm condition is set to ON. When the 
value falls below the dropout setpoint setting and remains there long enough to satisfy 
the dropout time delay period (∆T2), the alarm condition is set to OFF.

Over Ground Current Over Current, Gnd 0.000 to 99999.000 0 to 99999 A

Over Voltage L-L Over Voltage, L-L 0.00 to 999999.00 0 to 999999 V

Under Voltage L-L Under Voltage, L-L 0.00 to 999999.00 0 to 9999999 V

Over Voltage L-N Over Voltage, L-N 0.00 to 999999.00 0 to 9999999 V

Under Voltage L-N Under Voltage L-N 0.00 to 999999.00 0 to 9999999 V

Over Active Power Over kW 0.0 to 9999999.0 0 to 9999999 kW

Over Reactive Power Over kVAR 0.0 to 9999999.0 0 to 9999999 kVAR

Over Apparent Power Over kVA 0.0 to 9999999.0 0 to 9999999 kVA

Leading True PF Lead PF, True -1.00 to -0.01 and 0.01 to 1.00 —

Lagging True PF Lag PF, True -1.00 to -0.01 and 0.01 to 1.00 —

Leading Disp PF Lead PF, Disp -1.00 to -0.01 and 0.01 to 1.00 —

Lagging Disp PF Lag PF, Disp -1.00 to -0.01 and 0.01 to 1.00 —

Over Present Active Power Demand Over kW Dmd, Pres 0.0 to 9999999.0 0 to 9999999 kW

Over Last Active Power Demand Over kW Dmd, Last 0.0 to 9999999.0 0 to 9999999 kW

Over Predicted Active Power Demand Over kW Dmd, Pred 0.0 to 9999999.0 0 to 9999999 kW

Over Present Reactive Power Demand Over kVAR Dmd,Pres 0.0 to 9999999.0 0 to 9999999 kVAR

Over Last Reactive Power Demand Over kVAR Dmd,Last 0.0 to 9999999.0 0 to 9999999 kVAR

Over Predicted Reactive Power Demand Over kVAR Dmd,Pred 0.0 to 9999999.0 0 to 9999999 kVAR

Over Present Apparent Power Demand Over kVA Dmd, Pres 0.0 to 9999999.0 0 to 9999999 kVA

Over Last Apparent Power Demand Over kVA Dmd, Last 0.0 to 9999999.0 0 to 9999999 kVA

Over Predicted Apparent Power Demand Over kVA Dmd, Pred 0.0 to 9999999.0 0 to 9999999 kVA

Over Frequency Over Frequency 0.000 to 99.000 Hz

Under Frequency Under Frequency 0.000 to 99.000 Hz

Over Voltage Unbalance Over Voltage Unbal 0.000 to 999999.000 0 to 9999999 V

Over Voltage THD Over Voltage THD 0.000 to 99 %

Phase Loss Phase Loss 0.00 too 999999.00 0 to 999999 —
1 Some alarms use the system type and the VT or CT ratio to determine the maximum allowed setpoint. See “Maximum allowable setpoint” on page 91.

Standard (1-Sec) alarms (Continued)

Alarm label Valid range and resolution1

Units
ION Setup Meter display ION Setup Meter display
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The meter records the date and time when the alarm event starts (EV1) and when it 
ends (EV2). The meter also performs any task assigned to the event, such as operating 
a digital output. The meter also records maximum values (Max1, Max2) before, during 
or after the alarm period.

Under setpoint

When the value falls below the pickup setpoint setting and remains there long enough 
to satisfy the pickup time delay period (∆T1), the alarm condition is set to ON. When the 
value rises above the dropout setpoint setting and remains there long enough to satisfy 
the dropout time delay period (∆T2), the alarm condition is set to OFF.

The meter records the date and time when the alarm event starts (EV1) and when it 
ends (EV2). The meter also performs any task assigned to the event, such as operating 
a digital output. The meter also records minimum values (Min1, Min2) before, during or 
after the alarm period.

A Pickup setpoint ∆T2 Dropout time delay (in seconds)

B Dropout setpoint EV2 End of alarm condition

∆T1 Pickup time delay period (in seconds) ∆T3 Alarm duration (in seconds)

EV1 Start of alarm condition Max1 Maximum value recorded during pickup period

Max2 Maximum value recorded during alarm period

A Pickup setpoint ∆T2 Dropout time delay (in seconds)

B Dropout setpoint EV2 End of alarm condition

∆T1 Pickup delay period (in seconds) ∆T3 Alarm duration (in seconds)

EV1 Start of alarm condition Min1 Minimum value recorded during pickup period

Min2 Minimum value recorded during alarm period

EV1 EV2

B

A
ΔT1

ΔT2

ΔT3

Max1

Max2

EV1 EV2

ΔT1

ΔT2

A

B

ΔT3

Min1

Min2
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Maximum allowable setpoint

The meter is programmed to help prevent user data entry errors. Limits have been set 
for the standard (1-Sec) alarms.

The maximum setpoint value you can enter for some of the standard alarms depend on 
the voltage transformer ratio (VT ratio), current transformer ratio (CT ratio), system type 
(i.e., number of phases) and/or the maximum voltage and maximum current limits 
programmed at the factory. 

NOTE: VT ratio is the VT primary divided by the VT secondary, and CT ratio is the CT 
primary divided by the CT secondary.

Power factor (PF)

You can set up a Leading PF or Lagging PF alarm to monitor when the circuit’s power 
factor goes above or below the threshold you specify. The Leading PF and Lagging PF 
alarms use the power factor quadrants as the values on the y-axis, with quadrant II on 
the lowest end of the scale, followed by quadrant III, quadrant I, and finally quadrant IV 
on the highest end of the scale.

Standard alarm maximum setpoint values

Standard alarm Maximum setpoint value

Over Phase Current (maximum current) x (CT ratio)

Under Phase Current (maximum current) x (CT ratio)

Over Neutral Current (maximum current) x (CT ratio) x (number of phases)

Over Ground Current (maximum current) x (CT ratio)

Over Voltage L-L (maximum voltage) x (VT ratio)

Under Voltage L-L (maximum voltage) x (VT ratio)

Over Voltage L-N (maximum voltage) x (VT ratio)

Under Voltage L-N (maximum voltage) x (VT ratio)

Over Active Power (maximum voltage) x (maximum current) x (number of phases)

Over Reactive Power (maximum voltage) x (maximum current) x (number of phases)

Over Apparent Power (maximum voltage) x (maximum current) x (number of phases)

Over Present Active Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Last Active Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Predicted Active Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Present Reactive Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Last Reactive Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Predicted Reactive Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Present Apparent Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Last Apparent Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Predicted Apparent Power Demand (maximum voltage) x (maximum current) x (number of phases)

Over Voltage Unbalance (maximum voltage) x (VT ratio)

Phase Loss (maximum voltage) x (VT ratio)

PF quadrants and related values 

Quadrant PF values Lead/Lag

II 0 to -1 Leading (capacitive)

III -1 to 0 Lagging (inductive)

I 0 to 1 Lagging (inductive)

IV 1 to 0 Leading (capacitive)
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Leading PF

The Leading PF alarm monitors an over setpoint condition. 

Lagging PF

The Lagging PF alarm monitors an under setpoint condition. 

Phase loss

The phase loss alarm is an under setpoint alarm. It monitors the voltages on a 3-phase 
system and triggers the alarm when one or two phases fall below the pickup setpoint 
setting and remains there long enough to satisfy the pickup time delay period. When all 
of the phases rises above the dropout setpoint setting and remains there long enough 
to satisfy the dropout time delay period, the alarm condition is set to OFF.

Logic alarms
The meter supports up to 10 logic alarms (Logic Alarm 1 to 10). A logic alarm is used to 
monitor up to four different inputs or parameters. The logic alarm is tripped when the 
individual states of all the inputs (A, B, C, D) cause the output (Y) of a logic operation to 
be true.

The logic alarm inputs can only be linked using software.

A Pickup setpoint ∆T2 Dropout time delay (in seconds)

B Dropout setpoint EV2 End of alarm condition

∆T1 Pickup delay period (in seconds) ∆T3 Alarm duration (in seconds)

EV1 Start of alarm condition

A Pickup setpoint ∆T2 Dropout time delay (in seconds)

B Dropout setpoint EV2 End of alarm condition

∆T1 Pickup delay period (in seconds) ∆T3 Alarm duration (in seconds)

EV1 Start of alarm condition

ΔT3
ΔT2

ΔT1

EV1 EV2

II

IV

I

III

0

-1

0

+1

0

II

IV ΔT3

ΔT2

ΔT1

EV1 EV2

I

III

0

-1

0

+1

0
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Custom alarms
Custom alarms (Cust1s) are setpoint-driven alarms, similar to the standard (1-Sec) 
alarms.

A custom alarm’s input parameters and setpoint subtypes can only be configured using 
software. The pickup setpoint and dropout setpoint limits are set to -999999 to 999999.

Custom alarms parameter list 

Alarm parameter Unit Alarm parameter Unit

Current A A Active Energy Delivered kW

Current B A Active Energy Received kW

Current C A Active Energy Delivered + Received kW

Current N A Active Energy Delivered - Received kW

Current G A Reactive Energy Delivered kVAR

Current Avg A Reactive Energy Received kVAR

Current Unbalance A % Reactive Energy Delivered + Received kVAR

Current Unbalance B % Reactive Energy Delivered - Received kVAR

Current Unbalance C % Apparent Energy Delivered kVA

Current Unbalance Worst % Apparent Energy Received kVA

Voltage A-B V Apparent Energy Delivered + Received kVA

Voltage B-C V Apparent Energy Delivered - Received kVA

Voltage C-A V Input Metering CH 01 Accumulation —

Voltage L-L Avg V Input Metering CH02 Accumulation —

Voltage A-N V Input Metering CH03 Accumulation —

Voltage B-N V Input Metering CH04 Accumulation —

Voltage C-N V Active Power Last Demand kW

Voltage L-N Avg V Active Power Present Demand kW

Voltage Unbalance A-B % Active Power Predicted Demand kW

Voltage Unbalance B-C % Reactive Power Last Demand kVAR

Voltage Unbalance C-A % Reactive Power Present Demand kVAR

Voltage Unbalance L-L \Worst % Reactive Power Predicted Demand kVAR

Voltage Unbalance A-N % Apparent Power Last Demand kVA

Voltage Unbalance B-N % Apparent Power Present Demand kVA

Voltage Unbalance C-N % Apparent Power Predicted Demand kVA

Voltage Unbalance L-N Worst % Current A Last Demand A

Active Power A kW Current A Present Demand A

Active Power B kW Current A Predicted Demand A

Active Power C kW THD Current A %

Active Power Total kW THD Current B %

Reactive Power A kVAR THD Current C %

Reactive Power B kVAR THD Current N %

Reactive Power C kVAR THD Current G %

Reactive Power Total kVAR thd Current A %

Apparent Power A kVA thd Current B %

Apparent Power B kVA thd Current C %

Apparent Power C kVA thd Current N %

Apparent Power Total kVA thd Current G %

Frequency Hz Min Freq Hz

Temperature °C Max Active Power A kW

Max Total Demand Distortion %

Max Freq %
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Alarms setup overview
You can use the meter display or ION Setup to configure unary, digital or standard 
(1-Sec) alarms. To configure logic and custom alarms, you must use ION Setup.

NOTE: If you make changes to the basic power meter setup, all alarms are disabled to 
prevent undesired alarm operation.

Built-in error-checking

ION Setup dynamically checks incorrect setup combinations. When you enable an 
alarm, you must set up the pickup and dropout limits to acceptable values first in order 
to exit the setup screen.

Alarm priorities
Each alarm has a priority level. Use priorities to distinguish between events that require 
immediate action and those that do not require action.

Active alarms

When a pickup event occurs, the active alarm list appears on the meter display’s Active 
Alarms screen. Press “Detail” to see more event information. See “Active alarms” on 
page 101 for more information.

Multiple alarm considerations

If multiple alarms with different priorities are active at the same time, the display shows 
the alarms in the order they occurred.

Related topics
• See “Monitoring” on page 56 to view the active alarms list using a web browser.

NOTICE
UNINTENDED EQUIPMENT OPERATION

After modifying any basic setup parameter:
• Verify all standard alarms settings are correct and make adjustments as necessary.
• Re-enable all configured alarms.

Failure to follow these instructions can result in incorrect alarm functions.

Alarm notification through the meter display

Alarm 
priority 

Alarm notification and recording method

Alarm LED1 Alarm icon Alarm details Alarm logging

High Blinks while the alarm is 
active.

Blinks while the alarm is active. Alarm 
icon remains displayed until 
acknowledged.

Click Details to display what caused the 
alarm to pickup or drop off. Click Ack to 
acknowledge the alarm.

Recorded in alarm log.

Medium Blinks while the alarm is 
active. Blinks while the alarm is active. Click Details to display what caused the 

alarm to pickup or drop off. Recorded in alarm log.

Low Blinks while the alarm is 
active. Blinks while the alarm is active. Click Details to display what caused the 

alarm to pickup or drop off.. Recorded in alarm log.

None No activity None None Recorded in event log only.
1 If the alarm / energy pulsing LED is configured for alarming.
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Alarm setup using the meter display
If your meter is equipped with a display:

1. Navigate to the alarms setup menu screens and select the alarm you want to set up. 
See “Front panel display and meter setup” on page 33 for basic instructions on 
using the front panel buttons to navigate the meter screens.

2. Configure the setup parameters as explained in the different alarm setup sections.

3. When prompted, click Yes to save the changes to the meter.

NOTE: You must use ION Setup to create logic and custom (Cust1s) alarms. After the 
alarm is created, you can use ION Setup or the meter display to modify the alarm 
parameters.

NOTE: If you used ION Setup to program decimal values on a standard (1-Sec) alarm, 
do not use the meter display to make subsequent changes to any alarm parameters 
(inculding enable/disable), as doing so will cause removal of all decimals previously 
programmed through ION Setup.

Alarm setup using ION Setup
To set up all alarm types using ION Setup, open the Alarming setup screen to view the 
different alarm types. See the ION Setup online help for details.

Setting up unary alarms
Select the unary alarm you want to configure then use the following controls to set up 
the alarm (ION Setup controls are shown in parentheses).

Setting up digital alarms
Select the digital alarm you want to configure then use the following controls to set up 
the alarm (ION Setup controls are shown in parentheses).

Maint Reset

Setup

1-Sec Unary Dig Logic Cust1s

Comm

Alarm

Meter

Unary alarm setup parameters 

Setting Option or range Description

Enable Yes (checked) or No 
(cleared) This enables or disables the alarm.

Priority High, Medium, Low, None This sets the alarm priority and notification options. 
See “Alarm priorities” on page 94.

Select Dig Output
(Outputs)

None, 
Digital Output D1,
Digital Output D2,
Digital Output D1 & D2

Select the digital output(s) you want to control when the 
alarm is triggered.

Digital alarm setup parameters 

Setting Option or range Description

Enable Yes (checked) or No 
(cleared) This enables or disables the alarm.

Priority High, Medium, Low, None This sets the alarm priority and notification options. 
See “Alarm priorities” on page 94.
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Setting up standard (1-sec) alarms
Select the standard (1-Sec) alarm you want to configure then use the following controls 
to set up the alarm (ION Setup controls are shown in parentheses).

NOTE: It is recommended that you use ION Setup to configure standard (1-Sec) 
alarms. ION Setup supports a higher resolution to allow you to specify more decimal 
places when setting up the pickup setpoint and dropout setpoint values for certain 
measurements.

Pickup Setpoint
(Setpoint Pickup) On, Off Use this setting to control when to trip the alarm, based 

on the state of the digital input (On or Off). 

Pickup Time Delay
(Delay) 0 to 999999

This specifies the number of seconds the digital input 
must be in the alarm pickup state before the alarm is 
tripped.

Dropout Time Delay
(Setpoint Dropout

Delay)
0 to 999999

This specifies the number of seconds the digital input 
must be out of the alarm pickup state before the alarm 
turns off.

Select Dig Output
(Outputs)

None, 
Digital Output D1,
Digital Output D2,
Digital Output D1 & D2

Select the digital output(s) you want to control when the 
alarm is triggered.

Digital alarm setup parameters (Continued)

Setting Option or range Description

NOTICE
UNINTENDED EQUIPMENT OPERATION

After configuring alarms in ION Setup:
• Do not use the meter display to make any changes to the alarms, otherwise all 

decimals previously programmed in ION Setup will be lost.

Failure to follow these instructions can result in incorrect alarm functions.

Standard (1-sec) alarm setup parameters 

Setting Option or range Description

Enable Yes (checked) or No 
(cleared) This enables or disables the alarm.

Priority High, Medium, Low, None This sets the alarm priority and notification options. 
See “Alarm priorities” on page 94.

Pickup Setpoint
(Pickup Limit)

See “Standard (1-Sec) 
alarms” on page 88

This is the value (magnitude) you define as the setpoint 
limit for triggering the alarm. For “over” conditions, this 
means the value has gone above the Pickup limit. For 
“under” conditions, this means the value has gone 
below the Pickup limit. 

Pickup Time Delay
(Delay) 0 to 999999

This specifies the number of seconds the signal must 
stay above the pickup setpoint (for “over” conditions), 
or below the pickup setpoint (for “under” conditions) 
before the alarm is tripped.

Dropout Setpoint
(Dropout Limit)

See “Standard (1-Sec) 
alarms” on page 88

This is the value (magnitude) you define as the limit for 
dropping out of the alarm condition. For “over” 
conditions, this means the value has gone below the 
Dropout limit. For “under” conditions, this means the 
value has gone above the Pickup limit.

Dropout Time Delay
(Delay) 0 to 999999

This specifies the number of seconds the signal must 
stay below the dropout setpoint (for “over” conditions), 
or above the dropout setpoint (for “under” conditions) 
before the alarm condition is ended.

PU Set Point Lead/Lag
(Lead, Lag) Lead or Lag

Applies to PF (power factor) alarms only. Use this set 
the PF value and quadrant to set the pickup setpoint for 
an over PF condition (PF Leading) or under PF 
condition (PF Lagging). See “Power factor (PF)” on 
page 91
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Setting up logic alarms
Use ION Setup to configure logic alarms.

NOTE: You must first configure the alarms you want to use as inputs to a logic alarm. 
For example, if you use a standard (1-Sec) alarm as one of the inputs, you must set up 
its setpoint pickup, dropout and delay parameters.

1. Select the logic alarm you want to set up, then click Edit.

2. Select the alarms you want to use as inputs to the logic alarm.

3. Click the double-arrow button to move the selected alarm to the Selected (max 4) 
box, then click OK.

4. Repeat to add more inputs to the logic alarm.

5. Configure the rest of the alarm setup parameters, click OK, then Send to save your 
changes to the meter.

DO Set Point Lead/Lag
(Lead, Lag) Lead or Lag

Applies to PF (power factor) alarms only. Use this set 
the PF value and quadrant to set the dropout setpoint 
for an over PF condition (PF Leading) or under PF 
condition (PF Lagging). See “Power factor (PF)” on 
page 91

Select Dig Output
(Outputs)

None, 
Digital Output D1,
Digital Output D2,
Digital Output D1 & D2

Select the digital output(s) you want to control when the 
alarm is triggered.

Standard (1-sec) alarm setup parameters (Continued)

Setting Option or range Description

Logic alarm setup parameters 

Setting Option or range Description

Edit —

See the preceding procedure. This button allows you to 
select up to 4 input parameters that you want to 
compare against each other. The logic alarm is set 
when the result of the specified logic operation on all 
inputs is true.

Enable Yes (checked) or No 
(cleared) This enables or disables the alarm.

Label Logic Alarm 1 to Logic 
Alarm 10 (default labels)

ION Setup lets you modify the default label so it more 
clearly identifies your logic alarm. You can only use 
letters, numbers and underscores. Spaces are not 
allowed.

Type

AND Output of AND operation is True only if all inputs are 
True.

NAND Output of NAND operation is True if one or more inputs 
are False.

OR Output of OR operation is True if one or more inputs 
are True.

NOR Output of NOR operation is True only if all inputs are 
False.

XOR Output of XOR operation is True if only one input is 
True, and all other inputs are False.

Priority High, Medium, Low, None This sets the alarm priority and notification options. 
See “Alarm priorities” on page 94.

Select Dig Output
(Outputs)

None, 
Digital Output D1,
Digital Output D2,
Digital Output D1 & D2

Select the digital output(s) you want to control when the 
alarm is triggered.
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Logic alarm setup error prompts

Both the meter and ION Setup have error-checking provisions, and alert you with an 
error message if the following actions are attempted:

• The output of a logic alarm is used as an input to itself.
• The same source is duplicated as another input on the same logic alarm.
• The source register used is invalid or is a nonexistent parameter.

Setting up custom alarms
Use ION Setup to configure custom (Cust1s) alarms.

1. Select the custom alarm you want to set up, then click Enable to display the 
available setup options.

2. Use the dropdown list to select the parameter you want to set for your custom 
alarm.

3. Use the Label box to define a name for your custom alarm.

4. Use the dropdown list to select the setpoint condition you want to monitor:

— Over: Alarm condition occurs when the value goes above the pickup setpoint 
setting.

— Under: Alarm condition occurs when the value goes below the pickup setpoint 
setting.

— Over (absolute): Alarm condition occurs when the absolute value goes above 
the pickup setpoint setting.

— Under (absolute): Alarm condition occurs when the absolute value goes below 
the pickup setpoint setting.

5. Configure the rest of the alarm setup parameters, click OK, then Send to save your 
changes to the meter.

Custom alarm setup parameters 

Setting Option or range Description

Enable Yes (checked) or No 
(cleared) This enables or disables the alarm.

Setpoint Pickup See “Standard (1-Sec) 
alarms” on page 88

This is the value (magnitude) you define as the setpoint 
limit for triggering the alarm. For “over” conditions, this 
means the value has gone above the Pickup limit. For 
“under” conditions, this means the value has gone 
below the Pickup limit. 

Delay
(Setpoint Pickup) 0 to 999999

This specifies the number of seconds the signal must 
stay above the pickup setpoint (for “over” conditions), 
or below the pickup setpoint (for “under” conditions) 
before the alarm is tripped.

Setpoint Dropout See “Standard (1-Sec) 
alarms” on page 88

This is the value (magnitude) you define as the limit for 
dropping out of the alarm condition. For “over” 
conditions, this means the value has gone below the 
Dropout limit. For “under” conditions, this means the 
value has gone above the Pickup limit.

Delay
(Setpoint Dropout) 0 to 999999

This specifies the number of seconds the signal must 
stay below the dropout setpoint (for “over” conditions), 
or above the dropout setpoint (for “under” conditions) 
before the alarm condition is ended.

Priority High, Medium, Low, None This sets the alarm priority and notification options. 
See “Alarm priorities” on page 94.

Select Dig Output
(Outputs)

None, 
Digital Output D1,
Digital Output D2,
Digital Output D1 & D2

Select the digital output(s) you want to control when the 
alarm is triggered.
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LED alarm indicator
You can use the meter’s alarm / energy pulsing LED as an alarm indicator.

When set to detect alarms, the LED blinks to indicate an alarm condition. See “Alarm 
priorities” on page 94 for a description of the LED behavior based on different alarms.

NOTE: The alarm / energy pulsing LED on the PM5561 is permanently set for energy 
pulsing and cannot be used for alarms.

Configuring the LED for alarms using the meter display

You can use the meter display to configure the alarm /energy pulsing LED for alarming.

1. Navigate to the LED setup menu screen.

2. Set the mode to Alarm, then press OK.

3. Press  to exit. Press Yes to save your changes.

Location of alarm / energy pulsing LED 

PM5560 / PM5561 PM5563 A Alarm / energy pulsing LED

Alarm / energy pulsing LED setup parameters 

Setting Option or range Description

Mode Disabled, Alarm, Energy
Disabled turns off the LED completely.
Alarm sets the LED for alarm notification.
Energy sets the LED for energy pulsing.

Parameter

Active Del,
Active Rec,
Active Del + Rec,
Reactive Del,
Reactive Del + Rec,
Apparent Del,
Apparent Rec,
Apparent Del + Rec

Select which accumulated energy channel to monitor and 
use for energy pulsing. This setting is ignored when the 
LED mode is set to Alarm.

Pulse Wt. (p/k_h) 1 to 9999999

When configured for energy pulsing, this setting defines 
how many pulses are sent to the LED for every 1 kWh, 
1 kVARh or 1kVAh accumulated energy. This setting is 
ignored when the LED mode is set to Alarm.

Maint Reset

Setup

LED D In D Out Inp Mtr

Comm

Alarm

I/O

Meter
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Configuring the LED for alarms using ION Setup

You can use the ION Setup to configure your meter’s LED for alarming.

1. Start ION Setup.

2. Connect to your meter

3. Navigate to I/O configuration > Energy Pulsing.

4. Select Front Panel LED and click Edit. 

5. Set the control mode to Alarm.

6. Click Send to save your changes.

Using alarms for external control

You can set the alarm to trigger a digital output, which you can then use to control an 
external relay. See “Digital output applications” on page 77 for details.

Alarm screens
If your meter is equipped with a display, use the front panel buttons to navigate to the 
alarm setup or display screens.

Alarm display and notification
The meter notifies you when an alarm condition is detected. “Alarm priorities” on 
page 94 outlines the differences in alarm notification based on alarm priorities.

Alarm icon

When a low, medium or high priority alarm is tripped, this symbol appears at the top 
right corner of the display screen, indicating that an alarm is active:

 

For high priority alarms, the alarm icon remains displayed until you acknowledge the 
alarm.

Alarm / energy LED

If configured for alarming, the alarm / energy pulsing LED also flashes to indicate the 
meter has detected an alarm condition. See “LED alarm indicator” on page 99.

Alarm details
Details about the alarms can be viewed from the active alarms (Active), alarm history 
(Hist), alarm counters (Count) and unacknowledged alarms (Unack) screens.

Alarm setup Alarm display

Maint Reset

Setup

Comm

Alarm

Meter

Alarm

Hist

Active

Count

Unack
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Active alarms

When an alarm condition becomes true (alarm = ON), the alarm is displayed on the 
active alarms screen. The alarm details (for low, medium and high priority alarms) are 
also recorded in the alarm history log.

Viewing active alarm details

1. Navigate to Alarm > Active.

2. Select the alarm you want to view (the latest ones appear on top). Press Detail.

NOTE: For unacknowledged high priority alarms, the Ack option appears on this 
screen. Press Ack to acknowledge the alarm, or return to the previous screen if you 
do not want to acknowledge the alarm.

The alarm details show the date and time of the alarm event, the type of event (e.g., 
pickup or unary), which phase the alarm condition was detected on, and the value that 
caused the alarm condition.

NOTE: Alarm details are not available if the alarm priority is set to None.

Alarm history

The alarm history log keeps a record of active alarms and past alarms. When an active 
alarm condition becomes false (alarm = OFF), the event is recorded in the alarm history 
log and alarm notification (alarm icon, alarm LED) is turned off.

Viewing alarm history details

1. Navigate to Alarm > Hist.

2. Select the alarm you want to view (the latest ones appear on top). Press Detail.

NOTE: For unacknowledged high priority alarms, the Ack option appears on this 
screen. Press Ack to acknowledge the alarm, or return to the previous screen if you 
do not want to acknowledge the alarm.

The alarm details show the date and time of the alarm event, the type of event (e.g., 
dropout or unary), which phase the alarm condition was detected on, and the value that 
caused the alarm condition to turn ON or OFF.

NOTE: Alarm details are not available if the alarm priority is set to None.

Alarm counter

Every occurrence of each type of alarm is counted and recorded in the meter. To view 
the alarm counters:

1. Select Alarm > Count. The Alarms Counter screen displays.

2. Scroll through the list to view the number of alarm occurrences for each type of 
alarm.

Rollover value

The alarm counters roll over to zero after reaching the value 9999.

Acknowledging alarms

This applies to high priority alarms. You can use the meter display or software to 
acknowledge alarms.
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To acknowledge alarms using the meter display:

1. Navigate to Alarm > Unack.

2. Select the alarm you want to acknowledge. Press Detail.

3. Press Ack to acknowledge the alarm.

4. Repeat for other unacknowledged alarms.

Active alarms list and alarm history log
Each occurrence of a low, medium or high priority alarm is stored in the active alarms 
list and recorded in the alarm history log. Alarms are displayed sequentially in the order 
of their occurrence, regardless of priority.

Alarm memory usage

There are two types of alarm entries: primary and secondary. The primary entry 
identifies the alarm. The secondary entry provides pickup and dropout information.

The active alarm list holds 40 entries at a time. The list works as a circular buffer, 
replacing old entries as new entries over 40 are entered into the active alarms list. The 
information in the active alarms list is volatile and reinitializes when the meter resets.

The alarm history log holds 40 entries. The log also works as a circular buffer, replacing 
old entries with new entries. The information in the alarm history log is nonvolatile and 
is retained when the meter resets.

Resetting alarms

To reset the alarms using the meter display, see the alarm parameters under “Single 
resets” on page 84.

To reset the alarms using ION Setup, open the Meter Resets screen and select the 
alarm parameters to clear.

Related topics
• See “Monitoring” on page 58 to view active alarms and alarm history using the 

meter webpages.
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Chapter 11 Multi-tariff feature

This section describes how to set up different tariffs for storing energy values in 
registers that correspond to each of those tariffs. An example of when this feature can 
be used is when a utility has set up tariff schedules with different rates based on what 
day or time of day energy is consumed.

The meter supports configuration of up to 8 different tariffs.

Multi-tariff feature example

In the above illustration, the area under the power curve equals the energy consumed.

Typically, the utility sets tariff schedules so the cost of energy is higher during high 
demand or high energy consumption times. How these “tariff energy containers” are 
configured determines how fast these containers fill, which correlates to increasing 
energy costs. The price per kWh is lowest at tariff T1 and highest at tariff T2.

Multi-tariff feature overview
The meter supports multiple tariffs to measure and monitor energy usage that can be 
used in billing or cost applications. There are different tariff modes you can use to 
determine what tariff is applied and when: Command mode, Time of Day mode, and 
Input mode.

Power

Time

Cost

T1 T2 T3 T4

T1 T2 T3 T4 Tariff energy 
containers
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Command mode overview

You can use this mode to send a Modbus command to the device which sets the active 
tariff. This tariff is applied to the measured energy until you send another Modbus 
command that sets a different tariff.

Related topics
• Search your meter’s Modbus register list at www.schneider-electric.com to 

download the Modbus map.

Time of day mode overview

You can use this mode to create a tariff schedule that specifies where the meter stores 
energy or input metered data, based on the time of year (month, day), the type of day 
(every day, weekend, weekday or a specific day of the week), or time of day. The data 
collected from the different tariffs can then be used in energy audits or similar costing 
and budget planning purposes.

Tariff validity

A valid tariff has certain conditions and limitations:

• Each tariff must cover a unique time period (tariffs cannot overlap) but there can be 
periods with no tariff.

• Any number of tariffs, from none to the maximum number of tariffs, can be applied.
• Time of day tariffs do not adjust for daylight savings time. 
• Time of day tariffs include February 29th in leap years (however, it is not 

recommended to have February 29th as a start or end date, as that tariff would be 
invalid for non-leap years.

• Except for leap years, tariff dates are not year-specific; if you wanted to create a 
tariff that starts on the first Monday in August, you need to enter the date for that 
year, then manually update the tariff information for the subsequent years.

• DST (daylight savings time) is not supported by the meter.

Tariff creation method

Your device performs validation checks as you enter tariff information; it prompts you to 
change the information that you have entered or set the tariff to disabled if the tariff 
configuration is invalid. These checks can include:

• Start and end times must be different (for example, you cannot create a tariff that 
starts at 02:00 and also ends at 02:00).

• Start time can only be earlier than end time for tariffs that are applied every day. 
You can create a daily tariff that starts at 06:00 and ends at 02:00, but these times 
are only valid for the Everyday tariff and invalid for the other tariff types.

• Start day must be earlier than end day if the days are in the same month. You 
cannot create a tariff that starts June 15 and ends June 12.

There are two methods of creating tariffs:

• Time of year tariffs divide the year into multiple sections (usually seasons), where 
each section has one or more day types. For example, an eight tariff configuration 
using this method could have Spring, Summer, Fall and Winter seasons that also 
use different weekend and weekday tariffs. 

• Daily tariffs can divide days by day of the week, a weekday, a weekend, or every 
day, and can specify the time of day. For example, an eight tariff configuration could 
have every day in the year divided into three-hour tariff periods or could have four 
tariffs for weekends and four tariffs for weekdays. 
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You can combine these methods if, for example you wanted to create a tariff that 
applies on Mondays from January 1 to June 30, from 09:00 to 17:00. However, since 
only one tariff can be applied at any time, you cannot use an everyday or weekday tariff 
type because you already specified a tariff for the time periods 09:00 to 17:00.

Depending on how you configure the tariffs and the maximum number of tariffs 
supported by your meter, you may not be able to assign tariffs for the entire year, 
potentially leaving time gaps that do not have any tariff assigned to them.

Input mode overview

You can use this mode to have the device’s digital inputs set which tariff is applied to 
the energy that is presently being consumed. If a digital input is used for multi-tariff, it 
cannot be used for an exclusive association (such as Demand Sync or Input Metering), 
but digital inputs can be shared with a non-exclusive association (such as Alarms). To 
make a digital input available for setting tariffs, any conflicting associations must be 
manually removed at the source of the original association.

The number of different tariffs that can be applied is determined by the number of 
available digital inputs and the total number of tariffs supported by your device. The 
digital inputs are used as binary counters to identify the appropriate tariff, where off = 0 
and on = 1, and most significant bit (MSB) is digital input 4 and least significant bit 
(LSB) is digital input 1. By this definition, digital input 1 must be associated with the 
multi-tariff feature in order to set the tariff to Input mode.

Digital input requirements for required number of tariffs 

Number of 
tariffs required

Digital inputs required

Configuration 1 Configuration 2

1 1 (digital input 1) 1 (digital input 1)

2 1 (digital input 1) 2 (digital input 1 and 2)

3 2 (digital input 1 and 2) 2 (digital input 1 and 2)

4 2 (digital input 1 and 2) 3 (digital input 1, 2 and 3)

5 3 (digital input 1, 2 and 3) 3 (digital input 1, 2 and 3)

6 3 (digital input 1, 2 and 3) 3 (digital input 1, 2 and 3)

7 3 (digital input 1, 2 and 3) 3 (digital input 1, 2 and 3)

8 3 (digital input 1, 2 and 3) 4 (digital input 1, 2, 3 and 4)

Configuration 1: 8 tariff assignment using 3 digital inputs1 

1 There is no inactive tariff with this configuration.

Tariff Digital input 4 Digital input 3 Digital input 2 Digital input 1

T1 N/A 0 0 0

T2 N/A 0 0 1

T3 N/A 0 1 0

T4 N/A 0 1 1

T5 N/A 1 0 0

T6 N/A 1 0 1

T7 N/A 1 1 0

T8 N/A 1 1 1

Configuration 2: 8 tariff assignment using 4 digital inputs 

Tariff Digital input 4 Digital input 3 Digital input 2 Digital input 1

None1 0 0 0 0

T1 0 0 0 1

T2 0 0 1 0

T3 0 0 1 1

T4 0 1 0 0
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Configuring tariffs
This section explains how to set up tariffs.

You can change the tariff mode using the front panel.

When the meter is set to command mode for tariffs, the active tariff is controlled by 
Modbus commands sent from your energy management system or other Modbus 
master.

Related topics
• Search your meter’s Modbus register list at www.schneider-electric.com to 

download the Modbus map.

Configuring time of day mode tariffs

When the meter is set to time of day for tariffs, the active tariff is determined by the day 
type, the start and end times, and the start and end dates. The time of day tariff is not a 
calendar; the meter does not calculate the corresponding day of the week to a specific 
date, but February 29th is considered a valid date if you are programming the meter 
during a leap year.

When you enter tariff times using the front panel, be aware that the displayed minute 
value includes the entire minute. For example, an end time of 01:15 includes the time 
from 01:15:00 through 01:15:59. To create a tariff period that starts right after this, you 
must set the next tariff’s start time to 01:16. Although it may appear that there is a gap 
between these tariffs, there is not.

NOTE: You must always set the tariff times to UTC (GMT, Greenwich Mean Time), not 
local time. The GMT Offset (h) setup parameter does not apply to tariff times.

Use ION Setup to configure time of day mode tariffs.

Related topics
• See “Meter configuration using ION Setup” on page 51 to configure the tariffs and 

other parameters using ION Setup.

Configuring input mode tariffs using the front panel

When you set the tariff type to Input, the active tariff is determined by the status of the 
digital inputs.

T5 0 1 0 1

T6 0 1 1 0

T7 0 1 1 1

T82 1 0 0 0
1 This digital input configuration (0000) means there are no active tariffs (all tariffs are disabled)
2 Any configuration above 8, i.e., 1001 and higher, is invalid and therefore ignored by the meter (the active tariff 

does not change).

Configuration 2: 8 tariff assignment using 4 digital inputs (Continued)

Tariff setup menu tree

Maint Reset

Setup Basic Adv Dmd TariffMeter



PowerLogic™ PM5500 series user manual Chapter 11—Multi-tariff feature

HRB1684301-01 107

Digital inputs are available for tariffs if they are not used, or if they are only associated 
with alarms (Normal). To make a digital input available, you must manually disconnect 
the conflicting association before configuring tariffs.

You cannot configure any digital input tariff if digital input 1 is not available for 
association. Likewise, digital input 2 must be available to select more than two tariffs. 
The status of the digital inputs is used to calculate the binary value of the active tariff, 
where off = 0 and on = 1. The calculation of the number of tariffs value can differ, 
depending on the number of digital inputs that can be selected (i.e., inputs that can be 
associated with multi-tariff).

To configure input mode tariffs using the front panel:

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.

3. Navigate to Meter > Tariff.

4. With the cursor pointing to Mode, press Edit.

5. Press  or  to change the setting to Input, then press OK.

NOTE: If a digital input association error prompt displays, you must exit from the tariff 
setup screens and remove the digital input association.

6. Navigate to Tariffs, then press Edit.

7. Press  or  to change the number of tariffs you want to set up. The maximum 
number of tariffs that you can apply is determined by the number of available digital 
inputs, as described in the table, “Digital input requirements for required number of 
tariffs” on page 105. Press OK.

8. Navigate to Inputs, then press Edit.

9. If applicable, press  or  to change how many digital inputs you want to use to 
control which tariff is selected (active). Press OK.

10. Press  to exit, then Yes to save your changes.

Related topics
• To configure the tariffs using ION Setup, see the “PM5500 series” topic in the 

ION Setup online help or in the ION Setup device configuration guide, available for 
download at www.schneider-electric.com.
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Chapter 12 Measurements and calculations

This section describes how the power meter processes measured and calculated data.

Real-time readings
The power meter measures currents and voltages, and reports in real time the RMS 
(Root Mean Squared) values for all three phases and neutral. The voltage and current 
inputs are continuously monitored at a sampling rate of 128 points per cycle. This 
amount of resolution helps enable the meter to provide reliable measurements and 
calculated electrical values for various commercial, buildings and industrial 
applications.

Related topics
• See “Introduction” on page 11 to learn about the meter’s capabilities.
• See “Viewing meter data” on page 61 to learn how to navigate the data screens 

using the front panel.
• See “Using software to view meter data” on page 67 for information on energy 

management software systems.

Energy
The power meter calculates and stores accumulated energy values for real, reactive, 
and apparent energy. 

You can view accumulated energy from the display. The energy value units 
automatically change, based on the quantity of energy accumulated (e.g., from kWh to 
MWh, then from MWh to TWh).

Related topics
• See “Energy” on page 12 for a list of energy readings.
• See “Energy” on page 65 to view energy readings using the meter display.
• See “Using software to view meter data” on page 69 for information on energy 

management software systems.

Min/max values
The meter’s real-time readings are updated once every 50 cycles for 50 Hz systems, or 
once every 60 cycles for 60 Hz systems. When the readings reach their lowest or 
highest value, the meter updates and saves these min/max (minimum and maximum) 
quantities in non-volatile memory.

Power factor
Power factor (PF) is the ratio of real power (P) to apparent power (S), and is a number 
between zero (0) and one (1). In a purely resistive circuit, PF is equal to 1 (unity PF). 
Inductive or capacitive loads increase the reactive power (Q) component in the circuit 
which causes the PF to become less than 1.

Power factor can have a positive or negative sign, depending on the type of load or 
direction of power flow. See “Power factor sign convention” on page 110.
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Power factor min/max convention

The meter uses the following convention for power factor minimums and maximums:

• For negative PF readings, the minimum PF value is the measurement closest to -0 
for PF readings between -0 to -1. For positive PF readings, the minimum PF value is 
the measurement closest to +1 for PF readings between +1 to +0.

• For negative PF readings, the maximum PF value is the measurement closest to -1 
for PF readings between -0 to -1. For positive PF readings, the maximum PF value 
is the measurement closest to +0 for PF readings between +1 to +0. 

Power factor sign convention

You can set the power factor sign (PF sign) convention by changing the HMI mode to 
either IEC or IEEE.

IEC mode

In IEC mode, the PF sign follows the direction of power flow. PF sign is positive (+) for 
positive (normal) power flow. PF sign is negative (-) for negative (reverse) power flow.

Power factor minimum and maximum

1.0

-0.4 .4

.6

.8

-0.6

-0.8

+0

.2

-0

-0.2

-1.0

Maximum PF [ + ]

Negative PF values
[ - ]

Minimum PF [ - ]

Positive PF values
[ + ]

Power factor sign convention

Real
Power
In

watts negative (–)
vars positive (+)
power factor (–)

watts positive (+)
vars positive (+)
power factor (+)

watts negative (–)
vars negative (–)
power factor (–)

watts positive (+)
vars negative (–)
power factor (+)

Reverse 
Power Flow

Normal
Power Flow

Reactive
Power In

Quadrant
2

Quadrant
1

Quadrant
3

Quadrant
4

IEC mode

Real
Power
In

watts negative (–)
vars positive (+)
power factor (+)

watts positive (+)
vars positive (+)
power factor (–)

watts negative (–)
vars negative (–)
power factor (–)

watts positive (+)
vars negative (–)
power factor (+)

Reverse 
Power Flow

Normal
Power Flow

Reactive
Power In

Quadrant
2

Quadrant
1

Quadrant
3

Quadrant
4

IEEE mode
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IEEE mode

In IEEE mode, the PF sign is determined by the type of load (inductive or capacitive) 
contributing to the reactive power component of apparent power. PF sign is positive (+) 
for capacitive loads (leading power factor). PF sign is negative (-) for inductive loads 
(lagging power factor).

Related topics
• See “Setting up regional settings” on page 44 to change the HMI mode.
• See “Power, energy and power factor” on page 139 to learn how the meter 

calculates power factor.

Power demand
Power demand is a measure of average power consumption over a fixed time interval. 

NOTE: If not specified, references to “demand” is assumed to mean “power demand”.

The meter measures instantaneous consumption and can calculate demand using 
various methods.

Related topics
• See “Demand setup” on page 40 to set up demand using the front panel.

Power demand calculation methods
Power demand is calculated by dividing the energy accumulated during a specified 
period by the length of that period. How the power meter performs this calculation 
depends on the method and time parameters you select (for example, timed rolling 
block demand with a 15-minute interval and 5-minute subinterval).

To be compatible with electric utility billing practices, the power meter provides the 
following types of power demand calculations:

• Block interval demand
• Synchronized demand
• Thermal demand

You can configure the power demand calculation method from the front panel or using 
ION Setup.

Block interval demand
For block interval demand method types, you specify a period of time interval (or block) 
that the power meter uses for the demand calculation. Select/configure how the power 
meter handles that interval from one of these different methods:

• Timed Sliding Block: Select an interval from 1 to 60 minutes (in 1-minute 
increments). If the interval is between 1 and 15 minutes, the demand calculation 
updates every 15 seconds. If the interval is between 16 and 60 minutes, the 
demand calculation updates every 60 seconds. The power meter displays the 
demand value for the last completed interval.

• Timed Block: Select an interval from 1 to 60 minutes (in 1-minute increments). The 
power meter calculates and updates the demand at the end of each interval.

• Timed Rolling Block: Select an interval and a subinterval. The subinterval must 
divide evenly into the interval (for example, three 5-minute subintervals for a 
15-minute interval). Demand is updated at the end of each subinterval. The power 
meter displays the demand value for the last completed interval.
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The following illustration shows the different ways power demand is calculated using 
the block interval method. In this example, the interval is set to 15 minutes.

Synchronized demand
You can configure the demand calculations to be synchronized using an external pulse 
input, a command sent over communications, or the device’s internal real-time clock. 

• Input synchronized demand: This method allows you to synchronize the demand 
interval of your meter with an external digital pulse source (such as another power 
meter’s digital output) connected to your meter's digital input. This helps 
synchronize your meter to the same time interval as the other meter for each 
demand calculation. When setting up this type of demand, you can choose Input 
Sync Block (input-synchronized block demand) or Input Sync Roll Blk (input-
synchronized rolling block demand). Input Sync Roll Blk requires that you specify 
a subinterval.

• Command synchronized demand: This method allows you to synchronize the 
demand intervals of multiple meters on a communications network. For example, if 
a programmable logic controller (PLC) input is monitoring a pulse at the end of a 
demand interval on a utility revenue meter, you can program the PLC to issue a 
command to multiple meters whenever the utility meter starts a new demand 
interval. Each time the command is issued, the demand readings of each meter are 
calculated for the same interval. When setting up this type of demand, you can 

Block interval demand example

15 30 45

15 30 45

60 . . .

15 30 4520 35 4025

Demand value is the 
average for the last 
completed interval

Demand value is 
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the last 
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Demand value is 
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the last 
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interval
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(sec)

Time
(min)

Time
(min)

Calculation updates 
every 15 seconds

Calculation updates at 
the end of the interval

Calculation updates at the end of 
the subinterval (5 minutes)

Timed Sliding Block

Timed Block

Timed Rolling Block

15-minute interval

15-minute interval

15-minute interval 15-min

15-minute interval
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choose Cmd Sync Block (command-synchronized block demand) or Cmd Sync 
Roll Block (command-synchronized rolling block demand). Cmd Sync Roll Blk 
requires that you specify a subinterval.

• Clock synchronized demand: This method allows you to synchronize the demand 
interval to the power meter’s internal real-time clock. This helps you synchronize the 
demand to a particular time, typically on the hour (for example, at 12:00 am). If you 
select another time of day when the demand intervals are to be synchronized, the 
time must be specified in minutes from midnight. For example, to synchronize at 
8:00 am, select 480 minutes. When setting up this type of demand, you can choose 
Clock Sync Block (clock-synchronized block demand) or Clock Sync Roll Blk 
(clock-synchronized rolling block demand). Clock Sync Roll Blk requires that you 
specify a subinterval. 

Thermal demand
Thermal demand calculates the demand based on a thermal response, which imitates 
the function of thermal demand meters. The demand calculation updates at the end of 
each interval. You can set the demand interval from 1 to 60 minutes (in 1-minute 
increments).

The following illustration shows the thermal demand calculation. In this example, the 
interval is set to 15 minutes.

Current demand
The power meter calculates current demand using one of the methods described in 
“Power demand calculation methods” on page 111. You can set the demand interval 
from 1 to 60 minutes in 1-minute increments (for example, 15 minutes).

Predicted demand
The power meter calculates predicted demand for the end of the present interval for 
kW, kVAR, and kVA demand. This prediction takes into account the energy 
consumption so far within the present (partial) interval and the present rate of 
consumption.

Predicted demand is updated every second.

The following illustration shows how a change in load can affect predicted demand for 
the interval. In this example, the interval is set to 15 minutes.

Thermal demand example

The interval is a window of time that moves across the timeline
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Peak demand
The maximum values for the kWD, kVARD, and kVAD power (or peak demand) is 
maintained in the meter’s non-volatile memory. The peak for each value is the highest 
average reading since the meter was last reset. The power meter also stores the date 
and time when the peak demand occurred. In addition to the peak demand, the power 
meter also stores the coinciding average 3-phase power factor. The average 3-phase 
power factor is defined as “demand kW/demand kVA” for the peak demand interval.

Related topics
• See “Demand” on page 12 for a list of available peak demand readings.
• See “Single resets” on page 86 to reset peak demand values using the meter 

display.

Input metering demand
The power meter supports up to 4 input metering channels, one for each digital input. 
The input metering channels can be used to measure water, air, gas, electric and 
steam utilities (WAGES).

Typical WAGES utility meters have no communications capabilities, but they usually 
have a pulse output. The utility meter sends a pulse to its output each time a preset 
quantity or amount of (WAGES) energy is consumed or delivered. This preset quantity 
or amount is referred to as the pulse weight.

To monitor the utility meter, connect its pulse output to the power meter’s digital input. 
Use ION Setup to associate the digital input for input metering and configure the input 
metering operation mode, pulse weight, consumption units and demand units.

Related topics
• See “Digital input setup” on page 72 for details on configuring the digital inputs.
• See “Input metering setup” on page 75 for details on configuring input metering.

Timer
The meter supports an active load timer and an operating timer. Use the meter display 
to navigate to the Timer screens.

Operating timer

The operating timer (Timer > Oper) keeps track of how long the meter has been 
powered up.

Predicted demand example

1:00 1:06 1:15

15-minute interval

Predicted demand if load is 
added during interval; 
predicted demand increases 
to reflect increased demand

Predicted demand if no load 
is added.

Time

Change in Load

Demand 
for last 
completed 
interval

Beginning 
of interval

Partial Interval 
Demand
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Load timer

The load timer keeps track of how much time the input current exceeds the specified 
load timer setpoint current.

Related topics
• See “Configuring advanced setup parameters” on page 39 to set up the minimum 

current for the load timer setpoint.
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Chapter 13 Power quality

This section describes the meter’s power quality features and how to access power 
quality data.

The meter measures voltage and current harmonics up to the 63rd harmonic, and 
calculates Total Harmonic Distortion (THD) and Total Demand Distortion (TDD and 
tdd).

Harmonics overview
Harmonics are integer multiples of the fundamental frequency of the power system. 
Harmonics information is valuable for power quality analysis, determining properly 
rated transformers, maintenance and troubleshooting. 

Harmonics measurements include per-phase magnitudes and angles for the 
fundamental and higher harmonics relative to the fundamental frequency. The meter’s 
power system setting defines which phases are present and determines how line-to-line 
or line-to-neutral voltage harmonics and current harmonics are calculated. 

Harmonics data provide information to determine how non-linear loads affect the power 
system. For example, power system harmonics can cause current flow on the neutral 
conductor, increase heating in electric motors, and eventually damage connected 
equipment. Power conditioners or harmonic filters can be used to minimize unwanted 
harmonics.

Crest factor and K-factor

Crest factor is the ratio of peak to RMS voltage values. For a pure sinusoidal waveform, 
crest factor is equal to 1.414. The meter uses the following equation to calculate crest 
factor:

K-factor relates the heating effect of a distorted current in a transformer to a sinusoidal 
current with the same RMS magnitude — it describes a transformer’s ability to serve 
non-linear loads without exceeding rated temperature rise limits. The K-factor is equal 
to the sum of the squares of the harmonic currents multiplied by the squares of the 
harmonic order. The meter uses the following equation to calculate K-factor:

Where h is the harmonic order and Ih is the true RMS current of harmonic order h.

Total Harmonic Distortion and Total Demand Distortion

Total Harmonic Distortion (THD) is a measure of the total per-phase voltage or current 
harmonic distortion present in the power system. It provides a general indication of the 
quality of a waveform. THD is calculated for each phase of both voltage and current.

Total Demand Distortion (TDD) is the per-phase harmonic current distortion against the 
full load demand of the electrical system. TDD indicates the impact of harmonic 
distortion in the system. For example, if your system is showing high THD values but a 

Crest factor
Vpeak

VRMS
---------------=

K-factor Ih2 h2 
h 1=



=
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low demand, the impact of harmonic distortion on your system might be insignificant. 
However at full load, the THD value for the current harmonics is equal to TDD, so this 
could negatively impact your system.

The meter uses the following series of equations to calculate THD and TDD.

Harmonic content calculations

1. Calculate harmonic content (HC).

HC (harmonic content) is equal to the RMS value of all the non-fundamental harmonic 
components in one phase of the power system.

2. Calculate the harmonic content for current (HCI).

HCI (harmonic content current) is equal to the RMS value of all the non-fundamental 
current harmonic components (HI2…HIn) in one phase of the power system.

THD and thd calculations

The meter supports two methods of calculating total harmonic distortion: THD and thd.

THD is a quick measure of the total distortion present in a waveform and is the ratio of 
harmonic content to the fundamental. The meter uses the following equation to 
calculate THD:

Where H1 is equal to the fundamental harmonic.

thd is an alternate method for calculating total harmonic distortion. It uses the RMS 
value for the total harmonic content rather than the fundamental content. The meter 
uses the following equation to calculate thd:

TDD calculation

TDD (total demand distortion) evaluates the harmonic currents between an end user 
and a power source. The harmonic values are based on a point of common coupling 
(PCC), which is a common point where each user receives power from the power 
source. The meter uses the following equation to calculate TDD:

Where ILoad is equal to the maximum demand load on the power system.

HC H2 2 H3 2 H4 2+ +=

HCI HI2 2 HI3 2 HI4 2+ +=

THD HC
H1
-------- 100=

thd HC
H1 2 HC 2+

----------------------------------------- 100=

TDD HCIA 2 HCIB 2 HCIC 2+ +  ILoad  100=
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Displaying harmonics data
For meters equipped with a front panel display, the following harmonics data is 
available:

• Numeric magnitude and angle of the fundamental (first) harmonic.
• Graphical display of the 3rd to 31st harmonics, expressed as a percentage of the 

fundamental harmonic.

Viewing harmonics using the front panel

You can view harmonics data using the front panel.

1. Navigate to Harm. The Harmonics % screen displays, with the following menu 
options:

2. Press the voltage or current harmonics you want to view. The fundamental (1st) 
harmonic’s numeric magnitudes and angles for all phases are displayed.

3. Press 3-11, 13-21, or 23-31 to view the graphs for the 3rd to 11th, 13th to 21st, or 
23rd to 31st harmonics, respectively. For example, to display the 13th to 21st 
harmonics screen, press 13-21.

The vertical axis of the harmonics graph indicates the harmonic’s magnitude as a 
percentage of the fundamental harmonic, and is scaled based on the largest 
harmonic displayed. At the top of each vertical bar is a marker that shows the 
maximum value of the harmonic. If the harmonic is greater than the fundamental 
harmonic, this marker is triangular-shaped to show that the value is out of range.

NOTE: The display screen only shows odd harmonics up to the 31st harmonic. 
However, all individual odd and even harmonics data up to the 63rd harmonic is 
available through communications and software. Individual harmonics data include 
current harmonics per phase, neutral and ground, and voltage harmonics line-to-
line, line-to-neutral and neutral to ground.

Viewing TDD, K-factor and Crest factor data

1. Navigate to Harm > TDD/K. The TDD and K-factor per phase information displays.

Harmonics % display screens 

IEEE mode IEC mode Description

V L-L U Line-to-line voltage harmonics data

V L-N V Line-to-neutral voltage harmonics data

Amps I Current harmonics data

TDD/K TDD/K Total demand distortion and K-factor data

Crest Crest Crest factor data

Example: 13th to 21st harmonics for line-to-neutral voltage

Phase A

Phase B

Phase C

Power Quality display screens 

IEEE mode IEC mode Description

TDD TDD Total demand distortion

K-F A K-F A K factor for phase A
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2. Navigate to Harm > Crest. The Crest factor information displays.

3. Press  to return to the main display screens.

NOTE: Your meter’s Modbus map includes registers for harmonics data for 
integration into your power or energy management system.

Related topics
• See “Front panel display and meter setup” on page 31 for front panel menu 

navigation details.
• Search your meter’s Modbus register list at www.schneider-electric.com to 

download the Modbus map.

Viewing THD/thd using the front panel

You can view THD/thd data using the front panel.

1. Navigate to THD. On the THD/thd Select screen, press THD to display values that 
use the calculation method based on the fundamental harmonic, or thd to display 
values that use the calculation method based on the RMS value of all harmonics in 
that phase (including the fundamental). 

2. Press the current or voltage THD or thd values you want to view. The total harmonic 
distortion percentage values are displayed.

3. Press  to return to the main display screens.

NOTE: Your meter’s Modbus map includes registers for total harmonic distortion data 
for integration into your power or energy management system.

Related topics
• See “Front panel display and meter setup” on page 31 for front panel menu 

navigation details.
• Search your meter’s Modbus register list at www.schneider-electric.com to 

download the Modbus map.

K-F B K-F B K factor for phase B

K-F C K-F C K factor for phase C

Crest Factor display screens 

IEEE mode IEC mode Description

V L-L U Crest factor data for line-to-line voltage 

V L-N V Crest factor data for line-to-neutral voltage

Amps I Crest factor data for current

Power Quality display screens (Continued)

IEEE mode IEC mode Description



THD (or thd) display screens 

IEEE mode IEC mode Description

Amps I Total harmonic distortion data for per phase and neutral currents.

V L-L U Total harmonic distortion data line-to-line voltage.

V L-N V Total harmonic distortion data line-to-neutral voltage.


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Chapter 14 Maintenance and upgrades

This section describes maintenance information and upgrade procedures for the meter.

Maintenance
The meter does not contain any user-serviceable parts. There are no moving parts 
inside the meter that require cleaning. 

• Do not open the meter. Opening the meter will void the warranty.
• Only manufacturer-authorized service personnel should service the meter.

Contact your local sales representative or Technical Support if the meter requires 
servicing.

Wrench icon

The wrench icon  appears on the top corner of the display screen to alert you of an 
overvoltage condition or a potential hardware or firmware problem in the meter that 
requires attention. It could also indicate that the energy LED is in an overrun state.

Navigate to Maint > Diag > Meter to view details of the meter status. Make note of the 
information shown on the screen, then contact Technical Support.

Troubleshooting LED indicators

Abnormal heartbeat / serial communications LED behavior could mean potential 
problems with the meter.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

• Do not attempt to service the meter. CT and PT inputs may contain hazardous 
currents and voltages.

• Do not perform a dielectric (hi-pot) or Megger test on the meter. High voltage testing 
of the meter may damage it.

• Before performing hi-pot or Megger testing on any equipment in which the meter is 
installed, disconnect all input and output wires to the meter.

Failure to follow these instructions will result in death or serious injury.

Heartbeat / serial communications LED behavior

Problem Probable causes Possible solutions

LED flash rate does not change 
when data is sent from the host 
computer.

Communications wiring
If using a serial-to-RS-485 converter, trace 
and check that all wiring from the computer 
to the meter is properly terminated.

Internal hardware problem

Perform a hard reset: turn off control power 
to the meter, then re-apply power. If the 
problem persists, contact Technical 
Support.

Heartbeat / serial communications 
LED remains lit and does not flash 
ON and OFF

Internal hardware problem

Perform a hard reset: turn off control power 
to the meter, then re-apply power. If the 
problem persists, contact Technical 
Support.

Heartbeat / serial communications 
LED flashes, but the display is 
blank

Display setup parameters 
incorrectly set See “Setting up the display” on page 44.
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If the problem is not fixed after troubleshooting, contact Technical Support for help. 
Make sure you have your meter’s firmware version, model and serial number 
information available.

Meter memory
The meter uses its non-volatile memory (NVRAM) to retain all data and metering 
configuration values. Under the operating temperature range specified for the meter, 
the NVRAM has an anticipated life of 45 years or longer. The meter stores its data logs 
in a memory chip, which has a life expectancy of up to 20 years under the operating 
temperature range specified for the meter. 

Clock battery

The internal battery in the meter keeps its clock running and helps maintain the time 
even when the meter is powered down.

The life expectancy of the internal battery is estimated to be over 10 years at 25°C 
under typical operating conditions.

Firmware version, model and serial number
You can view the meter’s firmware version, model and serial number from the display 
panel or through the meter webpages:

• Using the display panel: Navigate to Maint > Diag > Info. See “Maintenance” on 
page 66 for details.

• Using the meter webpages: Navigate to Diagnostics > Meter. See “Diagnostics” on 
page 59 for details.

Firmware upgrade
To see if there are firmware upgrades available for your meter, search your meter at 
www.schneider-electric.com.

NOTE: For MID compliance, the PM5561 meter’s firmware upgrade functionality is 
permanently disabled.

Reasons for upgrading your meter’s firmware include the following:

• Improve meter performance (e.g., optimize processing speed)
• Enhance existing meter features and functions
• Add new functionality to the meter
• Achieve compliance to stricter industry standards

The meter contains firmware that can be upgraded using the following methods:

Meter firmware and upgrade method 

Firmware type Upgrade method Description

OS DLF3000 The OS (operating system) firmware contains code that 
controls the meter’s features.

Language DLF3000 The language file contains translation strings to set the 
meter’s display to the selected language.
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Using DLF300 to upgrade firmware

1. Download the latest version of DLF3000 from www.schneider-electric.com, then 
install it on your computer. 

NOTE: DLF3000 is a free Schneider Electric utility for downloading firmware to your 
meter.

2. Download your meter’s firmware from www.schneider-electric.com.

3. Start DLF3000.

4. Click Add. Navigate to the folder where you saved your meter’s firmware.

5. Select the firmware file and click Open.

6. Select the firmware, then click Next.

7. If you haven’t defined an upgrade system yet:

— Click New, then type in the box to assign a system name
— Click Add, then type in the box to assign a communications connection name
— Select the communications driver (Modbus/TCP Driver or Serial Driver)

8. Click Continue.

9. If you are using Modbus over TCP to upgrade, type the meter’s IP address in the 
box, then click OK.

10. Click Add Device.

— Type in the box to assign a device name
— Select the device type from the list
— Select the connection name, i.e., the one you defined in the previous step.

11. Click Next.

12. Make sure the connection name, i.e., the one you defined in the previous step, is 
still selected. Enter the device address.

13. Select the protocol (e.g., Modbus).

14. Click OK.

15. Click Next.

16. Select the device name from the Download Candidate Devices pane, then click 
the right arrow button to move the selection to the Download Target Devices pane.

17. Select the meter firmware in the Firmware to field.

18. Click Next.

19. Click Health Check to confirm the meter is communicating. The Health Status 
shows Passed to indicate successful communications.

20. Click Next.

FPGA app DLF3000
The FPGA app (field programmable gate array application) 
firmware provides seamless transition between the meter’s 
physical hardware and the firmware code.

Ethernet FTP

The Ethernet files control how the meter webpages are 
displayed. The files in the FW folder contains the code and 
initialization files to run Ethernet communications. The www 
folder contains the webpages and javascript files. 

Meter firmware and upgrade method (Continued)

Firmware type Upgrade method Description
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21. The Firmware Update Group shows the connection name, the firmware version and 
status (should be “Queued”). The Group Device List shows the device or devices 
being upgraded. Click Download.

NOTE: A warning message displays, “Warning: Relays on PowerLogic Metering 
Devices will be de-energized if selected for download and will remain in this mode until 
a successful download is completed. Press OK to start the download.”

22. Click OK.

— The Firmware Upgrade Group status changes to Active, then updates to show 
the current upgrade progress (in percent complete).

— The Group Device List status shows “Entering Download Mode”, then changes 
to “Downloading” when the firmware is being downloaded to the meter. 
“Estimated Time Remaining” shows the firmware download progress.

— You can also check the progress on meters equipped with a display panel. The 
meter display shows “Download in progress” and a shows a dynamically 
incrementing number for “Percent Complete” (up to 100%).

23. When the firmware upgrade is complete, the Firmware Update Group status shows 
Complete (Passed). The Group Device List status shows Successful Download. 
Click Finished.

24. To exit the download firmware program, click Yes when prompted to quit DLF.

Upgrading the Ethernet card
The Ethernet card is the hardware component in your meter that is responsible for 
Ethernet communications. The Ethernet files are contained in two folders: FW and 
www:

• FW contains the code and other initialization files that run Ethernet 
communications.

• www contains the webpages and java script files. You can add custom webpages or 
modify the existing ones in this folder.

To upgrade your Ethernet card firmware, use an FTP client, such as FileZilla.

1. Start your FTP client.

2. Click Edit > Settings.

3. In the tree view, click Transfers > File Types.

4. Set Default transfer type to Binary, then click OK.

5. Type the meter’s IP address in the Host field and log in using your credentials. The 
factory default settings are:

— Username = user2
— Password = pass2

6. You may leave the Port field blank (the default FTP port setting is 21). Click 
Quickconnect.

7. In the local site pane, navigate to the folder where you downloaded the 
communications card firmware, then open the FW folder.

8. Navigate to the FW folder in the remote site pane (i.e., the meter).

9. Select all files in the FW folder from the local site, then upload it to the FW folder on 
the remote site.

10. If prompted that the target file already exists, select or confirm to overwrite the 
target file. Select Apply to current queue only if this option exists in the FTP client 
you are using.

11. Repeat the previous file transfer steps, this time selecting all files in the www folder.
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12. Exit the ftp client afer the file transfer completes successfully.

Technical assistance
Visit www.schneider-electric.com for support and assistance with lost passwords or 
other technical problems with the meter.

Make sure you include your meter’s model, serial number and firmware version in your 
email or have it readily available if calling Technical Support.

Diagnostics screen
For meters equipped with a display screen, you can use the Diagnostics screens to 
obtain information that may help you troubleshoot meter problems.

Info, Meter and Cl Pwr

See “Maintenance” on page 68 for description of the Info (information), Meter and CL 
Pwr (loss of control power) diagnostics screens.

Phasors

Phasors are used to represent the voltage and current magnitudes and phase angles.

The graph on the Phasors screen shows a representation of the phase angles in 
degrees, with the size of the lines representing the relative RMS magnitude of the 
voltages with respect to the other phase voltages, and the currents with respect to the 
other phase currents. The phasor for phase A voltage is set to a phase angle of zero, 
and all other phase angles are measured relative to phase A.

The Polar screen shows the RMS value and phase angle of each voltage and current 
phases.

Maint Reset

Setup

Diag

Polar

Info

Meter

Cl Pwr

Phasor
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Phasors can be used to troubleshoot incorrect connections on the meter’s voltage and 
current inputs. The phasors can reveal switched phase wiring or polarity errors.

NOTE: If two phasor lines overlap (i.e. if they have the same relative phase angle), only 
one phase label is visible as phasor diagram labels are overwritten dynamically on the 
display panel.

Maintenance log
The meter’s maintenance log can be accessed using the webpages. See “Diagnostics” 
on page 59.
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Chapter 15 Verifying accuracy

All meters are tested and verified at the factory in accordance with International 
Electrotechnical Commission (IEC) and American National Standards Institute (ANSI) 
standards. 

Your digital power meter does not require re-calibration. However, in some installations 
a final accuracy verification of the meters is required, especially if the meters will be 
used for revenue or billing applications.

Testing overview
The most common method for testing meter accuracy is to apply test voltages and 
currents from a stable power source and compare the meter’s readings with readings 
from a reference device or energy standard.

Accuracy test requirements

Signal and power source

The meter maintains its accuracy during voltage and current signal source variations 
but its energy pulsing output needs a stable test signal to help produce accurate test 
pulses. The meter’s energy pulsing mechanism needs approximately 10 seconds to 
stabilize after every source adjustment.

The meter must be connected to control power in order to conduct accuracy verification 
testing. Refer to your meter’s installation documentation for power supply 
specifications.

Control equipment

Control equipment is required for counting and timing the pulse outputs from the alarm / 
energy pulsing LED or the digital outputs.

• Most standard test benches have an arm equipped with optical sensors to detect 
LED pulses (the photodiode circuitry converts detected light into a voltage signal).

• The reference device or energy standard typically has digital inputs that can detect 
and count pulses coming from an external source (i.e., the meter’s digital output).

NOTE: The optical sensors on the test bench can be disrupted by strong sources of 
ambient light (such as camera flashes, florescent tubes, sunlight reflections, floodlights, 
etc). This can cause test errors. Use a hood, if necessary, to block out ambient light.

Environment

The meter should be tested at the same temperature as the testing equipment. The 
ideal temperature is about 23 °C (73 °F). Make sure the meter is warmed up sufficiently 
before testing.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

Verify the device’s power source meets the specifications for your device’s power 
supply.

Failure to follow these instructions will result in death or serious injury.
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A warm-up time of 30 minutes is recommended before beginning energy accuracy 
verification testing. At the factory, the meters are warmed up to their typical operating 
temperature before calibration to help ensure that the meters will reach their optimal 
accuracy at operating temperature.

Most high precision electronic equipment requires a warm up time before it reaches its 
specified performance levels. Energy meter standards allow the manufacturers to 
specify meter accuracy derating due to ambient temperature changes and self-heating.

Your meter complies with and meets the requirements of these energy metering 
standards.

For a list of accuracy standards that your meter complies to, contact your local 
Schneider Electric representative or download the meter brochure from 
www.schneider-electric.com.

Reference device or energy standard

To help ensure the accuracy of the test, it is recommended that you use a reference 
device or reference energy standard with a specified accuracy that is 6 to 10 times 
more accurate than the meter under test. Before you start testing, the reference device 
or energy standard should be warmed up as recommended by its manufacturer.

NOTE: Verify the accuracy and precision of all measurement equipment used in 
accuracy testing (for example, voltmeters, ammeters, power factor meters).

Energy pulsing

You can configure the meter’s alarm /energy LED or one of the digital outputs for 
energy pulsing.

• The meter is equipped with an alarm / energy pulsing LED. When configured for 
energy pulsing, the LED emits pulses that are then used to determine the accuracy 
of the meter’s energy measurements.

NOTE: The alarm / energy pulsing LED on the PM5561 is permanently set for 
energy pulsing and cannot be disabled or used for alarms.

• The meter is equipped with digital outputs. When you configure a digital output for 
energy pulsing, the meter sends voltage pulses to the digital output port, which are 
then used to determine the accuracy of the meter’s energy measurements.

Related topics
• See “Energy pulsing” on page 80 for configuration instructions using the front panel 

or ION Setup.

Location of energy pulsing LED 

PM5560 / PM5561 PM5563 A Alarm / energy pulsing LED
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Verifying accuracy test
The following are guidelines for testing the meter; your meter shop may have specific 
testing methods.

1. Turn off power to all test equipment. Use a properly rated voltage sensing device to 
confirm power is off.

2. Connect the test voltage and current source to the reference device or energy 
standard. Ensure all voltage inputs to the meter under test are connected in parallel 
and all currents inputs are connected in series.

3. Connect the control equipment used for counting the standard output pulses using 
one of these methods:

NOTE: When selecting which method to use, be aware that the Alarm / energy LED 
and digital outputs have different pulse rate limits. See “Energy pulsing 
considerations” on page 131 for details.

4. Before performing the verification test, let the test equipment power up the meter 
and apply voltage for at least 30 seconds. This helps stabilize the internal circuitry of 
the meter.

5. Set the meter’s power system to 3PH4W Wye Gnd (3-phase, 4 wire Wye with 
ground).

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate personal protective equipment (PPE) and follow safe electrical 
work practices. See NFPA 70E in the USA or applicable local standards.

• Turn off all power supplying this device before working on it.
• Always use a properly rated voltage sensing device to confirm that all power is off.
• Do not exceed the device’s ratings for maximum limits.
• Verify the device’s power source meets the specifications for your device’s power 

supply.

Failure to follow these instructions will result in death or serious injury.

Connecting the meter to the reference standard and test equipment

Alarm / energy LED Align the red light sensor on the standard test bench armature over the front 
panel alarm / energy LED.

Digital output Connect the meter’s digital output to the standard test bench pulse counting 
connections.

V1V2 V3 VN

I1 I2 I3

+ - + - + -

V1 V2 V3 VN
I1 I2 I3

+ - + - + -

V1 V2 V3 VN
I1 I2 I3

+ - + - + -

Reference device or energy standard

Meter under test

Test voltage and 
current source
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6. Depending on the method selected for counting the energy pulses, configure the 
meter’s alarm / energy LED or one of the digital outputs to perform energy pulsing. 
Set the meter’s energy pulse constant so it is in sync with the reference test 
equipment.

7. Perform accuracy verification on the test points. Run each test point for at least 30 
seconds to allow the test bench equipment to read an adequate number of pulses. 
Allow 10 seconds of dwell time between test points.

Calculating the number of required pulses

The reference test equipment typically requires you to specify the number of pulses 
required for a test duration of “t” seconds. Normally, the number of pulses required is at 
least 25 pulses, and the test duration is greater than 30 seconds.

Use the following formula to calculate the required number of pulses:

Where:

• Ptot = total instantaneous power in kilowatts (kW)
• K = the meter’s pulse constant setting, in pulses per kWh
• t = test duration, in seconds (typically greater than 30 seconds)

Calculating total power

The test voltage and current source supplies the same test signals to both the energy 
reference/standard and the meter under test. Total power is calculated as follows:

For a balanced 3-phase Wye system:

NOTE: A balanced 3-phase system assumes the voltage, current and power factor 
values are the same for all phases.

For a single-phase system:

Where:

• Ptot = total instantaneous power in kilowatts (kW)
• VLN = test point line-to-neutral voltage in volts [V]
• I = test point current in amps [A]
• PF = power factor

The result of the calculation is rounded up to the nearest integer.

Percent error calculation

For every test point:

Number of pulses Ptot K t
3600
------------=

Ptot 3 VLN I PF 1 kW
1000 W
-------------------=

Ptot VLN I PF 1 kW
1000 W
-------------------=

Energy Error EM ES–
ES

---------------------- 100 %=



PowerLogic™ PM5500 series user manual Chapter 15—Verifying accuracy

HRB1684301-01 131

Where:

• EM = energy measured by the meter under test
• ES = energy measured by the reference device or energy standard.

NOTE: If accuracy verification reveals inaccuracies in your meter, they may be caused 
by typical sources of test errors. If there are no sources of test errors present, please 
contact your local Schneider Electric representative.

Related topics
• See “Typical sources of test errors” on page 133 for possible causes of test errors.
• See “Power, energy and power factor” on page 135 for information on how the 

meter calculates power factor.

Test points

The meter should be tested at full and light loads and at lagging (inductive) power 
factors to help ensure testing over the entire range of the meter. The test amperage and 
voltage input rating are labeled on the meter. Refer to the installation sheet or data 
sheet for your meter’s nominal current, voltage and frequency specifications.

Energy pulsing considerations

The meter’s alarm / energy LED and digital outputs are capable of energy pulsing within 
the following limits:

The pulse rate depends on the voltage, current and PF of the input signal source, the 
number of phases, and the VT and CT ratios.

If Ptot is the instantaneous power (in kW) and K is the pulse constant (in pulses per 
kWh), then the pulse period is:

Watt-hour test points example

Watt-hour test point Sample accuracy verification test point

Full load 100% to 200% of the nominal current, 100% of the nominal voltage and nominal 
frequency at unity power factor or one (1).

Light load 10% of the nominal current, 100% of the nominal voltage and nominal frequency 
at unity power factor or one (1).

Inductive load (lagging 
power factor)

100% of the nominal current, 100% of the nominal voltage and nominal frequency 
at 0.50 lagging power factor (current lagging voltage by 60° phase angle).

Var-hour test points example

Var-hour test point Sample accuracy verification test point

Full load 100% to 200% of the nominal current, 100% of the nominal voltage and nominal 
frequency at zero power factor (current lagging voltage by 90° phase angle).

Light load 10% of the nominal current, 100% of the nominal voltage and nominal frequency 
at zero power factor (current lagging voltage by 90° phase angle).

Inductive load (lagging 
power factor)

100% of the nominal current, 100% of the nominal voltage and nominal frequency 
at 0.87 lagging power factor (current lagging voltage by 30° phase angle).

Energy pulsing limits

Description Alarm / energy LED Digital output

Maximum pulse frequency 2.5 kHz 25 Hz

Minimum pulse constant 1 pulse per kWh

Maximum pulse constant 9,999,999 pulses per kWh

Pulse period (in seconds) 3600
K Ptot
-------------------- 1

Pulse frequency (Hz)
---------------------------------------------------= =
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VT and CT considerations

The test points are always taken at the secondary side, regardless of whether VTs or 
CTs are used. Ptot is derived from the values of the voltage and current inputs at the 
secondary side, and takes into account the VT and CT ratios. 

If VTs and CTs are used, you must include their primary and secondary ratings in the 
equation. For example, in a balanced 3-phase Wye system with VTs and CTs:

Example calculations

A balanced 3-phase Wye system uses 480:120 volt VTs and 100:5 amp CTs. The 
signals at the secondary side are 119 volts line-to-neutral and 4.99 amps, with a power 
factor of 0.85. The desired pulse output frequency is 20 Hz (20 pulses per second).

1. Calculate the typical total output power (Ptot):

2. Calculate the pulse constant (K):

3. At full load (200% of nominal current = 10 A) and power factor (PF = 1), calculate 
the maximum total output power (Pmax):

4. Calculate the maximum output pulse frequency at Pmax:

5. Check the maximum pulse frequency against the limits for the LED and digital 
outputs:

NOTE: The maximum pulse frequency is within the limits for LED energy pulsing. 
However, the maximum pulse frequency is greater than the limits for digital output 
energy pulsing. Pulse output frequencies greater than 25 Hz will saturate the digital 
output and cause it to stop pulsing. Therefore in this example, you can only use the 
LED for energy pulsing.

Adjustments to allow energy pulsing at the digital outputs

If you want to use the digital output, you must reduce the output pulse frequency so it is 
within the limits.

Ptot 3 VLN VT primary
VT secondary
--------------------------------- I CT primary

CT ondarysec
----------------------------------- PF 1 kW

1000 W
-------------------=

Ptot 3 119 480
120
--------- 4.99 100

5
--------- 0.85 1 kW

1000 W
------------------- 121.14 kW= =

K 3600 (pulse frequency)
Ptot

------------------------------------------------------------ 3600 second/hour 20 pulses/second
121.14 kW

------------------------------------------------------------------------------------------= =

K 594.4  pulses/kWh=

Pmax 3 119 480
120
--------- 10 100

5
--------- 1 1 kW

1000 W
------------------- 285.6 kW= =

Maximum pulse frequency K Pmax
3600

------------------------ 594.4 pulses/kWh 285.6 kW
3600 seconds/hour

--------------------------------------------------------------------------= =

Maximum pulse frequency 47.2  pulses/second 47.2 Hz= =

47.2 Hz· LED maximum pulse frequency (2.5 kHz)

47.2 Hz· digital output maximum pulse frequency (25 Hz)
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Using the values from the above example, the maximum pulse constant for the digital 
output is:

6. Set the pulse constant (K) to a value below Kmax (for example, 300 pulses/kWh), 
then calculate the new maximum output pulse frequency at Pmax:

7. Check the new maximum pulse frequency against the limits for the LED and digital 
outputs:

As expected, changing K to a value below Kmax allows you to use the digital output 
for energy pulsing.

8. Follow the procedure in “Energy pulsing” on page 80 to set the pulse constant (K) in 
the meter.

Typical sources of test errors

If excessive errors are observed during accuracy testing, examine your test setup and 
test procedures to eliminate typical sources of measurement errors:

• Loose connections of voltage or current circuits, often caused by worn-out contacts 
or terminals. Inspect terminals of test equipment, cables, test harness and the meter 
under test.

• Meter ambient temperature is significantly different than 23 °C (73 °F). 
• Floating (ungrounded) neutral voltage terminal in any configuration with unbalanced 

phase voltages.
• Inadequate meter control power, resulting in the meter resetting during the test 

procedure.
• Ambient light interference or sensitivity issues with the optical sensor.
• Unstable power source causing energy pulsing fluctuations.
• Incorrect test setup: not all phases connected to the reference device or the energy 

standard. All phases connected to the meter under test should also be connected to 
the reference meter/standard.

• Moisture (condensing humidity), debris or pollution present in the meter under test.

Kmax 3600 (digital output maximum pulse frequency)
Pmax

------------------------------------------------------------------------------------------------------------------------ 3600 25
285.6

------------------------= =

Kmax 315.13 pulses per kWh=

New maximum pulse frequency K Pmax
3600

------------------------ 300 pulses/kWh 285.6 kW
3600 seconds/hour

---------------------------------------------------------------------= =

New maximum pulse frequency 23.8  pulses/second 23.8 Hz= =

23.8 Hz· LED maximum pulse frequency (2.5 kHz)

23.8 Hz· digital output maximum frequency (25 Hz)
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Chapter 16 Power, energy and power factor

This section describes how the meter interprets and calculates power and power factor.

Power (PQS)
A typical AC electrical system load has both resistive and reactive (inductive or 
capacitive) components. Resistive loads consume real power (P) and reactive loads 
consume reactive power (Q).

Apparent power (S) is the vector sum of real power (P) and reactive power (Q):

Real power is measured in watts (W or kW), reactive power is measured in vars (VAR 
or kVAR) and apparent power is measured in volt-amps (VA or kVA).

Power and the PQ coordinate system

The meter uses the values of real power (P) and reactive power (Q) on the 
PQ coordinate system to calculate apparent power.

Power flow

Positive power flow P(+) and Q(+) means power is flowing from the power source 
towards the load. Negative power flow P(-) and Q(-) means power is flowing from the 
load towards the power source.

S P2 Q2+=

PQ coordinate system
+Q

(+kVAR)

-P
(-kW)

-Q
(-kVAR)

+P
(+kW)

P (+)

S

P (-)

S

P (+)

S

P (-)

S
Q (-)Q (-)

Q (+) Q (+)

Quadrant 3 Quadrant 4

Quadrant 1Quadrant 2
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Energy delivered / energy received
The meter interprets energy delivered or received according to the direction of real 
power (P) flow. 

Energy delivered means positive real power flow (+P) and energy received means 
negative real power flow (-P).

Power factor (PF)
Power factor (PF) is the ratio of real power (P) to apparent power (S), and is a number 
between 0 and 1.

An ideal, purely resistive load has no reactive components, so its power factor is one 
(PF = 1, or unity power factor). A purely inductive or capacitive load no resistive 
components, so its power factor is zero (PF = 0).

True PF and displacement PF

The meter supports true power factor and displacement power factor values:

• True power factor includes harmonic content.
• Displacement power factor only considers the fundamental frequency.

PF lead / lag convention

The meter correlates leading power factor (PF lead) or lagging power factor (PF lag) 
with whether the current waveform is leading or lagging the voltage waveform. 

Current phase shift from voltage

For purely resistive loads the current waveform is in phase with the voltage waveform. 
For capacitive loads, current leads voltage. For inductive loads, current lags voltage.

Quadrant Real (P) power flow Energy delivered or received

Quadrant 1 Positive (+) Energy delivered

Quadrant 2 Negative (-) Energy received

Quadrant 3 Negative (-) Energy received

Quadrant 4 Positive (+) Energy delivered

PF P
S
---=

Current lead / lag and load type

Current and voltage in phase (resistive) Current leads voltage (capacitive) Current lags voltage (inductive)

270°90°

V

I Va

Vb

Vc

Ia

Ib

Ic

270°90°

Va

Vb

Vc

IaIb

Ic

V

I

90° 270°

Va

Vb

Vc

Ia

Ib

Ic

V

I
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PF sign convention

Depending on the regional settings, the meter shows positive or negative power factor 
according to IEC or IEEE standards.

PF sign in IEC mode

When the regional setting is set to IEC mode, the meter correlates power factor sign 
(PF sign) with the direction of real power (P) flow.

• For positive real power (+P), the PF sign is positive (+).
• For negative real power (-P), the PF sign is negative (-).

Power and PF lead / lag

PF lead / lag summary

Quadrant Current phase shift Load type PF lead / lag

Quadrant 1 Current lags voltage Inductive PF lag

Quadrant 2 Current leads voltage Capacitive PF lead

Quadrant 3 Current lags voltage Inductive PF lag

Quadrant 4 Current leads voltage Capacitive PF lead

+Q
(+kVAR)

-P
(-kW)

-Q
(-kVAR)

+P
(+kW)

P (+)

S

P (-)

S

P (+)

S

P (-)

S
Q (-)Q (-)

Q (+) Q (+)

Quadrant 3 Quadrant 4

PF lead

Quadrant 1Quadrant 2

PF lag

PF lag

PF lead
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PF sign in IEEE mode

When the regional setting is set to IEEE mode, the meter correlates power factor sign 
(PF sign) with the PF lead / lag convention (also load type).

• For PF lag (inductive), the PF sign is positive (+)
• For PF lead (capacitive), the PF sign is negative (-).

Power factor sign in IEC mode

Power factor sign in IEEE mode

+Q
(+kVAR)

-P
(-kW)

-Q
(-kVAR)

+P
(+kW)

P (+)

S

P (-)

S

P (+)

S

P (-)

S
Q (-)Q (-)

Q (+) Q (+)

Quadrant 3 Quadrant 4

PF sign +

Quadrant 1Quadrant 2

PF sign +

PF sign -

PF sign -

+Q
(+kVAR)

-P
(-kW)

-Q
(-kVAR)

+P
(+kW)

P (+)

S

P (-)

S

P (+)

S

P (-)

S
Q (-)Q (-)

Q (+) Q (+)

Quadrant 3 Quadrant 4

PF sign -

Quadrant 1Quadrant 2

PF sign +

PF sign +

PF sign -
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Power factor register format
Each power factor value (PF value) occupies one floating point register for power factor 
(PF register). The meter performs a simple algorithm to the PF value then stores it in 
the PF register. The meter and software interpret the PF register for all reporting or data 
entry fields according to the following diagram:

How PF value is stored in the PF register

Quadrant 3 Quadrant 2 Quadrant 1 Quadrant 4

0 to -1 -1 to 0 0 to +1 +1 to 0

0 -1 0 +1 0

PF

PF register

-2 -1 0 +1 +2

0

-1

0

+1

Quadrant 3

-1 PF 0≤ ≤

Quadrant 4

0 PF 1≤ ≤

Quadrant 1

0 PF≤ 1≤

Quadrant 2

-1 PF 0≤ ≤

-0.5 +0.5

+0.5-0.5

-2 to -1 -1 to 0 0 to +1 +1 to +2

-2 +2

-1

0 0

+1

Quadrant 3

-2 PF register -1≤ ≤

Quadrant 4

2 PF register 1≤ ≤

Quadrant 1

0 PF register 1≤ ≤

Quadrant 2

-1 PF register 0≤ ≤

-0.5 +0.5

+1.5-1.5

Quadrant 2
-1 ≤ PF ≤ 0

Quadrant 3
-1 ≤ PF ≤ 0

Quadrant 1
0 ≤ PF ≤ +1

PF value

Quadrant 3

0 to -1

Quadrant 4
0 ≤ PF ≤ +1

PF register

-1 to 0 0 to +1 +1 to 0

Quadrant 2 Quadrant 1 Quadrant 4

-2 to -1 -1 to 0 0 to +1 +1 to +2

Quadrant 2
-1 ≤ PF register ≤ 0

Quadrant 1
0 ≤ PF register ≤ +1

Quadrant 3
-2 ≤ PF register ≤ -1

Quadrant 4
+1 ≤ PF register ≤ +2
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PF value is calculated from the PF register value using the following formulas:

Quadrant PF range PF register 
range PF formula

Quadrant 1 0 to +1 0 to +1 PF value = PF register value

Quadrant 2 -1 to 0 -1 to 0 PF value = PF register value

Quadrant 3 0 to -1 -2 to -1 PF value = (-2) - (PF register value)

Quadrant 4 +1 to 0 +1 to +2 PF value = (+2) - (PF register value)
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Chapter 17 MID compliance

This section applies only to the PM5561 (referred to in the section as the meter) and 
contains descriptions and procedures that supplement the meter installation sheet. The 
information contained here supports the meter’s declaration of compliance with the 
Measuring Instruments Directive (2004/22/EC).

MID overview
Directive 2004/22/EC is the Measuring Instruments Directive (“MID”) from the 
European Parliament & Council that harmonises many aspects of legal metrology 
across the EU states.

Scope

Although MID applies to various measuring instruments, the scope of this section is 
limited only to the MID standards that apply to AC electricity metering equipment:

• EN 50470-1:2006
Electricity metering equipment (a.c.) — Part 1: General requirements, tests and test 
conditions - Metering equipment (class indexes A, B and C)

• EN 50470-3:2006
Electricity metering equipment (a.c.) — Part 3: Particular requirements - Static 
meters for active energy (class indexes A, B and C)

Related topics
• Search the internet for “Measuring Instruments Directive” or “Directive 2004/22/EC” 

for more information.

MID compliance for the meter
The meter complies to these MID standards and class indexes:

• EN 50470-1:2006 Class C
• EN 50470-3:2006 Class C

The meter achieves MID compliance through application of Annex B (Type 
Examination) and Annex D (Declaration of Conformity to Type Based on Quality 
Assurance of the Production Process).

Specifications relevant to MID
The meter meets all specifications listed in “Specifications” on page 27. See that 
section for mechanical and electrical specifications such as IP rating, rated operating 
conditions, protective class and environmental conditions.

In addition, the following specifications, function limitations and specific conditions 
relevant to MID:

Applicable MID standards and class index • EN 50470-1:2006 Class C
• EN 50470-3:2006 Class C

Type of measuring equipment Static watt-hour meter

Intended use
Indoor use only, permanently mounted in residential, 
commercial or light industrial applications, where levels of 
vibration and shock are of low significance
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Safety precautions
Installation, wiring, testing and service must be performed in accordance with all local 
and national electrical codes.

1. Turn off all power supplying this device before working on it.

2. Always use a properly rated voltage sensing device to confirm that all power is off.

Installation and wiring
Refer to the installation sheet that shipped with your meter for meter installation and 
wiring instructions.

Related topics
• See “Meter mounting” on page 17 and “Meter wiring” on page 20 for additional 

information.

Mechanical environment M1

Electromagnetic (EMC) environment E2

Applicable measurements Active energy metering only (kWh or MWh)

System types (for MID-compliant applications) • 3-phase 4-wire Wye grounded
• 3-phase 3-wire Delta ungrounded

Voltage at voltage 
terminals

3-phase 4-wire Wye 
grounded 3 x 57.7 (100) to 3 x 400 (690) V AC

3-phase 3-wire Delta 
ungrounded 3 x 100 to 3 x 600 V L-L

Minimum current 50 mA

Rated secondary current 5 A

Maximum current 10 A

Electrical network frequency 50 Hz

Optical pulse output 
(energy pulsing LED)

Location Meter front panel

Frequency 2.5 kHz maximum

Pulse constant1 10,000 pulses per kWh

Wavelength 590 to 635 nm
1 See “MID-protected setup parameters” on page 144 for additional details.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate personal protective equipment (PPE) and follow safe electrical 
work practices. See NFPA 70E in the USA or applicable local standards.

• Turn off all power supplying this device before working on it.
• Always use a properly rated voltage sensing device to confirm that all power is off.
• Do not exceed the device’s ratings for maximum limits.
• Do not use this device for critical control or protection applications where human or 

equipment safety relies on the operation of the control circuit.
• Never short the secondary of a voltage transformer (VT).
• Never open circuit a current transformer (CT).
• Always use grounded external CTs for current inputs.

Failure to follow these instructions will result in death or serious injury.
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Installing the terminal covers
The voltage and current terminal covers help prevent tampering with the meter’s 
voltage and current measurement inputs. The terminal covers enclose the terminals, 
the conductor fixing screws and a suitable length of the external conductors and their 
insulation. The terminal covers are secured by tamper-resistant meter seals.

The meter terminal covers must be installed by a qualified installer. The installation of 
both the voltage and current terminal covers is required to provide tamper evidence for 
MID installations.

1. Install the voltage terminal cover (A) and apply the seal at the sealing point (B).

2. Install the current terminal cover (C) and apply the seals at the sealing points (D).

PM5561 default screen
The meter’s default home screen displays the following information.

Related topics
• See “Front panel display and meter setup” on page 31 for detailed information on 

front panel menu navigation, LED indicators and display screen notification icons.

Location of terminal covers

A Voltage terminal cover

B Voltage terminal sealing point

C Current terminal cover

D Current terminal sealing points (2)

C

D

Default PM5561 display screen

A Accumulated real energy (delivered + received)

B System frequency

C Active tariff

D Power system setting

E Locked / unlocked icon

E
C

D
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Meter firmware version
You can access information about the meter’s OS and RS firmware versions by 
navigating to Maint > Setup > Diag > Info. The OS CRC value is a number that 
identifies the uniqueness between different OS firmware versions.

NOTE: For MID compliance, the meter’s firmware upgrade functionality is permanently 
disabled. You cannot upgrade a PM5561 meter’s firmware.

Related topics
• See the Diag menu descriptions under “Maintenance” on page 66 for information on 

other meter diagnostics screens.

MID-protected setup parameters
This section describes the setup parameters that are permanently set at the factory and 
cannot be modified, regardless of the lock or unlock settings.

The alarm / energy pulsing LED on the meter is permanently set for energy pulsing and 
cannot be disabled or used for alarms. All other setup parameters for the energy 
pulsing LED are also permanently set and cannot be modified.

NOTE: The pulses per kWh reflect uncompensated values only. This means that the 
PT and CT values are ignored and the pulses represent the raw energy calculated from 
the metering inputs.

Lock-protected setup parameters
This section lists the meter’s lock-protected setup parameters for MID compliance. After 
the meter is locked, these setup parameters are protected and cannot be edited.

The setup parameters can be accessed from the maintenance menu screen. Use the 
front panel buttons to navigate to the Maint > Setup menu.

Front panel LEDs 
Alarm / energy pulsing LED (orange)
Heartbeat / communications LED (green)

MID-protected setup parameters 

Setup menu Setup submenu MID-protected setup parameter

I/O LED

• Mode (Control) = Energy (energy pulsing)
• Pulses per k_h (Pulse Rate) = 10,000 (pulses 

per kWh)
• Channel (Parameter) = Active Energy Del+Rec
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Lock-protected functions
This section lists the meter’s lock-protected functions for MID compliance. After the 
meter is locked, these functions are disabled.

These functions can be accessed from the maintenance menu screen. Use the front 
panel buttons to navigate to the Maint > Reset menu.

Setting up the PM5561
You must configure all the lock-protected setup parameters before locking the meter. 
When the meter is locked, those setup parameters cannot be edited.

Basic setup menu

See “Configuring basic setup parameters” on page 35 to perform basic setup.

For MID compliance, the Power System must be set to one of the following settings:

• 3PH4W Wye Gnd (three-phase 4-wire wye grounded)
• 3PH3W Dlt Ungnd (three-phase 3-wire delta ungrounded)

Advanced setup menu

See “Configuring advanced setup parameters” on page 37 to perform advanced setup.

You must use ION Setup to edit the device label.

Clock setup menu

See “Setting the clock” on page 44 to change the meter time using the display.

You can also use ION Setup to set or sync the meter time.

Lock-protected setup parameters 

Setup menu Setup submenu Lock-protected setup parameter

Meter

Basic

• Power System
• VT Connect
• VT Primary (V) and VT Secondary (V)1
• CT on Terminal
• CT Primary (A)
• CT Secondary (A)
• CT Primary Neu.(A) and CT Sec. Neu.(A)2
• Sys Frequency
• Phase Rotation

1 If using VTs (i.e., if VT Connect is set to 3VT or 2VT)
2 For 3PH4W Wye Gnd systems that measure I4 current (i.e., if CT on Terminal is set to I1 I2 I3 IN)

Advanced • Label

Tariff • Mode

HMI User Passwords • Energy Resets

Clock • Date

Lock-protected functions

Menu Submenu Lock-protected function

Resets
Global Resets • Meter Initialization (all)

• Energies

Single Resets • Energy
• Multi-Tariff
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Tariff setup menu

See “Multi-tariff feature” on page 103 to configure the energy tariffs.

Passwords setup menu

See “Setting up the screen passwords” on page 43 to change the meter screen 
passwords.

NOTE: When the meter is locked, all other passwords can still be modified except for 
the Energy Resets password.

Initializing the meter
Initializing the meter clears the meter’s logged data, counters and timers. It is common 
practice to initialize the meter after its configuration is complete, before adding it to an 
energy management system.

1. After configuring all the meter setup parameters, navigate through the different 
meter display screens and make sure the displayed data is valid.

2. See “Global resets” on page 83 for instructions on clearing the meter’s recorded 
logged data, counters and timers.

3. Select Meter Initialization to clear all recorded data.

Locking or unlocking the meter
After you initialize the meter, you must lock it in order to conform to MID standards. 
Choose a number from 1 to 9999 for the lock password, record it and store the 
password in a secure place.

1. Navigate to Maint > Lock.

2. Set Security Lock by entering a non-zero password.

3. Select Yes to confirm locking the meter, then exit the screen.

A lock icon appears on the upper left corner of the screen.

4. Make sure you record and store the Lock password in a secure location. A lost 
Lock password cannot be recovered.

NOTE: To change the lock password, unlock the meter then lock it again using a 
different password. Make sure you record this new password and store it in a secure 
place.

NOTICE
IRRECOVERABLE PASSWORD

Record your meter's lock password information in a secure location.

Failure to follow these instructions can result in a permanently locked meter.
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